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 การวจิยัคร้ังน้ีมีวตัถุประสงค ์คือ 1) เพื่อพฒันาบทเรียนออนไลน์แบบผสมผสาน  
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรมอยา่งง่าย ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ตามเกณฑป์ระสิทธิภาพ E1/ E2  
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ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 และ 3) เพื่อศึกษาความพึงพอใจต่อบทเรียนออนไลน์ 
แบบผสมผสานฯ วธีิด าเนินการวจิยัตามขั้นตอน ADDIE มีดงัน้ี 1) ขั้นตอนการวิเคราะห์  
(A: Analysis) 2) ขั้นตอนการออกแบบ (D: Design) 3) ขั้นตอนการพฒันา (D: Development)  
4) ขั้นตอนการทดลอง (I : Implementation) และ 5) ขั้นตอนการประเมินผล(E: Evaluation)
กลุ่มเป้าหมายท่ีใชใ้นการวจิยั คือ นกัเรียนชั้นประถมศึกษาปีท่ี 6 โรงเรียนวดัตโปทาราม  
จ านวน 30 คน  
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นกัเรียนชั้นประถมศึกษาปีท่ี 6 2) แบบทดสอบก่อนเรียน-หลงัเรียน และ 3) แบบวดัความพึงพอใจ
ของนกัเรียน ต่อการใชบ้ทเรียนออนไลน์แบบผสมผสานฯ การวเิคราะห์ขอ้มูล ประกอบดว้ย  
ค่าร้อยละ ค่าเฉล่ีย ค่าความเบ่ียงเบนมาตรฐาน การทดสอบประสิทธิภาพ (E1/ E2) และดชันี
ประสิทธิผล ผลการวจิยัพบวา่ 
 1. บทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี
เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรมอยา่งง่าย ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
มีผลการทดสอบประสิทธิภาพตามเกณฑ ์E1/ E2 เท่ากบั 86.22/ 86.44 เป็นไปตามเกณฑท่ี์ก าหนด 
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  2. ผลการวเิคราะห์ค่าดชันีประสิทธิผลบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระ 
การเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม 
อยา่งง่าย ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ไดเ้ท่ากบั 0.72 มีดชันีประสิทธิผลเพิ่มข้ึน 
 3. ความพึงพอใจต่อบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพ
และเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรมอยา่งง่าย ส าหรับนกัเรียน 
ชั้นประถมศึกษาปีท่ี 6 อยูใ่นระดบั มากท่ีสุด ( X = 4.58, SD = 0.54) 
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 The objectives of this research were to; 1) develop the online blended learning in the 
Career and Technology Strand on developing electronic book by flip album program for primary 
6 students to meet the efficiency of 85/ 85, 2) to determine the effectiveness index of the online 
learning lesson and 3) to study the leaners’ satisfaction towards the online learning. 

 Research method followed the ADDIE model, they were 1) Analysis 2) Design  
3) Development 4) Implementation 5) Evaluation  

 The population in this study was 60 students in 2 classroom. They were studying in 
Prathomsuksa 6 at Wattapotharam School, Chonburi province. The samples were 30 
prathomsuksa 6 students at Wattapotharam School. They were randomly selected from the 
population above. The research instruments were the online learning lesson, learner satisfaction 
surveys, and learning achievement tests. The statistics used for the data analysis were mean, 
standard deviation, percentage and t-test. 

 It was found that the online blended learning in the Career and Technology Strand on 
developing electronic book by flip album program had the efficiency of 86.22/ 86.44. The 
effectiveness index was at 0.72. The satisfaction of the students towards the online learning 
lessons was at the highest satisfied. 
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บทที ่ 1 
บทน ำ 

 

ควำมเป็นมำและควำมส ำคญัของปัญหำ 
 การศึกษาของไทย ไดก้า้วสู่ยคุของการศึกษาไร้พรหมแดน เป็นการศึกษาท่ีเป็น 
การเรียนรู้ตลอดชีวิต การจดัการเรียนรู้ก็เปล่ียนแปลงไป โดยเนน้ท่ีผูเ้รียนตอ้งศึกษาหาความรู้ 
และท าความเขา้ใจในวชิาเรียนดว้ยตนเองมากข้ึน จากกแนวโนม้ดงักล่าว จึงจ าเป็นตอ้งจดัการศึกษา
เพื่อเตรียมประชากรของประเทศใหส้อดคลอ้งกนั กระบวนการจดัการศึกษาตอ้งส่งเสริมใหผู้เ้รียน
สามารถพฒันาตามธรรมชาติและเตม็ศกัยภาพ ทั้งน้ี ผูส้อนและผูเ้รียนอาจเรียนรู้ไปพร้อมกนั 
จากส่ือการเรียนการสอนและแหล่งวทิยาการต่าง ๆ และจดัการเรียนรู้ให้เกิดข้ึนไดทุ้กเวลา  
ทุกสถานท่ี การท่ีจะจดัการศึกษาลกัษณะน้ีได ้ควรน าเอาเทคโนโลยสีารสนเทศเขา้มามีบทบาท 
ใหม้ากข้ึน (ประเวศ วะสี, 2538) การใชเ้ทคโนโลยสีารสนเทศวา่ ควรจดัใหค้รูในโรงเรียน 
และนกัเรียนไดมี้โอกาสเรียนวชิาการใชเ้ทคโนโลยสีารสนเทศ เพื่อน ามาใชเ้ป็นเคร่ืองมือ 
ในการรับข่าวสารและความรู้ดว้ยวธีิการเรียนดว้ยตนเอง หรือวธีิการส่ือสารโตต้อบกบัครู 
หรือเพื่อนนกัเรียนดว้ยกนั (ครรชิต มาลยัวงศ,์ 2540) 
 ในปัจจุบนัน้ี ไดมี้การน าเทคโนโลยสีารสนเทศในลกัษณะบทเรียนออนไลน์ มาใช ้
ในการจดัการเรียนการสอนมากข้ึน ซ่ึงบทเรียนออนไลน์มีขอ้ไดเ้ปรียบ คือ ช่วยใหก้ารจดั 
การเรียนการสอนมีประสิทธิภาพมากข้ึน เพราะในการถ่ายทอดเน้ือหาผา่นมลัติมีเดีย สามารถ 
ท าใหผู้เ้รียนเรียนรู้ไดดี้กวา่ ผูส้อนสามารถตรวจสอบความกา้วหนา้ พฤติกรรมการเรียนรู้ของผูเ้รียน
ไดต้ลอดเวลา และช่วยใหผู้เ้รียนสามารถควบคุมการเรียนของตนเองได ้เน่ืองจากการน าเทคโนโลยี
ส่ือหลายมิติ (Hypermedia) มาประยกุตใ์ชใ้นการเช่ือมโยงขอ้มูล ไม่วา่จะเป็นในรูปขอ้ความ ภาพน่ิง 
เสียง ภาพเคล่ือนไหว วีดิโอท่ีเก่ียวขอ้งไวด้ว้ยกนั ผูเ้รียนจึงสามารถเขา้ถึงขอ้มูลก่อนหรือหลงัได้
โดยไม่ตอ้งเรียงล าดบั เกิดความสะดวกต่อผูเ้รียน ช่วยใหผู้เ้รียนไดเ้รียนรู้ตามจงัหวะของตน  
(Self-paced learning) เน่ืองจากการน าเสนอเน้ือหาในรูปแบบของส่ือหลายมิติ เปิดโอกาสใหผู้เ้รียน
สามารถควบคุมการเรียนรู้ของตนเองไดต้ามความถนดั ความสนใจ และนอกจากน้ียงัมีส่ิงท่ีช่วยให้
เกิดปฏิสัมพนัธ์ระหวา่งผูเ้รียนกบัผูส้อนและเพื่อน ๆ ได ้เน่ืองจากบทเรียนออนไลน์มีเคร่ืองมือ
มากมาย เช่น หอ้งสนทนา (Chat room) กระดานสนทนา (Web board) และไปรษณียอิ์เลคทรอนิกส์        
(E-mail) ท่ีเอ้ือต่อการโตต้อบท่ีหลากหลาย ส่งเสริมการเรียนรู้ในทกัษะใหม่ ๆ รวมทั้งเน้ือหา 
ท่ีมีความทนัสมยัและสามารถตอบสนองเร่ืองราวต่าง ๆ ในปัจจุบนัไดอ้ยา่งทนัที ท าให้เกิดรูปแบบ
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การเรียนท่ีสามารถจดัสอนใหแ้ก่ผูเ้รียนในวงกวา้งมากข้ึน เพราะผูเ้รียนในลกัษณะน้ีไม่มีขอ้จ ากดั
ในดา้นการเดินทางมาศึกษาในเวลาใด เวลาหน่ึง และสถานท่ีใด สถานท่ีหน่ึง จึงสามารถน าไป
สนบัสนุนการเรียนรู้ตลอดชีวติได ้(ศุภชยั สุขะนินทร์ และกรกนก วงศพ์านิช, 2545) และเคร่ืองมือ
ท่ีน ามาใชใ้นการจดัการเรียนการสอนแบบออนไลน์ ท่ีสะดวกในปัจจุบนัน้ีคือ Google apps for 
education เป็นชุดโปรแกรมต่าง ๆ ของ Google ท่ีเปิดให้สถาบนัการศึกษาใชส้ าหรับใชเ้ป็น
เคร่ืองมือเสริมประกอบการเรียนการสอนแบบออนไลน์ แลว้แต่ผูส้อนจะน าไปประยุกตใ์ช ้
ประกอบดว้ย Google classroom, Gmail, Google drive, Google calendar, Google docs, Google 
sheet, Google slide, Google plus, Google group, Google site, Google form โดย Google apps for 
education ไดมี้ส่วนส าคญัในการเปล่ียนแปลงโฉมองคก์รในดา้นนวตักรรมการศึกษา  
และการติดต่อส่ือสารในสถาบนัการศึกษาต่าง ๆ ท าใหค้รูติดตามนกัเรียนอยูใ่กลชิ้ดมากข้ึน  
ไดเ้รียนรู้ตามหลกัสูตร ช่วยลดค่าใชจ่้ายของสถาบนัการศึกษาดว้ยความเป็นระบบคลาวด ์ 
ซ่ึงสามารถน ามาจดัการเรียนรู้แบบผสมผสาน ทั้งภายในและภายนอกหอ้งเรียนไดเ้ป็นอยา่งดี 
 การเรียนแบบผสมผสาน (Blended learning) เป็นการน าเอาจุดแขง็ของการเรียน 
ในหอ้งเรียนมารวมกบัขอ้ดีของการเรียนบนเครือข่าย ซ่ึงเป็นรูปแบบการจดัการเรียนการสอน
รูปแบบใหม่ส าหรับการจดัการศึกษาทุกระดบั ปัจจุบนัมีการน าการเรียนการสอนบนเครือข่าย 
แบบผสมผสานมาใชใ้นการจดัการศึกษาหลายระดบั ซ่ึงในการน าการเรียนการสอนบนเครือข่าย
แบบผสมผสานมาใชใ้นการจดัการศึกษาแต่ละระดบันั้น การออกแบบการเรียนการสอน 
(Instructional design) ถือเป็นปัจจยัส าคญัท่ีจะก าหนดวา่จะมีการผสมผสานในระดบัใด รูปแบบใด 
การออกแบบวธีิการเรียน วธีิการสอน กิจกรรมการเรียนการสอนและเคร่ืองมือสนบัสนุนการเรียน 
ในการน าขอ้ดีของการเรียนการสอนบนเครือข่าย และการเรียนในชั้นเรียนแบบดั้งเดิม 
มาเสริมเติมเตม็จุดดอ้ยซ่ึงกนัและกนั เพื่อใหผู้เ้รียนเกิดการเรียนรู้ไดอ้ยา่งมีประสิทธิภาพ โดยใช ้
ส่ิงอ านวยความสะดวกในอินเตอร์เน็ตเป็นส่ือและเคร่ืองมือในสภาพแวดลอ้มของการเรียนการสอน
บนเครือข่ายเพื่อสนบัสนุนการเรียน โดยเนน้ปฏิสัมพนัธ์จากการเรียนแบบออนไลน์ และการมี 
ส่วนร่วมในห้องเรียนแบบดั้งเดิม (ปณิตา วรรณพิรุณ, 2551) การเรียนการสอนแบบผสมผสาน 
สามารถพฒันาใหผู้เ้รียนเกิดการเรียนรู้ท่ีทา้ทายตอบสนองต่อความแตกต่างระหวา่งบุคคลและ
ศกัยภาพทางการเรียนรู้ของผูเ้รียน ท าใหผู้เ้รียนสามารถพฒันาความสามารถในการเรียนรู้ของ
ตนเองไดดี้ข้ึน (Driscoll, 2002) นอกจากน้ี การเรียนการสอนแบบผสมผสาน ยงัมีส่วนช่วย
สนบัสนุนการมีปฏิสัมพนัธ์ระหวา่งผูเ้รียนกบัผูเ้รียนดว้ยกนั และผูเ้รียนกบัผูส้อนโดยการติดต่อ
แบบส่วนตวั ช่วยใหก้ารเรียนรู้ดีข้ึน (Thorne, 2003) ซ่ึงสอดคลอ้งกบังานวจิยั ของ ศุภลกัษณ์  
ปริสุทโกล (2557) ไดท้  าการศึกษาผลการเรียนดว้ยโปรแกรมบทเรียนแบบผสมผสาน กลุ่มสาระ 
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การเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การใชอิ้นเทอร์เน็ต ท่ีมีต่อผลสัมฤทธ์ิทางการเรียน 
การคิดวจิารณญาณและความคงทนในการเรียนรู้ ของนกัเรียนชั้นประถมศึกษาปีท่ี 4 ท่ีมีการน า
ตนเองในการเรียนรู้ต่างกนั พบวา่ โปรแกรมบทเรียนแบบผสมผสานแบบ 50:50 มีประสิทธิภาพ
และประสิทธิผล เหมาะสมในการพฒันาผลสัมฤทธ์ิทางการเรียน การคิดวจิารณญาณ ความคงทน
ในการเรียนและความพึงพอใจของนกัเรียน  
 หลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน พุทธศกัราช 2551 ไดจ้ดักลุ่มสาระการเรียนรู้
ออกเป็น 8 กลุ่มสาระ โดยกลุ่มสาระการงานอาชีพและเทคโนโลย ีมุ่งพฒันาใหผู้เ้รียนมีความรู้  
ทกัษะและเจตคติในการท างาน การจดัการ การด ารงชีวิต การประกอบอาชีพและการใชเ้ทคโนโลย ี 
ซ่ึงในสาระท่ี 3 เทคโนโลยสีารสนเทศและการส่ือสาร เป็นสาระท่ีเนน้ให้ผูเ้รียนมีความเขา้ใจ  
เห็นคุณค่าและใชก้ระบวนการเทคโนโลยสีารสนเทศ ในการสืบคน้ขอ้มูล การเรียนรู้ การส่ือสาร  
การแกปั้ญหา การท างานและอาชีพอยา่งมีประสิทธิภาพ ประสิทธิผลและมีคุณธรรม ในการจดั 
การเรียนรู้การงานอาชีพและเทคโนโลย ี(คอมพิวเตอร์) ของโรงเรียนวดัตโปทาราม ไดจ้ดัการเรียนรู้
ใหต้รงกบัความตอ้งการของผูเ้รียนและใหส้อดคลอ้งกบันโยบายการปฏิรูปการศึกษาท่ีเนน้ผูเ้รียน
เป็นส าคญั จึงท าให้รูปแบบกิจกรรมการเรียนรู้ไดป้รับเปล่ียนไปตามนโยบายดงักล่าว ซ่ึงในขณะน้ี
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี(คอมพิวเตอร์) โรงเรียนวดัตโปทาราม   
ไดพ้บปัญหาจากการจดัการเรียนการสอน ดงัน้ี (สัมภาษณ์ครูผูส้อนกลุ่มสาระการงานอาชีพ 
และเทคโนโลย)ี         
  1. จ  านวนเวลาท่ีใชใ้นการเรียนรู้มีอยูจ่  ากดั ตามหลกัสูตรสถานศึกษาของโรงเรียน 
วดัตโปทาราม ไดจ้ดัใหว้ชิาคอมพิวเตอร์เป็นสาระการเรียนรู้เพิ่มเติม ซ่ึงเรียนสัปดาห์ละ 1 คาบ
เท่านั้น นอกจากน้ี โรงเรียนยงัมีกิจกรรมเสริมหลกัสูตรท่ีส่งผลกระทบต่อเวลาเรียน เน่ืองจาก
โรงเรียนตอ้งหยดุการเรียนการสอนเพื่อท ากิจกรรม เช่น กิจกรรมแข่งขนัทกัษะวชิาการ กิจกรรม
การแข่งขนักีฬา รวมถึงการอบรมดูงานของครู เป็นตน้  
  2. ปัญหาความแตกต่างระหวา่งบุคคล เน่ืองจากโรงเรียนวดัตโปทาราม เป็นโรงเรียน 
ขยายโอกาส การจดันกัเรียนเขา้ชั้นเรียนจึงตอ้งจดัแบบคละความรู้ความสามารถ ระหวา่งนกัเรียน 
ท่ีมีความรู้ความสามารถทางการเรียนสูง ปานกลาง ต ่า ท าใหน้กัเรียนท่ีมีผลการเรียนต ่า นกัเรียน 
ท่ีเรียนรู้ชา้และนกัเรียนท่ีขาดเรียนบ่อย ประสบปัญหาในการเรียนไม่ทนัเพื่อน ครูผูส้อนจะตอ้ง
ยอ้นกลบัมาสอนและทบทวนเน้ือหาท่ีผูเ้รียนไม่เขา้ใจหรือเรียนไม่ทนัซ ้ าอีก ท าใหน้กัเรียนท่ีมี 
ผลการเรียนสูงหรือนกัเรียนท่ีเรียนทนัเน้ือหา เกิดความเบ่ือหน่าย ซ่ึงส่งผลใหป้ระสิทธิภาพ 
ในการเรียนรู้ลดลง  
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 3. ปัญหาจากครู เน่ืองจากโรงเรียนมีกิจกรรมมาก ครูมีหนา้ท่ีรับผดิชอบงานหลายดา้น 
เม่ือตอ้งไปท ากิจกรรมต่าง ๆ ของโรงเรียน ท าใหใ้นบางคร้ังตอ้งจดัครูท่านอ่ืนสอนแทน  
 4. ปัญหาจากตวัผูเ้รียน ผูเ้รียนส่วนใหญ่ไม่มีพื้นฐานความรู้เดิมเก่ียวกบัการสร้างหนงัสือ
อิเล็กทรอนิกส์มาก่อน และในบางคร้ังผูเ้รียนตอ้งเขา้ร่วมกิจกรรมต่าง ๆ ของโรงเรียน รวมไปถึง
การขาดเรียนของผูเ้รียน ซ่ึงส่งผลใหเ้รียนไม่ทนัเพื่อน  
 5. ขาดการน าส่ือบทเรียนท่ีประยกุตใ์ชเ้ทคโนโลยท่ีีเหมาะสม มาใชใ้นการจดัการเรียน
การสอน 
 จากท่ีมาและความส าคญัของปัญหาดงักล่าวขา้งตน้ ผูว้จิยัไดน้ าหลกัการท่ีส าคญั รวมถึง
ประโยชน์ของการเรียนดว้ยบทเรียนออนไลน์แบบผสมผสาน มาพฒันาบทเรียนออนไลน์ ในกลุ่ม
สาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม 
Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ข้ึน ซ่ึงเป็นนวตักรรมท่ีแปลกใหม่ เพื่อดึงดูด
ความสนใจของนกัเรียนใหม้ากข้ึน และเป็นส่ือช่วยสอนท่ีส่งเสริมใหผู้เ้รียนเรียนรู้ไดด้ว้ยตนเอง 
ตามความพร้อมของผูเ้รียน ตามหลกัการท่ีเนน้ผูเ้รียนเป็นส าคญั อีกทั้งยงัเป็นการน าเอา 
ส่ือเทคโนโลยสีมยัใหม่ มาใชใ้นการจดัการเรียนการสอน เพื่อใหผู้เ้รียนไดพ้ฒันาอยา่งเตม็ศกัยภาพ 
ซ่ึงจะสามารถกระตุน้และจูงใจใหผู้เ้รียนเขา้สู่กระบวนการพฒันาทกัษะการเรียนรู้   
เพิ่มประสิทธิภาพการเรียนรู้ให้สูงข้ึน และเป็นไปตามหลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน 
พุทธศกัราช 2551 
 

วตัถุประสงค์  
 1. เพื่อพฒันาบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพ 
และเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียน 
ชั้นประถมศึกษาปีท่ี 6 ใหมี้ประสิทธิภาพตามเกณฑ ์E1/ E2 เท่ากบั 85/ 85 
 2. เพื่อหาดชันีประสิทธิผล (EI) ของการเรียนดว้ยบทเรียนออนไลน์แบบผสมผสาน              
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
 3. เพื่อศึกษาความพึงพอใจของนกัเรียนต่อการใชบ้ทเรียนออนไลน์แบบผสมผสาน 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
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ขอบเขตกำรวจิัย 
 1. รูปแบบกำรวจัิย การวิจยัคร้ังน้ีเป็นการวิจยัและพฒันา (Research and development) 
โดยใชข้ั้นตอนแนวทาง ADDIE model เพื่อพฒันาและหาประสิทธิผลของบทเรียนออนไลน์ 
แบบผสมผสานกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสือ
อิเล็กทรอนิกส์ ดว้ยโปรแกรมอยา่งง่าย  
  2. กลุ่มเป้ำหมำย ท่ีใชใ้นการวจิยัคร้ังน้ี คือ นกัเรียนชั้นประถมศึกษาปีท่ี 6  
โรงเรียนวดัตโปทาราม จ านวน 30 คน จ านวน 1 หอ้งเรียน 
 3. ขอบเขตด้ำนเน้ือหำ เน้ือหาวชิาท่ีใชใ้นการวจิยัคร้ังน้ี เป็นหน่วยการเรียน เร่ือง  
การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ซ่ึงประกอบดว้ย 5 หน่วยการเรียนรู้ ดงัน้ี  
 หน่วยท่ี 1 ความหมายและคุณสมบติัของหนงัสืออิเล็กทรอนิกส์ (e-Book) 
 หน่วยท่ี 2 เร่ิมตน้ใชง้านโปรแกรม Flip album  
 หน่วยท่ี 3 การออกแบบและการสร้างหนงัสืออิเล็กทรอนิกส์ 
 หน่วยท่ี 4 การตกแต่งอิเล็กทรอนิกส์ใหส้วยงาม 
 หน่วยท่ี 5 การน าหนงัสือไปใชง้าน 
 

ตัวแปรในกำรวจิัย 
 ตวัแปรท่ี 1 บทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพ 
และเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียน 
ชั้นประถมศึกษาปีท่ี 6   
 ตวัแปรท่ี 2 ประสิทธิภาพของบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้ 
การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรมอยา่งง่าย  
Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 โดยใชเ้กณฑ ์ E1/ E2 เท่ากบั 85/ 85 
 ตวัแปรท่ี 3 ดชันีประสิทธิผลของบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้
การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album 
ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
 ตวัแปรท่ี 4 ความพึงพอใจของนกัเรียนท่ีเรียนดว้ยบทเรียนออนไลน์แบบผสมผสาน  
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  
 
 



6 

ระยะเวลำในกำรทดลอง 
 ผูว้จิยัไดท้  าการทดลองในภาคเรียนท่ี 1 ปีการศึกษา 2561 ใชเ้วลาทั้งหมด 10 ชัว่โมง 
 

กรอบแนวคดิในกำรวจิัย 
 

 
 
 
 
 

 
  
 
 
  
 
 
ภาพท่ี 1-1 กรอบแนวคิดในการวจิยั 
 

ประโยชน์ทีค่ำดว่ำจะได้รับ 
 1. ไดบ้ทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพ 
และเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียน 
ชั้นประถมศึกษาปีท่ี 6   
 2. เป็นแนวทางในการพฒันาบทเรียนออนไลน์แบบผสมผสานในกลุ่มสาระอ่ืน ๆ ต่อไป 
 
 

หลกัสูตรแกนกลางการศึกษา 
ขั้นพ้ืนฐาน พ.ศ. 2551  
กลุ่มสาระการเรียนรู้ 

การงานอาชีพและเทคโนโลย ี

ขั้นตอนการพฒันาบทเรียน
ออนไลน์แบบผสมผสาน 
ตามขั้นตอนของ ADDIE 

เน้ือหาบทเรียน  
เร่ือง การสร้างหนงัสือ

อิเลก็ทรอนิกส์ 
ดว้ยโปรแกรม Flip Album 

นกัเรียนชั้นประถมศึกษาปีท่ี 6 
โรงเรียนวดัตโปทาราม             

ภาคเรียนท่ี 1 ปีการศึกษา 2561 

บทเรียนออนไลน ์
แบบผสมผสาน กลุ่มสาระ
การเรียนรู้การงานอาชีพ 

และเทคโนโลย ี 
เร่ือง การสร้างหนงัสือ

อิเลก็ทรอนิกส์ 
ดว้ยโปรแกรม Flip album 

ส าหรับนกัเรียนชั้น
ประถมศึกษาปีท่ี 6 

 

หลกัสูตรแกนกลางการศึกษา 
ขั้นพ้ืนฐาน พ.ศ. 2551  
กลุ่มสาระการเรียนรู้ 

การงานอาชีพและเทคโนโลย ี

ขั้นตอนการพฒันาบทเรียน
ออนไลน์แบบผสมผสาน 
ตามขั้นตอนของ ADDIE 

เน้ือหาบทเรียน  
เร่ือง การสร้างหนงัสือ

อิเลก็ทรอนิกส์ 
ดว้ยโปรแกรม Flip Album 
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นิยำมค ำศัพท์เฉพำะ 
 1. การพฒันาบทเรียนออนไลน์ หมายถึง การออกแบบและสร้างบทเรียนออนไลน์ 
ตามขั้นตอนของ ADDIE ท่ีประกอบไปดว้ย ขั้นท่ี 1 การวเิคราะห์ (Analysis) ขั้นท่ี 2 การออกแบบ 
(Design) ขั้นท่ี 3 การพฒันา (Development) ขั้นท่ี 4 การน าไปใชจ้ริง (Implementation)  
ขั้นท่ี 5 การประเมินผล (Evaluation) โดยใชโ้ปรแกรม Google apps for education, Adobe  
photoshop และโปรแกรมส าเร็จรูปอ่ืน ๆ พฒันาบทเรียนเร่ืองการสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album โดยศึกษารายละเอียดเก่ียวกบัหลกัการและวธีิการสร้างบทเรียนออนไลน์
จากเอกสารและงานวิจยัท่ีเก่ียวขอ้ง   
 2. การเรียนรู้แบบผสมผสาน หมายถึง การจดักิจกรรมการเรียนการสอนท่ีเนน้ความ
ยดืหยุน่ เป็นการบูรณาการระหวา่งการเรียนการสอนออนไลน์ผา่นระบบเครือข่าย (Online learning)  
และการเรียนในหอ้งเรียนแบบดั้งเดิม (Traditional classroom) ท่ีมีการเผชิญหนา้ (Face-to-face)        
เขา้ดว้ยกนั กล่าวคือ มีการลดเวลาเรียนในชั้นเรียนปกติลง โดยเน้ือหาและกิจกรรมการเรียนรู้
บางอยา่งสามารถเรียนแบบออนไลน์ได ้เพื่อสนบัสนุนให้ผูเ้รียนเกิดการเรียนรู้ไดดี้ข้ึน ตอบสนอง
ความแตกต่างระหวา่งบุคคลของผูเ้รียน โดยมีจุดมุ่งหมายเพื่อใหผู้เ้รียนทุกคนสามารถบรรลุ 
ตามวตัถุประสงคก์ารเรียนรู้ 
 3. ประสิทธิภาพของบทเรียนออนไลน์ หมายถึง ความสามารถของบทเรียนท่ีท าให้
ผูเ้รียนสามารถปฏิบติัไดส้ าเร็จตามเกณฑม์าตรฐาน E1/ E2 เท่ากบั 85/ 85 
 3.1 E1 คือ ค่าประสิทธิภาพของงานและแบบฝึกปฏิบติั กระท าไดโ้ดยการน าคะแนน
งานทุกช้ินของนกัเรียนในแต่ละกิจกรรมของแต่ละคนมารวมกนั แลว้หาค่าเฉล่ียและเทียบส่วน 
เป็นร้อยละ 
 3.2 E2 คือ ประสิทธิภาพผลลพัธ์ของการประเมินหลงัเรียน ของแต่ละส่ือหรือ 
ชุดการสอน กระท าไดโ้ดยการเอาคะแนนจากการสอบหลงัเรียนและคะแนนจากงานสุดทา้ย 
ของนกัเรียนทั้งหมดรวมกนัหาค่าเฉล่ีย แลว้เทียบส่วนร้อย เพื่อหาค่าร้อยละ 
 3.3 85 ตวัแรก หมายถึง ค่าคะแนนเฉล่ียจากการท าแบบฝึกระหวา่งเรียน คิดเป็น 
ร้อยละของคะแนนรวมท่ีไม่ต ่ากวา่ร้อยละ 85 
 3.4 85 ตวัหลงั หมายถึง ค่าคะแนนเฉล่ียจากการท าแบบทดสอบหลงัเรียน คิดเป็น 
ร้อยละของคะแนนรวมท่ีไม่ต ่ากวา่ร้อยละ 85 
 4. ดชันีประสิทธิผลของบทเรียนออนไลน์ หมายถึง ความแตกต่างของคะแนนก่อนเรียน
และหลงัเรียน ของผูเ้รียนท่ีเรียนดว้ยบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้ 
การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album 



8 

ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 โดยใหพ้ิจารณาดูวา่นกัเรียนมีพฒันาการเพิ่มข้ึน 
อยา่งน่าเช่ือถือไดห้รือไม่ โดยการทดสอบนกัเรียนทุกคนก่อนเรียนและหลงัเรียน แลว้น ามาหา 
ค่าพฒันาการท่ีเพิ่มข้ึนของผูเ้รียน  
 5. ความพึงพอใจ หมายถึง ความรู้สึกชอบ ไม่ชอบ ของนกัเรียนท่ีมีต่อบทเรียนออนไลน์
แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสือ
อิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  ซ่ึงวดัโดยใช ้
แบบวดัความพึงพอใจท่ีผูว้จิยัไดพ้ฒันาข้ึน 
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บทที ่2 
เอกสารและงานวจิยัที่เกีย่วข้อง 

  

 การศึกษาเอกสารและงานวิจยัท่ีเก่ียวขอ้ง ในการด าเนินการศึกษาคร้ังน้ี ผูว้จิยัไดศึ้กษา
เอกสารและงานวิจยัท่ีเก่ียวขอ้ง ตามหวัขอ้ต่อไปน้ี 
 1. หลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน พุทธศกัราช 2551 กลุ่มสาระการเรียนรู้ 
การงานอาชีพและเทคโนโลยี 
 2. แนวคิดเก่ียวกบับทเรียนออนไลน์ 
 3. การเรียนรู้แบบผสมผสาน  
 4. แนวคิดเก่ียวกบั Google apps for education   
 5. การหาประสิทธิภาพของบทเรียนและดชันีประสิทธิผลของบทเรียน 
 6. การสร้างแบบทดสอบวดัผลสัมฤทธ์ิทางการเรียน 
 7. ความพึงพอใจ 
 8. งานวจิยัท่ีเก่ียวขอ้ง 
 

หลกัสูตรแกนกลางการศึกษาขั้นพืน้ฐาน พทุธศักราช 2551 กลุ่มสาระการเรียนรู้ 
การงานอาชีพและเทคโนโลย ี
 จากหลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน พุทธศกัราช 2551 ไดก้ าหนดมาตรฐาน 
การเรียนรู้และตวัช้ีวดั โดยท่ีกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี มีแนวทาง 
ในการจดัการเรียนรู้ ดงัน้ี (กรมวชิาการ, 2551) 
 1. ท าไมต้องเรียนการงานอาชีพและเทคโนโลยี 
 กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี เป็นกลุ่มสาระท่ีช่วยพฒันาใหผู้เ้รียน                      
มีความรู้ ความเขา้ใจ มีทกัษะพื้นฐานท่ีจ าเป็นต่อการด ารงชีวติและรู้เท่าทนัการเปล่ียนแปลง     
สามารถน าความรู้เก่ียวกบัการด ารงชีวติ การอาชีพและเทคโนโลย ีมาใชป้ระโยชน์ในการท างาน
อยา่งมีความคิดสร้างสรรคแ์ละแข่งขนัในสังคมไทยและสากล เห็นแนวทางในการประกอบอาชีพ   
รักการท างาน และมีเจตคติท่ีดีต่อการท างาน สามารถด ารงชีวติอยูใ่นสังคมไดอ้ยา่งพอเพียง 
และมีความสุข   
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 2. เรียนรู้อะไรในการงานอาชีพและเทคโนโลยี 
 กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี มุ่งพฒันาผูเ้รียนแบบองคร์วม เพื่อให้
มีความรู้ความสามารถ มีทกัษะในการท างาน เห็นแนวทางในการประกอบอาชีพและการศึกษาต่อ
ไดอ้ยา่งมีประสิทธิภาพ โดยมีสาระส าคญั ดงัน้ี   
 2.1 การด ารงชีวติและครอบครัว เป็นสาระเก่ียวกบัการท างานในชีวติประจ าวนั 
ช่วยเหลือตนเอง ครอบครัวและสังคมไดใ้นสภาพเศรษฐกิจท่ีพอเพียง ไม่ท าลายส่ิงแวดลอ้ม  
เนน้การปฏิบติัจริง จนเกิดความมัน่ใจและภูมิใจในผลส าเร็จของงาน เพือ่ใหค้น้พบความสามารถ 
ความถนดัและความสนใจของตนเอง 
 2.2 การออกแบบและเทคโนโลยี เป็นสาระการเรียนรู้ท่ีเก่ียวกบัการพฒันา
ความสามารถของมนุษยอ์ยา่งสร้างสรรค ์โดยน าความรู้มาใชก้บักระบวนการเทคโนโลย ี 
สร้างส่ิงของ เคร่ืองใช ้วธีิการ หรือเพิ่มประสิทธิภาพในการด ารงชีวติ 
 2.3 เทคโนโลยสีารสนเทศและการส่ือสาร เป็นสาระเก่ียวกบักระบวนการเทคโนโลยี
สารสนเทศ การติดต่อส่ือสาร การคน้หาขอ้มูล การใชข้อ้มูลและสารสนเทศ การแกปั้ญหา 
หรือการสร้างงาน คุณค่าและผลกระทบของเทคโนโลยสีารสนเทศและการส่ือสาร 
 2.4 การอาชีพ เป็นสาระท่ีเก่ียวขอ้งกบัทกัษะท่ีจ าเป็นต่ออาชีพ เห็นความส าคญั 
ของคุณธรรม จริยธรรมและเจตคติท่ีดีต่ออาชีพ ใชเ้ทคโนโลยไีดเ้หมาะสม เห็นคุณค่าของอาชีพ
สุจริตและเห็นแนวทางในการประกอบอาชีพ 
 3. สาระและมาตรฐานการเรียนรู้ 
 สาระท่ี 1 การด ารงชีวติและครอบครัว  
 มาตรฐาน ง 1.1 เขา้ใจการท างาน มีความคิดสร้างสรรค ์มีทกัษะกระบวนการท างาน 
ทกัษะการจดัการ ทกัษะกระบวนการแกปั้ญหา ทกัษะการท างานร่วมกนัและทกัษะการแสวงหา
ความรู้ มีคุณธรรมและลกัษณะนิสัยในการท างาน มีจิตส านึกในการใชพ้ลงังาน ทรัพยากร   
และส่ิงแวดลอ้มเพื่อการด ารงชีวติและครอบครัว 
 สาระท่ี 2 การออกแบบและเทคโนโลยี  
 มาตรฐาน ง 2.1 เขา้ใจเทคโนโลยแีละกระบวนการเทคโนโลย ีออกแบบและสร้างส่ิงของ
เคร่ืองใชห้รือวธีิการ ตามกระบวนการเทคโนโลยอียา่งมีความคิดสร้างสรรค ์เลือกใชเ้ทคโนโลยี
ในทางสร้างสรรคต่์อชีวติ สังคม ส่ิงแวดลอ้ม และมีส่วนร่วมในการจดัการเทคโนโลยท่ีีย ัง่ยนื 
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 สาระท่ี 3 เทคโนโลยสีารสนเทศและการส่ือสาร  
  มาตรฐาน ง 3.1 เขา้ใจ เห็นคุณค่าและใชก้ระบวนการเทคโนโลยสีารสนเทศ 
ในการสืบคน้ขอ้มูล การเรียนรู้ การส่ือสาร การแกปั้ญหา การท างานและอาชีพอยา่งมีประสิทธิภาพ 
ประสิทธิผลและมีคุณธรรม   
 สาระท่ี 4 การอาชีพ  
 มาตรฐาน ง 4.1 เขา้ใจ มีทกัษะท่ีจ าเป็น มีประสบการณ์ เห็นแนวทางในงานอาชีพ   
ใชเ้ทคโนโลยเีพื่อพฒันาอาชีพ มีคุณธรรมและมีเจตคติท่ีดีต่ออาชีพ 
 4. คุณภาพผู้เรียน 
 จบชั้นประถมศึกษาปีท่ี 3 
 ก. เขา้ใจวธีิการท างานเพื่อช่วยเหลือตนเอง ครอบครัวและส่วนรวม ใชว้สัดุอุปกรณ์                  
และเคร่ืองมือถูกตอ้งตรงกบัลกัษณะงาน มีทกัษะกระบวนการท างาน มีลกัษณะนิสัยการท างาน                            
ท่ีกระตือรือร้น ตรงเวลา ประหยดั ปลอดภยั สะอาด รอบคอบ และมีจิตส านึกในการอนุรักษ์
ส่ิงแวดลอ้ม 
 ข. เขา้ใจประโยชน์ของส่ิงของเคร่ืองใชใ้นชีวติประจ าวนั มีความคิดในการแกปั้ญหา 
หรือสนองความตอ้งการอยา่งมีความคิดสร้างสรรค ์มีทกัษะในการสร้างของเล่น ของใชอ้ยา่งง่าย 
โดยใชก้ระบวนการเทคโนโลยี ไดแ้ก่ ก าหนดปัญหาหรือความตอ้งการ รวบรวมขอ้มูล ออกแบบ 
โดยถ่ายทอดความคิดเป็นภาพร่าง 2 มิติ ลงมือสร้างและประเมินผล เลือกใชว้สัดุอุปกรณ์อยา่งถูกวธีิ 
เลือกใชส่ิ้งของเคร่ืองใชใ้นชีวติประจ าวนัอยา่งสร้างสรรค ์และมีการจดัการส่ิงของเคร่ืองใช ้
ดว้ยการน ากลบัมาใชซ้ ้ า    
 ค. เขา้ใจและมีทกัษะการคน้หาขอ้มูลอยา่งมีขั้นตอน การน าเสนอขอ้มูลในลกัษณะต่าง ๆ 
และวธีิดูแลรักษาอุปกรณ์เทคโนโลยสีารสนเทศ 
 จบชั้นประถมศึกษาปีท่ี 6 
 ก. เขา้ใจการท างานและปรับปรุงการท างานแต่ละขั้นตอน มีทกัษะการจดัการ  
ทกัษะการท างานร่วมกนั ท างานอยา่งเป็นระบบและมีความคิดสร้างสรรค ์มีลกัษณะนิสัยการท างาน
ท่ีขยนั อดทน รับผดิชอบ ซ่ือสัตย ์มีมารยาทและมีจิตส านึกในการใชน้ ้า ไฟฟ้า อยา่งประหยดั 
และคุม้ค่า 
 ข. เขา้ใจความหมาย ววิฒันาการของเทคโนโลย ีและส่วนประกอบของระบบเทคโนโลย ี
มีความคิดในการแกปั้ญหาหรือสนองความตอ้งการอยา่งหลากหลาย น าความรู้และทกัษะ 
การสร้างช้ินงาน ไปประยกุตใ์นการสร้างส่ิงของเคร่ืองใช ้ตามความสนใจอยา่งปลอดภยั โดยใช้
กระบวนการเทคโนโลย ีไดแ้ก่ ก าหนดปัญหาหรือความตอ้งการ รวบรวมขอ้มูล ออกแบบ 
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โดยถ่ายทอดความคิดเป็นภาพร่าง 3 มิติ หรือแผนท่ีความคิด ลงมือสร้างและประเมินผล เลือกใช้
เทคโนโลยใีนชีวติประจ าวนัอยา่งสร้างสรรคต่์อชีวติ สังคม และมีการจดัการเทคโนโลย ี 
ดว้ยการแปรรูปแลว้น ากลบัมาใชใ้หม่ 
 ค. เขา้ใจหลกัการแกปั้ญหาเบ้ืองตน้ มีทกัษะการใชค้อมพิวเตอร์ในการคน้หาขอ้มูล  
เก็บรักษาขอ้มูล สร้างภาพกราฟิก สร้างงานเอกสาร น าเสนอขอ้มูล และสร้างช้ินงาน 
อยา่งมีจิตส านึกและรับผิดชอบ 
 ง. รู้และเขา้ใจเก่ียวกบัอาชีพ รวมทั้งมีความรู้ ความสามารถ และคุณธรรมท่ีสัมพนัธ์ 
กบัอาชีพ  
 จบชั้นมธัยมศึกษาปีท่ี 3 
 ก. เขา้ใจกระบวนการท างานท่ีมีประสิทธิภาพ ใชก้ระบวนการกลุ่มในการท างาน  
มีทกัษะการแสวงหาความรู้ ทกัษะกระบวนการแกปั้ญหาและทกัษะการจดัการ มีลกัษณะนิสัย 
การท างานท่ีเสียสละ มีคุณธรรม ตดัสินใจอยา่งมีเหตุผลและถูกตอ้ง และมีจิตส านึกในการใช้
พลงังาน ทรัพยากรและส่ิงแวดลอ้ม อยา่งประหยดัและคุม้ค่า 
 ข. เขา้ใจกระบวนการเทคโนโลยแีละระดบัของเทคโนโลย ีมีความคิดสร้างสรรค์ 
ในการแกปั้ญหาหรือสนองความตอ้งการ สร้างส่ิงของเคร่ืองใชห้รือวธีิการ ตามกระบวนการ
เทคโนโลยอียา่งถูกตอ้งและปลอดภยั โดยถ่ายทอดความคิดเป็นภาพฉาย เพื่อน าไปสู่การสร้าง
ช้ินงานหรือแบบจ าลองความคิด และการรายงานผล เลือกใชเ้ทคโนโลยอียา่งสร้างสรรคต่์อชีวิต 
สังคม ส่ิงแวดลอ้ม และมีการจดัการเทคโนโลย ีดว้ยการลดการใชท้รัพยากรหรือเลือกใชเ้ทคโนโลยี
ท่ีไม่มีผลกระทบกบัส่ิงแวดลอ้ม 
 ค. เขา้ใจหลกัการเบ้ืองตน้ของการส่ือสารขอ้มูล เครือข่ายคอมพิวเตอร์ หลกัการและวธีิ
แกปั้ญหา หรือการท าโครงงานดว้ยกระบวนการทางเทคโนโลยสีารสนเทศ มีทกัษะการคน้หาขอ้มูล  
และการติดต่อส่ือสารผา่นเครือข่ายคอมพิวเตอร์อยา่งมีคุณธรรมและจริยธรรม การใชค้อมพิวเตอร์  
ในการแกปั้ญหา สร้างช้ินงานหรือโครงงานจากจินตนาการ และการใชเ้ทคโนโลยสีารสนเทศ
น าเสนองาน 
 ง. เขา้ใจแนวทางการเลือกอาชีพ การมีเจตคติท่ีดีต่ออาชีพและเห็นความส าคญัของ 
การประกอบอาชีพ วธีิการหางานท า คุณสมบติัท่ีจ  าเป็นส าหรับการมีงานท า วเิคราะห์แนวทางเขา้สู่
อาชีพ มีทกัษะพื้นฐานท่ีจ าเป็นส าหรับการประกอบอาชีพ และประสบการณ์ต่ออาชีพท่ีสนใจและ
ประเมินทางเลือกในการประกอบอาชีพ ท่ีสอดคลอ้งกบัความรู้ ความถนดัและความสนใจ 
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 จบชั้นมธัยมศึกษาปีท่ี 6 
 ก. เขา้ใจวธีิการท างานเพื่อการด ารงชีวติ สร้างผลงานอยา่งมีความคิดสร้างสรรค ์ 
มีทกัษะการท างานร่วมกนั ทกัษะการจดัการ ทกัษะกระบวนการแกปั้ญหา และทกัษะการแสวงหา
ความรู้ ท างานอยา่งมีคุณธรรม และมีจิตส านึกในการใชพ้ลงังานและทรัพยากรอยา่งคุม้ค่าและย ัง่ยนื 
 ข. เขา้ใจความสัมพนัธ์ระหวา่งเทคโนโลยกีบัศาสตร์อ่ืน ๆ วเิคราะห์ระบบเทคโนโลย ี 
มีความคิดสร้างสรรคใ์นการแกปั้ญหาหรือสนองความตอ้งการ สร้างและพฒันาส่ิงของเคร่ืองใช้
หรือวธีิการตามกระบวนการเทคโนโลยอียา่งปลอดภยั โดยใชซ้อฟทแ์วร์ช่วยในการออกแบบ 
หรือน าเสนอผลงาน วเิคราะห์และเลือกใชเ้ทคโนโลยท่ีีเหมาะสมกบัชีวติประจ าวนัอยา่งสร้างสรรค์
ต่อชีวิต สังคม ส่ิงแวดลอ้ม และมีการจดัการเทคโนโลยดีว้ยวธีิการของเทคโนโลยสีะอาด 
 ค. เขา้ใจองคป์ระกอบของระบบสารสนเทศ องคป์ระกอบและหลกัการท างาน 
ของคอมพิวเตอร์ ระบบส่ือสารขอ้มูลส าหรับเครือข่ายคอมพิวเตอร์ คุณลกัษณะของคอมพิวเตอร์ 
และอุปกรณ์ต่อพว่ง และมีทกัษะการใชค้อมพิวเตอร์แกปั้ญหา เขียนโปรแกรมภาษาพฒันาโครงงาน
คอมพิวเตอร์ ใชฮ้าร์ดแวร์และซอฟตแ์วร์ติดต่อส่ือสารและคน้หาขอ้มูลผา่นอินเทอร์เน็ต ใช้
คอมพิวเตอร์ในการประมวลผลขอ้มูลใหเ้ป็นสารสนเทศเพื่อการตดัสินใจ ใชเ้ทคโนโลยสีารสนเทศ
น าเสนองาน และใชค้อมพิวเตอร์สร้างช้ินงานหรือโครงงาน 
 ง. เขา้ใจแนวทางสู่อาชีพ การเลือกและใชเ้ทคโนโลยอียา่งเหมาะสมกบัอาชีพ ตลอดจน 
มีประสบการณ์ในอาชีพท่ีถนดัและสนใจ และมีคุณลกัษณะท่ีดีต่ออาชีพ 
 

แนวคดิเกีย่วกบับทเรียนออนไลน์ 
 ความหมายของบทเรียนออนไลน์  
 ปัทมา นพรัตน์ (2548) ใหค้วามหมายของการเรียนรู้แบบออนไลน์ หรือ E-learning  
วา่เป็นการศึกษาเรียนรู้ผา่นเครือข่ายคอมพิวเตอร์ อินเทอร์เน็ต (Internet) หรืออินทราเน็ต (Intranet)  
เป็นการเรียนรู้ดว้ยตวัเอง ผูเ้รียนจะไดเ้รียนตามความสามารถและความสนใจของตน โดยเน้ือหา
ของบทเรียน ซ่ึงประกอบดว้ย ขอ้ความ รูปภาพ เสียง วดีิโอและมลัติมีเดียอ่ืน ๆ จะถูกส่งไปยงั
ผูเ้รียน ผา่น Web browser โดยผูเ้รียน ผูส้อน และเพื่อนร่วมชั้นเรียนทุกคน สามารถติดต่อ ปรึกษา 
แลกเปล่ียนความคิดเห็นระหวา่งกนัได ้เช่นเดียวกบัการเรียนในชั้นเรียนปกติ โดยอาศยัเคร่ืองมือ
การติดต่อส่ือสารท่ีทนัสมยั (E-mail, Web-board, Chat) จึงเป็นการเรียนส าหรับทุกคน  
เรียนไดทุ้กเวลาและทุกสถานท่ี (Learn for all: Anyone, anywhere and anytime)  
 ชฏิล เกษมสันต ์(2547) ใหค้วามหมายของ E-learning หรือ Electronic learning  
คือ การส่งความรู้ไปสู่ผูเ้รียนโดยใชส่ื้ออิเล็กทรอนิกส์ (Electronic media) เช่น Computer   
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ท่ีเช่ือมต่อเครือข่าย Internet หรือ Intranet ในหลกัการท่ีวา่ดว้ย "การเรียนการสอนทางไกล"  
การเรียนการสอนแบบ E-learning น้ีสามารถเรียนไดจ้าก Web หรือ CD ดว้ยเคร่ืองคอมพิวเตอร์     
และผูส้อนกบัผูเ้รียนสามารถติดต่อส่ือสารกนัไดโ้ดยทาง E-mail, Web board และ Chat room   
 ปรัชญนนัท ์นิลสุข (2548) ใหค้วามหมายของ E-learning คือ การจดักระบวนการ 
และการใชป้ระโยชน์จากส่ือทางอิเล็กทรอนิกส์ โดยเฉพาะคอมพิวเตอร์และระบบอินเทอร์เน็ต   
ท่ีออกแบบการเรียนการสอนอยา่งเป็นระบบ เพือ่ให้เกิดการเรียนรู้ไดทุ้กท่ี ไม่ยดึติดกบัเวลา 
และความกา้วหนา้ในการเรียนรู้  
    ถนอมพร เลาหจรัสแสง (2547) ใหค้วามหมายของ E-learning วา่หมายถึง   
การเรียนเน้ือหาหรือสารสนเทศส าหรับการสอนหรือการอบรม ซ่ึงใชก้ารน าเสนอดว้ยตวัอกัษร  
ภาพน่ิง ผสมผสานกบัการใชภ้าพเคล่ือนไหววดิีทศัน์และเสียง โดยอาศยัเทคโนโลยขีองเวบ็   
(Web technology)ในการถ่ายทอดเน้ือหา รวมทั้งใชเ้ทคโนโลยกีารจดัหลกัสูตร (Course  
management system) ในการบริหารจดัการงานสอนต่าง ๆ 
 บุญเลิศ  อรุณพิบูลย ์(2548) ใหค้วามหมายของ E-learning คือ ระบบท่ีพฒันา 
ต่อเน่ืองมาจาก Web based instruction มีการเพิ่มเติมระบบการจดัการบริหารหลกัสูตร 
และการเรียนรู้ของผูเ้รียน น าเสนอไดท้ั้งระบบ Online และ Offline น าเสนอไดท้ั้งระบบ  
Synchronous และ Asynchronous   
 Krutus (2000) กล่าววา่ E-learning เป็นรูปแบบของเน้ือหาสาระท่ีสร้างเป็นบทเรียน
ส าเร็จรูป ท่ีอาจใชซี้ดีรอมเป็นส่ือกลางในการส่งผา่น หรือใชก้ารส่งผา่นเครือข่ายภายใน  
หรืออินเทอร์เน็ต ทั้งน้ี อาจจะอยูใ่นรูปแบบคอมพิวเตอร์ช่วยการฝึกอบรม (Computer based 
training: CBT) และการใชเ้วบ็เพื่อการฝึกอบรม (Web based training: WBT)  
หรือการเรียนการสอนทางไกลผา่นดาวเทียมก็ได ้
 Campbell (1999) ไดใ้หค้วามหมายวา่ E-learning เป็นการใชเ้ทคโนโลยท่ีีมีอยู ่
ในเครือข่ายอินเทอร์เน็ต สร้างการศึกษาท่ีมีปฏิสัมพนัธ์ และการศึกษาท่ีมีคุณภาพสูง ท่ีผูค้นทัว่โลก
มีความสะดวกและสามารถเขา้ถึงไดอ้ยา่งรวดเร็ว ไม่จ  ากดัสถานท่ีและเวลา เป็นการเปิดประตู
การศึกษาตลอดชีวิตให้กบัประชากร  
 ความส าคัญและความจ าเป็นของการจัดการสอนแบบ E-learning 
 โลกยคุปัจจุบนั E-learning เร่ิมมีความส าคญัมากข้ึน จนสามารถท าใหเ้กิดการเรียนรู้ 
ไดทุ้กเวลา ทุกสถานท่ี ไม่จ  ากดัอยูแ่ต่ในหอ้งเรียนหรือในโรงเรียนเท่านั้น นอกจากน้ี ยงัเป็น 
การส่งเสริมความสามารถในการเรียนรู้เป็นรายบุคคล และการเรียนรู้ดว้ยตนเองอยา่งต่อเน่ือง 
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ตลอดชีวิต ตอบสนองคุณลกัษณะใฝ่รู้ ใฝ่เรียน และพฒันาทกัษะการคิด การสืบคน้ของผูเ้รียน  
โดยส่วนใหญ่แลว้ E-learning จะถูกใชป้ระโยชน์ในกรณีต่อไปน้ี คือ 
 1. เป็นแหล่งความรู้ของผูเ้รียน (Knowledge based) โดยท่ีอินเตอร์เน็ต ถือเป็น 
แหล่งความรู้ท่ียิง่ใหญ่ กวา้งขวางท่ีสุดในโลก ท่ีผูเ้รียนควรไดรู้้จกัศึกษา เพื่อการแสวงหา วเิคราะห์
และสร้างองคค์วามรู้ไดเ้ป็นอยา่งดี 
 2. เป็นห้องปฏิบติัการของผูเ้รียน (Virtual lab) ในโลกของอินเตอร์เน็ต ผูเ้รียนสามารถ
เรียนรู้ ฝึกฝนทกัษะและปฏิบติักิจกรรมต่าง ๆ ไดอ้ยา่งมากมาย โดยมีแหล่งความรู้ท่ีกวา้งขวาง  
แต่อยา่งไรก็ตาม การท่ีผูเ้รียนจะไดฝึ้กฝนและปฏิบติักิจกรรมต่าง ๆ นั้น อาจตอ้งอยูใ่นความดูแล 
ก ากบั แนะน า ติดตาม ของครูผูส้อนดว้ย จึงจะท าใหกิ้จกรรมต่าง ๆ มีส่วนเสริมการเรียนรู้ 
ของผูเ้รียนไดอ้ยา่งมีประสิทธิภาพ 
 3. เป็นส่วนของหอ้งปฏิบติัการจ าลองสภาพต่าง ๆ (Sims lab) ในโลกของคอมพิวเตอร์
สามารถกระท าส่ิงต่าง ๆ ไดใ้นขณะท่ีโลกท่ีเป็นจริงไม่สามารถกระท าได ้เช่น การจ าลอง
ปรากฏการณ์ธรรมชาติ การเจริญเติบโตของส่ิงมีชีวติ การเกิดภูเขาไฟระเบิด ระบบสุริยะจกัรวาล 
หรือเหตุการณ์ท่ีอนัตราย เช่น การเกิดปฏิกิริยานิวเคลียร์ หรือการถ่ายทอดจินตนาการออกมา 
เป็นภาพท่ีชดัเจนเสมือนจริง ท าใหก้ารเรียนรู้และความคิดของมนุษยเ์ป็นไปอยา่งกวา้งขวาง  
อิสระ ไร้ขอบเขตและไร้ขอ้จ ากดัมากข้ึน 
 4. น าผูเ้รียนออกไปสู่โลกกวา้ง (Reaching out) เป็นการเปิดประตูห้องเรียนออกไปสัมผสั
กบัความเป็นไปของโลก ศึกษาส่ิงท่ีเป็นอยูจ่ริง ๆ ท่ีไม่ไดมี้อยูเ่ฉพาะแต่ในห้องเรียน หรือ 
หนงัสือเรียนเท่านั้น แต่เป็นการศึกษาความรู้ท่ีเป็นอยูจ่ริง ท าใหรู้้เท่าทนัความเป็นไป  
การเปล่ียนแปลงของโลกและรู้จกัโลกท่ีเราอยูม่ากข้ึน 
 5. น าโลกกวา้งมาสู่หอ้งเรียน (Reaching within) เป็นการดึงเอาเร่ืองท่ีอยูไ่กลตวั  
ไกลจากประสบการณ์ท่ีผูเ้รียนจะสัมผสัไดจ้ริง ๆ มาสู่หอ้งเรียน ท าใหมี้ความรู้กวา้งขวาง 
และรู้จกัน ามาใชใ้หเ้กิดประโยชน์ต่อการเรียนรู้ในสาขาวชิาต่าง ๆ และใชใ้นชีวติประจ าวนัมากข้ึน 
ในโลกปัจจุบนัเราจะพบวา่ ผูท่ี้มีขอ้มูลมากกวา่ยอ่มไดเ้ปรียบ และผูท่ี้มีขอ้มูลมากท่ีสุดจะไดเ้ปรียบ
กวา่ แต่ท่ียิง่ไปกวา่นั้นอีกก็คือ ผูท่ี้มีขอ้มูลท่ีถูกตอ้งและใชข้อ้มูลเป็นจะไดเ้ปรียบท่ีสุด ดงันั้น 
นอกจากผูเ้รียนจะรู้จกัแสวงหาขอ้มูลแลว้ ยงัตอ้งรู้จกัวิเคราะห์ความถูกตอ้ง ความเหมาะสม 
ของขอ้มูลท่ีมีอยู ่และสามารถน าขอ้มูลไปใชจึ้งจะเกิดประโยชน์สูงสุด 
 6. เป็นเวทีการแสดงออก (Performance) ระบบอินเตอร์เน็ต เป็นระบบท่ีเช่ือมโยง 
โลกทั้งหมดเขา้ดว้ยกนั ท าให้ระยะทางไม่เป็นปัญหาในการติดต่อส่ือสารอีกต่อไป ผูเ้รียนสามารถ
แสดงความคิดเห็น แสดงผลงาน แสดงทกัษะ ความรู้ ความสามารถ ออกไปสู่การรับรู้ของผูค้น 
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อยา่งไร้ขอบเขตและไดรั้บการยอมรับมากข้ึน รวมถึงมีโอกาสท่ีจะกา้วหนา้และประสบความส าเร็จ
ไดม้ากข้ึน 
 นอกจากน้ี ในการจดัการเรียนรู้ E-learning นั้น ถือวา่เป็นเร่ืองใหม่ท่ีครูผูส้อนจ าเป็นตอ้ง
ปรับแนวคิด ปรัชญาเก่ียวกบัการเรียนการสอนไปบา้ง และยอมรับขอ้จ ากดับางประการเก่ียวกบั 
การจดัการเรียนการสอน โดยปรับแนวคิดเก่ียวกบัเร่ือง ต่อไปน้ี 
  1. เป็นการจดัการเรียนรู้ท่ีทดแทนการเรียนการสอนในชั้นเรียน เพื่อใหผู้เ้รียนมีทางเลือก
ใหม่ในการเรียนรู้ ท่ีไม่ไดข้ึ้นอยูก่บัความสามารถในการถ่ายทอดเน้ือหาจากครูผูส้อนแต่เพียง 
อยา่งเดียว แต่ผูเ้รียนยงัสามารถเรียนรู้ไดจ้ากส่ิงแวดลอ้ม และจากแหล่งเรียนรู้อ่ืนๆ ท่ีอยูร่อบตวั 
รวมทั้งแหล่งเรียนรู้ในอินเตอร์เน็ตอีกดว้ย ท่ีกล่าวเช่นน้ี ไม่ไดห้มายความวา่ไม่จ  าเป็นตอ้งมี 
การเรียนการสอนในชั้นเรียน เพียงแต่ตอ้งการให้เป็นอีกทางเลือกหน่ึงของการศึกษาเรียนรู้ 
ของผูเ้รียน เป็นการเพิ่มศกัยภาพในการเรียนรู้เพิ่มเติมจากในชั้นเรียน นอกจากน้ี การจดัการเรียนรู้
ในลกัษณะอ่ืน ๆ ใหห้ลากหลายออกไป ก็จะเป็นการกระตุน้ใหผู้เ้รียนเกิดการเรียนรู้ไดดี้ยิง่ข้ึน 
  2. เป็นการจดัการเรียนรู้ท่ีตอบสนองผูเ้รียนเป็นรายบุคคล ซ่ึงความมุ่งหมายของการสอน
รายบุคคลนั้นจะยดึหลกัวา่ ผูเ้รียนตอ้งมีความรับผดิชอบในการเรียนดว้ยตนเอง ไดมี้โอกาสเรียน
ตามล าพงั จะตอ้งเป็นการสนบัสนุนส่งเสริมใหผู้เ้รียนเป็นผูเ้รียนตลอดชีวิต มากกวา่เป็นผูเ้รียน 
ท่ีอยูภ่ายใตก้ารบงัคบัตลอดเวลา เป็นการเนน้การเรียนมากกวา่การสอน เนน้ในเร่ืองความสนใจ 
ความตอ้งการ และความรู้สึกของผูเ้รียนเป็นเร่ืองส าคญัอนัดบัแรก และผูเ้รียนไดรั้บการประเมิน
ความกา้วหนา้ดว้ยตนเอง ดงันั้น ความสามารถในการเรียนรู้ดว้ยตนเองของผูเ้รียน จึงเป็น
คุณลกัษณะส าคญัต่อการเรียนรู้เป็นรายบุคคล ท่ีควรเนน้ในโลกยคุปัจจุบนัเป็นอยา่งยิง่  
แต่อยา่งไรก็ตาม การเรียนรู้ดว้ยตนเองเป็นส่ิงท่ีดี แต่การรู้จกัแต่ตนเอง มีเฉพาะโลกของตวัเอง   
ขาดความเขา้ใจต่อผูอ่ื้น ขาดการคิดแบบองคร์วม ก็เป็นส่ิงท่ีครูผูส้อนตอ้งพึงตระหนกั 
เป็นการจดัการเรียนรู้ท่ีครูผูส้อนเปล่ียนบทบาทจาก “ ผูส้อน” (Teacher) เป็น “ผูแ้นะน า”  
(Facilitator) การเรียนการสอนในชั้นเรียนนั้น ครูมกัจะเป็นผูมี้บทบาทมากท่ีสุดในชั้นเรียน  
ท าใหช้ั้นเรียนเป็นกิจกรรมส าคญัของผูส้อนไม่ใช่ผูเ้รียน นอกจากน้ี ผูเ้รียนแต่ละคนก็มีโอกาส 
ในการเรียนรู้ท่ีแตกต่างกนั ซ่ึงเป็นไปตามลกัษณะการเรียน (Learning style) ของแต่ละคน  
การจดัการเรียนรู้ E-learning จะท าใหผู้เ้รียนเป็นผูค้วบคุมการเรียนรู้ของตนเองได ้ไม่ข้ึนอยูก่บัผูอ่ื้น   
ดงันั้น บทบาทของครูในการสอนจะเปล่ียนไป โดยครูจะเป็นผูแ้นะน าวธีิการเรียน เสนอแนะ 
แนวทางการเรียนรู้ ตลอดจนอ านวยความสะดวกในการเรียนรู้ของผูเ้รียน 
  3. เป็นการเรียนรู้ท่ีผูเ้รียนเปล่ียนบทบาทจาก “ผูเ้รียน” (Learner) เป็น “ผูแ้สวงหา” 
(Researcher) เม่ือบทบาทของครูเปล่ียน บทบาทของผูเ้รียนก็ควรเปล่ียนตาม โดยผูเ้รียน 
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จะไม่เป็นผูท่ี้คอยแต่รับการสอน แต่จะมีบทบาทเป็นผูศึ้กษา ผูค้น้ควา้ เสาะแสวงหาความรู้  
สร้างองคค์วามรู้และใชอ้งคค์วามรู้นั้น ๆ ดว้ยตนเอง 
  4. เป็นการยา้ยฐานการสอนจากหอ้งเรียนจริง (Classroom-based instruction)  
ไปสู่หอ้งเรียนเสมือนบนเวบ็ (Web-based instruction) ซ่ึง E-learning เป็นการเรียนการสอน 
ผา่นระบบอินเตอร์เน็ต โดยท่ีผูเ้รียนเป็นผูศึ้กษาหาความรู้จากบทเรียนออนไลน์ท่ีผูส้อนจดัเตรียมไว ้
และระบบการติดต่อส่ือสารท่ีสามารถโตต้อบกนัได ้ท าใหมี้ลกัษณะเหมือนกบัห้องเรียนหอ้งหน่ึง  
ซ่ึงเรียกวา่ หอ้งเรียนเสมือน (Virtual classroom) ในการเรียนรู้ลกัษณะน้ี ครูตอ้งยอมรับขอ้จ ากดั 
บางประการ เช่น ครูไม่ไดเ้ป็นผูค้วบคุมชั้นเรียน ไม่ไดเ้ป็นผูค้อยสอดส่องสังเกตพฤติกรรม 
ของผูเ้รียน อยา่งไรก็ตาม ก็ยงัมีพฤติกรรมท่ีครูสามารถประเมินได ้เช่น ความรับผิดชอบ ความใฝ่รู้
ใฝ่เรียน ความพากเพียรพยายาม ความสนใจ ความร่วมมือ เป็นตน้ ท่ีสามารถประเมินไดจ้าก 
ผลงานของผูเ้รียนและการติดต่อส่ือสารระหวา่งกนัทางระบบอินเตอร์เน็ต 
  5. เป็นการจดัการเรียนรู้ท่ีผสมผสานความร่วมมือหลายฝ่าย การจดัการเรียนรู้ E-learning 
มีองคป์ระกอบหลายประการ นอกจากครูผูส้อน ซ่ึงเป็นผูเ้ช่ียวชาญในเน้ือหาแลว้ ยงัตอ้งมีผูดู้แล
ระบบ โปรแกรมเมอร์ ผูช่้วยในการผลิตบทเรียน รวมถึงผูรู้้ ผูเ้ช่ียวชาญภายนอกและผูป้กครอง  
ท่ีจะตอ้งมีส่วนร่วมในการจดัการเรียนรู้ให้เกิดประสิทธิภาพมากท่ีสุด เพราะเม่ือการจดัการเรียนรู้
ไม่ไดจ้  ากดัอยูแ่ต่ในชั้นเรียนหรือในโรงเรียนแลว้ ผูมี้ส่วนร่วมก็ไม่ไดมี้จ ากดัอยูแ่ค่ครูกบันกัเรียน
อีกต่อไป 
  รูปแบบการจัดการสอนแบบ E-learning  
 E-learning ถือวา่มีสถานะเป็นส่ือการเรียนรู้แบบหน่ึง โดยใชอุ้ปกรณ์อิเล็กทรอนิกส์ 
ในการจดัการเรียนรู้ท่ีมีประสิทธิภาพสูงมาก ซ่ึงครูผูส้อนควรจะไดน้ ามาใช้และจะตอ้งใชใ้หเ้ป็น 
โดยน ามาใชใ้นรูปแบบต่าง ๆ ไดด้งัน้ี 
 1. ส่ือการเรียนรู้ E-Learning จ าแนกตามระบบการเช่ือมโยงขอ้มูล ได ้2 ชนิด คือ 
 ชนิดท่ี 1 Stand alone หมายถึงส่ือ E-learning แบบปิด (Offline) ท่ีสามารถแสดงผลได้
บนเคร่ืองคอมพิวเตอร์บุคคลเคร่ืองใด ๆ โดยท่ีไม่ไดเ้ช่ือมโยงกบัเคร่ืองอ่ืน ๆ และเคร่ืองอ่ืน ๆ  
ไม่สามารถเรียกดูขอ้มูลเน้ือหาได ้
 ชนิดท่ี 2 Online หมายถึงส่ือ E-learning แบบเปิด ท่ีสามารถแสดงผลได ้
โดยเคร่ืองคอมพิวเตอร์อ่ืน ๆ ท่ีมีระบบใกลเ้คียงกนั โดยมีการเช่ือมโยงเป็นเครือข่ายร่วมกนั   
ซ่ึงอาจเป็นระบบเครือข่ายภายใน (Lan) หรือระบบอินเตอร์เน็ตก็ได ้
 2. ส่ือการเรียนรู้ E-learning จ าแนกตามลกัษณะวธีิการส่ือสาร ได ้2 ชนิด คือ 
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 ชนิดท่ี 1 การส่ือสารทางเดียว (One-way communication) คือ การส่ือสารในลกัษณะท่ี
ผูใ้หส้ารไม่เปิดโอกาสใหผู้รั้บการส่ือสารไดเ้ป็นฝ่ายใหส้าร และไม่สนใจต่อปฏิกิริยาตอบกลบั 
ของอีกฝ่ายหน่ึง ส่ือชนิดน้ี ไดแ้ก่ E-book ภาพน่ิง ภาพเคล่ือนไหว ท่ีเนน้การใหข้อ้มูล ถึงแมจ้ะ 
ใหผู้เ้รียนมีโอกาสสร้างปฏิสัมพนัธ์กบัส่ือ แต่ก็เป็นไปเพื่อการเลือกศึกษาเน้ือหา ไม่ไดเ้ป็น 
การโตต้อบกลบั 
 ชนิดท่ี 2 ส่ือสารสองทาง (Two-way communication) คือ การส่ือสารท่ีมีทั้งใหแ้ละรับ
ข่าวสารระหวา่งกนั โดยท่ีแต่ละฝ่ายเป็นทั้งผูส่้งสารและผูรั้บสาร มีการโตต้อบใหข้อ้มูลยอ้นกลบั
ไปมา ส่ือชนิดน้ี ไดแ้ก่ บทเรียน CAI ชนิดท่ีมีปฏิสัมพนัธ์หรือระบบจดัการบทเรียน (LMS) 
 3. ส่ือการเรียนรู้ E-learning จ าแนกตามระดบัการใชง้าน ได ้3 ชนิด คือ 
 ชนิดท่ี 1 ส่ือเสริม (Supplementary) เป็นส่ือท่ีใชป้ระกอบในการเรียนการสอนปกติ  
ผูเ้รียนเรียนแบบปกติ เป็นเพียงส่ือประกอบบทเรียนบา้ง เพื่อใหผู้เ้รียนศึกษาเพิ่มเติม ท่ีผูเ้รียนอาจจะ
ใชห้รือไม่ใชก้็ได ้หรือเป็นการท่ีครูคดัลอกเน้ือหาจากแบบเรียนไปบรรจุไวใ้นอินเตอร์เน็ต 
แลว้แนะน าใหผู้เ้รียนไปเปิดดู 
 ชนิดท่ี 2 ส่ือเพิ่มเติม (Complementary) เป็นส่ือท่ีใชใ้นการเรียนการสอนปกติ ผูเ้รียน
เรียนแบบปกติ แต่มีการก าหนดเน้ือหาใหศึ้กษาหรือสืบคน้จากส่ืออิเลคทรอนิคส์ หรือ Website  
เป็นบางเน้ือหา และมีการก าหนดกิจกรรมใหผู้เ้รียนไดเ้ขา้ไปศึกษาเน้ือหา โดยถือเป็นส่วนหน่ึง 
ของการจดัการเรียนรู้ท่ีจะตอ้งมีการวดัและประเมินการเรียนรู้ประกอบไปดว้ย ปัจจุบนั 
ในการจดัการเรียนการสอนของครู มกัจะเป็นแบบน้ีเพิ่มมากข้ึน 
 ชุดท่ี 3 ส่ือหลกั (Comprehensive replacement) เป็นส่ือใชท้ดแทนการเรียนการสอน 
หรือการบรรยายในชั้นเรียน โดยท่ีเน้ือหาทั้งหมดมีความสมบูรณ์แบบในตวัเองครบกระบวนการ
เรียนรู้ หรือเป็นเน้ือหา Online ท่ีมีการออกแบบใหใ้กลเ้คียงกบัครูผูส้อนมากท่ีสุด เพื่อใชท้ดแทน
การสอนของครูโดยตรง ส่ือชนิดน้ี ไดแ้ก่ บทเรียนส าเร็จรูปหรือส่ือคอมพิวเตอร์ช่วยสอน 
ท่ีมีการออกแบบไวอ้ยา่งเหมาะสม ครบวงจร หรือใชร้ะบบจดัการบทเรียน (LMS) 
 องค์ประกอบของการจัดการสอนแบบ E-learning 
  การจดัการสอนแบบ E-learning ตอ้งอาศยัการด าเนินการอยา่งเป็นระบบ เน่ืองจาก 
การด าเนินการตอ้งมีความเก่ียวขอ้งกนัหลายฝ่าย ในการจดัการระบบ E-learning นั้น อยา่งนอ้ยท่ีสุด
ควรประกอบไปดว้ยส่วนประกอบท่ีส าคญั 7 ส่วน คือ 
 1. กระบวนการจดัการเรียนรู้ (Learning process) ประกอบดว้ย การวเิคราะห์หลกัสูตร 
ก าหนดผลการเรียนรู้ท่ีคาดหวงัหรือจุดประสงคก์ารเรียนรู้ ก าหนดเน้ือหา ก าหนดกิจกรรมการวดั
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และประเมินผลการเรียนรู้ ซ่ึงรวมแลว้ อาจหมายถึง ตวัหลกัสูตรและการจดัการเรียนรู้ 
ของสถานศึกษา ซ่ึงในส่วนน้ีเป็นหนา้ท่ีรับผดิชอบของครูผูส้อนโดยตรง 
 2. ระบบเครือข่าย (Network) ประกอบดว้ย การวางระบบเครือข่ายภายใน (Intranet)  
และระบบเครือข่ายภายนอก (Internet) ใหเ้ช่ือมโยงทัว่ถึงกนั การจดัการเก่ียวกบัระบบเครือข่าย 
ของสถานศึกษา จะตอ้งมีความสัมพนัธ์สอดคลอ้งกบัระบบโครงสร้างพื้นฐาน (Infrastructure)  
ดา้น ICT ของประเทศดว้ย โดยอยูใ่นความรับผิดชอบของฝ่ายคอมพิวเตอร์หรือผูดู้แลระบบ 
 3. ส่ือการสอน (Instructional media) ประกอบดว้ย ส่ือท่ีใชก้ารเรียนรู้ชนิดต่าง ๆ  
ซ่ึงในท่ีน้ี หมายถึง ส่ือท่ีใชใ้นการถ่ายทอดเน้ือหาโดยผา่นระบบอิเล็กทรอนิกส์โดยเฉพาะ  
ท่ีสามารถน าเสนอผา่นระบบเครือข่ายคอมพิวเตอร์ไดโ้ดยสะดวก ซ่ึงผลิตโดยครูผูส้อน 
และอาจมีฝ่ายอ่ืน ๆ ร่วมดว้ย 
 4. การติดต่อส่ือสาร (Communication) ประกอบดว้ย วธีิการติดต่อส่ือสารแบบต่าง ๆ 
ระหวา่งผูส้อนกบัผูเ้รียน เพื่อใหก้ารเรียนการสอนประสบผลส าเร็จ การติดต่อส่ือสารมีทั้งระบบปิด 
เช่น จดหมายอิเล็กทรอนิกส์ Web cam หรือระบบเปิด เช่น กระดานข่าว กระดานสนทนา  
และการประชุมทางไกล เป็นตน้ การเลือกวธีิส่ือสารท่ีเหมาะสมจะพฒันาการเรียนรู้ของผูเ้รียน 
ไดอ้ยา่งมีประสิทธิภาพ 
  5. บุคลากรท่ีเก่ียวขอ้ง (Personals) ประกอบดว้ย ผูบ้ริหารสถานศึกษา ซ่ึงเป็นผูดู้แล
นโยบาย สนบัสนุนและควบคุม ผูดู้แลระบบเป็นผูจ้ดัการระบบ ผูพ้ฒันาโปรแกรม ครูผูส้อน  
และช่างเทคนิคเป็นผูผ้ลิต หรืออาจรวมถึงผูเ้ช่ียวชาญในสาขาอ่ืน ๆ ร่วมดว้ย เช่น นกัวเิคราะห์ 
และออกแบบระบบการสอน นกัออกแบบส่ือการน าเสนอ และผูเ้ช่ียวชาญเฉพาะสาขาวิชา เป็นตน้ 
 6. ผูเ้รียน (Learners) จะตอ้งมีความพร้อมท่ีจะเรียนรู้ผา่นระบบเครือข่าย โดยมีความรู้
ความสามารถดา้นคอมพิวเตอร์ขั้นพื้นฐานพอสมควร เก่ียวกบัการใชอิ้นเตอร์เน็ตในการสืบคน้  
การใชค้อมพิวเตอร์ในการจดัท าเน้ือหา ขอ้มูล การน าเสนองาน และการติดต่อส่ือสาร 
 7. แหล่งเรียนรู้ (Resources) ซ่ึงครูผูส้อนจะตอ้งศึกษา จดัหา เตรียมไวใ้นระบบส าหรับ
ผูเ้รียน ใหส้ามารถศึกษาและสืบคน้ไดโ้ดยสะดวก ในปัจจุบนัแหล่งเรียนรู้มีอยูก่วา้งขวางมากมาย 
และหลากหลายเพียงพอต่อการเรียนรู้ โดยท่ีผูส้อนไม่จ  าเป็นตอ้งเป็นผูผ้ลิตเน้ือหาต่าง ๆ ทั้งหมด 
เพียงแต่ครูผูส้อนควรไปศึกษาแหล่งเรียนรู้ต่าง ๆ ไวก่้อน เพื่อท่ีจะแนะน าผูเ้รียนไดอ้ยา่งเหมาะสม 
แหล่งเรียนรู้ต่าง ๆ แบ่งได ้ดงัน้ี 
 ก. แหล่งเรียนรู้ท่ีเป็นสถานท่ี ไดแ้ก่ สถานศึกษาเฉพาะทาง สถานประกอบการ  
แหล่งผลิต แหล่งจ าหน่าย พิพิธภณัฑ ์หอศิลป์ ศูนยศิ์ลปวฒันธรรม วดั อุทยานประวติัศาสตร์  
แหล่งโบราณคดี ศูนยอุ์ตสาหกรรม สถาบนัพฒันาฝีมือและแรงงาน เป็นตน้ 
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 ข. แหล่งเรียนรู้ท่ีเป็นแหล่งศึกษาอา้งอิง ไดแ้ก่ ห้องสมุด หอจดหมายเหตุ วดั หนงัสือ 
ต ารา จดหมายเหตุ บนัทึกเร่ืองราว พงศาวดาร ต านาน ภาพถ่าย ภาพวาด ภาพพิมพ ์ขอ้มูล                
ท่ีถูกบนัทึกไวโ้ดยส่ือเทคโนโลยต่ีาง ๆ และอินเตอร์เน็ต เป็นตน้ 
 3. แหล่งเรียนรู้ท่ีเป็นบุคคล ไดแ้ก่ ผูรู้้ ผูเ้ช่ียวชาญ นกัวชิาการ ช่างฝีมือ ศิลปินพื้นบา้น  
นกัปกครอง คนในทอ้งถ่ิน เป็นตน้ 
 4. แหล่งเรียนรู้ท่ีเป็นสถานการณ์จริง ไดแ้ก่ เหตุการณ์จริง ประเพณี พิธีกรรม  
ขบวนแห่งานเทศกาลต่าง ๆ 
 องคป์ระกอบของ E-learning การใหบ้ริการการเรียนแบบออนไลน์ หรือ E-learning  
มีองคป์ระกอบท่ีส าคญั 4 ส่วน โดยแต่ละส่วนจะตอ้งไดรั้บการออกแบบมาเป็นอยา่งดี  
เพราะเม่ือน ามาประกอบเขา้ดว้ยกนัแลว้ ระบบทั้งหมดจะตอ้งท างานประสานกนัไดอ้ยา่งลงตวั  
 เน้ือหาของบทเรียน  
 ส าหรับการเรียนการศึกษาแลว้ ไม่วา่จะเรียนอยา่งไรก็ตาม เน้ือหาถือวา่เป็นส่ิงท่ีส าคญั
ท่ีสุด E-learning ก็เช่นกนั อยา่งไรก็ตาม เน่ืองจาก E-learning นั้น ถือวา่เป็นการเรียนรู้แบบใหม่
ส าหรับวงการการศึกษาในประเทศไทย ดงันั้น เน้ือหาของการเรียนแบบน้ี ท่ีพฒันาเรียบร้อยแลว้ 
จึงมีอยูน่อ้ยมาก ท าใหไ้ม่เพียงพอกบัความตอ้งการในการฝึกอบรม เพิ่มพูนความรู้ พฒันาศกัยภาพ
ทั้งของบุคคลโดยส่วนตวัและของหน่วยงานต่าง ๆ ใหมี้การพฒันาเน้ือบทเรียนออนไลน์  
(Course ware) ใหม้ากข้ึน  
 ระบบบริหารจัดการการเรียนรู้ 
  เน่ืองจากการเรียนแบบออนไลน์หรือ E-learning นั้น เป็นการเรียนท่ีสนบัสนุนใหผู้เ้รียน 
ไดศึ้กษาเรียนรู้ไดด้ว้ยตวัเอง ระบบบริหารการเรียนท่ีท าหนา้ท่ีเป็นศูนยก์ลาง ก าหนดล าดบั 
ของเน้ือหาในบทเรียน น าส่งบทเรียนผา่นเครือข่ายคอมพิวเตอร์ไปยงัผูเ้รียน ประเมินผลความส าเร็จ
ของบทเรียน ควบคุมและสนบัสนุนการใหบ้ริการทั้งหมดแก่ผูเ้รียน จึงถือวา่เป็นองคป์ระกอบ 
ของ E-learning ท่ีส าคญัมาก เราเรียกระบบน้ีวา่ ระบบบริหารจดัการการเรียนรู้ (LMS: E-learning 
management system) ถา้จะกล่าวโดยรวม LMS จะท าหนา้ท่ีตั้งแต่ผูเ้รียนเร่ิมเขา้มาเรียน  
โดยจดัเตรียมหลกัสูตร บทเรียนทั้งหมดเอาไว ้พร้อมท่ีจะใหผู้เ้รียนไดเ้ขา้มาเรียน เม่ือผูเ้รียน 
ไดเ้ร่ิมตน้บทเรียนแลว้ ระบบจะเร่ิมท างานโดยส่งบทเรียนตามค าขอของผูเ้รียนผา่นเครือข่าย
คอมพิวเตอร์ (อินเทอร์เน็ต, อินทราเน็ตหรือเครือข่ายคอมพิวเตอร์อ่ืน ๆ) ไปแสดงท่ี Web browser   
ของผูเ้รียน จากนั้น ระบบก็จะติดตามและบนัทึกความกา้วหนา้ รวมทั้งสร้างรายงานกิจกรรม 
และผลการเรียนของผูเ้รียนในทุกหน่วยการเรียนอยา่งละเอียด จนกระทัง่จบหลกัสูตร  
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 การติดต่อส่ือสาร  
 การเรียนทางไกลโดยทัว่ไปแลว้ มกัจะเป็นการเรียนดว้ยตวัเอง โดยไม่ตอ้งเขา้ชั้นเรียน
ปกติ ซ่ึงผูเ้รียนจะเรียนจากส่ือการเรียนการสอนประเภทส่ิงพิมพ ์วทิยกุระจายเสียง วทิยโุทรทศัน์ 
และส่ืออ่ืน ๆ การเรียนแบบ E-learning ก็เช่นกนั ถือวา่เป็นการเรียนทางไกลแบบหน่ึง แต่ส่ิงส าคญั
ท่ีท าให ้E-learning มีความโดดเด่นและแตกต่างไปจากการเรียนทางไกลทัว่ไป คือ การน ารูปแบบ  
การติดต่อส่ือสารแบบ 2 ทาง มาใชป้ระกอบการเรียน เพื่อเพิ่มความสนใจและความต่ืนตวั 
ของผูเ้รียนท่ีมีต่อบทเรียนให้มากยิง่ข้ึน เช่น ในระหวา่งเรียน ถา้มีค าถามซ่ึงเป็นการทดสอบยอ่ย 
ในบทเรียน เม่ือค าถามปรากฏข้ึนมา ผูเ้รียนก็จะตอ้งเลือกค าตอบและส่งค าตอบกลบัมายงัระบบ
ในทนัที เหตุการณ์ดงักล่าว จะท าใหผู้เ้รียนรักษาระดบัความสนใจในการเรียนไดเ้ป็นระยะเวลา 
มากข้ึน นอกจากน้ี วตัถุประสงคส์ าคญัอีกประการของการติดต่อ 2 ทาง คือ ใชเ้ป็นเคร่ืองมือ 
ท่ีจะช่วยใหผู้เ้รียน ไดติ้ดต่อ สอบถาม ปรึกษาหารือ และแลกเปล่ียนความคิดเห็นระหวา่งตวัผูเ้รียน
กบัครู อาจารยผ์ูส้อน และระหวา่งผูเ้รียนกบัเพื่อนร่วมชั้นเรียนคนอ่ืน ๆ โดยเคร่ืองมือท่ีใช ้
ในการติดต่อส่ือสาร อาจแบ่งไดเ้ป็น 2 ประเภท ดงัน้ี   
 1. ประเภท Real-time ไดแ้ก่ Chat (Message, Voice) White board/ Text slide,  
Real-time annotations, Interactive poll, Conferencing และอ่ืน ๆ  
  2. ประเภท Non real-time ไดแ้ก่ Web-board, E-mail  
 การสอบและการวดัผลการเรียน  
 โดยทัว่ไปแลว้ การเรียนไม่วา่จะเป็นการเรียนในระดบัใดหรือเรียนวธีิใด ก็ยอ่มตอ้งมี 
การสอบ การวดัผลการเรียนเป็นส่วนหน่ึงอยูเ่สมอ การสอบและการวดัผลการเรียน 
จึงเป็นส่วนประกอบส าคญัท่ีจะท าใหก้ารเรียนแบบ E-learning เป็นการเรียนท่ีสมบูรณ์ กล่าวคือ  
ในบางวชิา จ  าเป็นตอ้งวดัระดบัความรู้ก่อนเขา้สมคัรเขา้เรียน เพื่อใหผู้เ้รียนไดเ้ลือกเรียนในบทเรียน 
หลกัสูตรท่ีเหมาะสมกบัเขามากท่ีสุด ซ่ึงจะท าใหก้ารเรียนท่ีเกิดข้ึน เป็นการเรียนท่ีมีประสิทธิภาพ
สูงสุด เม่ือเขา้สู่บทเรียนในแต่ละหลกัสูตรก็จะมีการสอบยอ่ยทา้ยบท และการสอบใหญ่ 
ก่อนท่ีจะจบหลกัสูตร 
    ปทีป เมธาคุณวฒิุ (2540) ไดก้ล่าวถึง การออกแบบโครงสร้างของการเรียนการสอน 
ผา่นเวบ็ ควรจะประกอบดว้ย  
 1. ขอ้มูลเก่ียวกบัรายวชิา ภาพรวมรายวชิา (Course overview) แสดงวตัถุประสงค ์
ของรายวชิา สังเขปรายวชิาค า อธิบายเก่ียวกบัหวัขอ้การเรียนหรือหน่วยการเรียน 
 2. การเตรียมตวัของผูเ้รียนหรือการปรับพื้นฐานผูเ้รียน เพื่อท่ีจะเตรียมตวัเรียน  



22 
 

 3. เน้ือหาบทเรียน พร้อมทั้งการเช่ือมโยงไปยงัส่ือสนบัสนุนต่าง ๆ ในเน้ือหาบทเรียน
 4. กิจกรรมท่ีมอบหมายใหท้ า พร้อมทั้งการประเมินผล การก าหนดเวลาเรียนการส่งงาน  
 5. แบบฝึกหดัท่ีผูเ้รียนตอ้งการฝึกฝนตนเอง  
 6. การเช่ือมโยงไปแหล่งทรัพยากรท่ีสนบัสนุนการศึกษาคน้ควา้  
 7. ตวัอยา่งแบบทดสอบ ตวัอยา่งรายงาน  
 8. ขอ้มูลทัว่ไป (Vital information) แสดงขอ้ความท่ีจะติดต่อผูส้อนหรือผูท่ี้เก่ียวขอ้ง 
กบัการลงทะเบียนค่าใชจ่้าย การไดรั้บหน่วยกิต และการเช่ือมโยงไปยงัสถานศึกษาหรือหน่วยงาน
และมีการเช่ือมโยงไปสู่รายละเอียดของหนา้ท่ีเก่ียวขอ้ง 
 9. ส่วนแสดงประวติัของผูส้อนและผูท่ี้เก่ียวขอ้ง  
 10. ส่วนของการประกาศข่าว (Bulletin board)  
 11. หอ้งสนทนา (Chat room) ท่ีเป็นการสนทนาในกลุ่มผูเ้รียนและผูส้อน    
 จากท่ีกล่าวมา การเรียนการสอนผา่นเวบ็เป็นการจดัการอยา่งจงใจ และน าเสนอขอ้มูล 
ท่ีมีเป้าหมาย เพื่อพฒันาการเรียนรู้โดยเฉพาะ ดงันั้น การออกแบบเวบ็ช่วยสอนจึงตอ้งพิจารณา 
ใหเ้ป็นไปตามวตัถุประสงคแ์ละการจดัระเบียบของเน้ือหาในบทเรียนท่ีสร้างข้ึน เพื่อช่วยให ้
การเรียนรู้ของผูเ้รียนเป็นไปอยา่งมีระบบ 
 ประโยชน์ของการจัดการเรียนการสอนแบบ E-learning 
 E-learning ถือไดว้า่เป็นการปรับกระบวนทศัน์ใหม่ (New paradigm shift) ทางการศึกษา    
เพราะ E-learning สามารถน าไปใชเ้พื่อพฒันาการเรียนการสอนใหมี้ประสิทธิภาพและประสิทธิผล
ยิง่ข้ึน ประโยชน์ของ E-learning มีอยูด่ว้ยกนัหลายประการ ดงัรายละเอียดต่อไปน้ี 
 1. E-learning ช่วยใหก้ารจดัการเรียนการสอนมีประสิทธิภาพมากยิง่ข้ึน งานวจิยั 
หลายช้ิน สนบัสนุนเน้ือหาการเรียน ซ่ึงถูกถ่ายทอดผา่นทางมลัติมีเดีย สามารถท าใหผู้เ้รียน 
เกิดการเรียนรู้ไดดี้กวา่การเรียนจากส่ือขอ้ความแต่เพียงอยา่งเดียว ดงันั้น หากจะเปรียบ E-learning 
กบัการสอนท่ีเนน้การบรรยายในลกัษณะ Chalk and talk ซ่ึงผูส้อนในปัจจุบนัยงัคงใชก้นัอยูน่ั้น  
E-learning ท่ีไดรั้บการออกแบบและผลิตมาอยา่งมีระบบ จะช่วยใหผู้เ้รียนเกิดการเรียนรู้ไดอ้ยา่งมี
ประสิทธิภาพมากกวา่ นอกจากในดา้นของประสิทธิภาพการเรียนอนัเกิดจากส่ือแลว้ ในดา้นของ
ระบบ E-learning ยงัมีการจดัหาเคร่ืองมือ (Course management tool) ซ่ึงท าใหผู้ส้อนสามารถ
ตรวจสอบความกา้วหนา้ของพฤติกรรมการเรียนของผูเ้รียนไดอ้ยา่งละเอียดและตลอดเวลา  
 2. E-learning จะมีการใชเ้ทคโนโลย ีHypermedia ซ่ึงเป็นการเช่ือมโยงของขอ้มูล 
ไม่วา่จะเป็นในรูปของขอ้ความ ภาพน่ิง เสียง กราฟิก วดีิโอ ภาพเคล่ือนไหว ท่ีเก่ียวเน่ือง 
เขา้ไวด้ว้ยกนัในลกัษณะ Non-linear เพื่อความสะดวกในการเขา้ถึงขอ้มูลของผูใ้ช ้ประโยชน์ 
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ของการประยกุตใ์ช ้Hypermedia ไวว้า่ Hypermedia สามารถใชเ้ป็นวธีิการน าเสนอความรู้ 
ส าหรับส่ือการเรียนการสอนท่ีมีประสิทธิภาพได ้ทั้งน้ี เน่ืองจากการท่ี Hypermedia น้ี สามารถ
น าเสนอเน้ือหาในลกัษณะของกรอบความคิดแบบใยแมงมุม (Web framework) ซ่ึงเป็น 
กรอบความคิดท่ีเช่ือวา่ จะมีลกัษณะท่ีคลา้ยคลึงกนักบัวธีิท่ีมนุษยจ์ดัระบบความคิดภายในจิตใจ    
ดงันั้น ผูเ้รียนท่ีเรียนจาก E-learning จะสามารถควบคุมการเรียนของตนได ้และยอ่มจะไดรั้บความรู้
และมีการจดจ าไดดี้ข้ึน  
 3. E-learning ท าใหผู้เ้รียนสามารถเรียนรู้ไดต้ามจงัหวะของตน (Self-paced learning)   
ผูเ้รียนสามารถท่ีจะควบคุมการเรียนของตนในดา้นของล าดบัการเรียน (Sequence)  
ตามพื้นฐานความรู้ ความถนดัและความสนใจของตน ผูเ้รียนสามารถเลือกเรียนเฉพาะเน้ือหา 
ส่วนท่ีตอ้งการทบทวน โดยไม่ตอ้งเรียนในส่วนท่ีเขา้ใจแลว้ ซ่ึงในลกัษณะน้ี ถือเป็นการใหอิ้สระ 
แก่ผูเ้รียนในการควบคุมการเรียนของตน (Learner control)   
 4. E-learning เอ้ือใหเ้กิดการโตต้อบ (Interaction) ท่ีหลากหลาย ไม่วา่จะเป็นการโตต้อบ
กบัเน้ือหา การโตต้อบกบัครูผูส้อนและกบัเพื่อน คอร์สแวร์ท่ีไดรั้บการออกแบบมาอยา่งดีนั้น 
จะเอ้ือใหเ้กิดปฏิสัมพนัธ์ระหวา่งผูเ้รียนกบัเน้ือหาไดอ้ยา่งมีประสิทธิภาพ ตวัอยา่งเช่น การออกแบบ
เน้ือหาในลกัษณะเกม หรือการจ าลอง เป็นตน้ นอกจากน้ี E-learning ยงัเอ้ือใหผู้เ้รียน 
เกิดการโตต้อบกบัครูผูส้อนและกบัเพื่อนได ้อยา่งท่ีเราทราบกนัดีวา่ การเรียนการสอนท่ีดีท่ีสุด  
คือการเรียนการสอนท่ีเปิดโอกาสใหผู้เ้รียนไดมี้การโตต้อบกบัผูส้อน หรือกบัผูเ้รียนอ่ืน ๆ  
ไดม้ากท่ีสุด  เพราะการเรียนในลกัษณะน้ี ผูส้อนจะสามารถตอบสนองความตอ้งการ ปัญหา 
และค าถามต่าง ๆ ของผูเ้รียนไดท้นัที E-learning ใหโ้อกาสผูเ้รียนในการโตต้อบกบัครูผูส้อน 
และ/ หรือการไดรั้บผลป้อนกลบัทั้งในลกัษณะเวลาเดียวกนั (Synchronous) เช่น การสนทนา (Chat) 
หรือการออกอากาศสด (Live broadcast) และในลกัษณะต่างเวลากนั (Asynchronous) เช่น การทิ้ง
ขอ้ความไวบ้นเวบ็บอร์ด (Web board)  
 5. E-learning ส่งเสริมใหเ้กิดการเรียนรู้ทกัษะใหม่ ๆ รวมทั้งเน้ือหาท่ีมีความทนัสมยั 
และตอบสนองต่อเร่ืองราวต่าง ๆ ในปัจจุบนัไดอ้ยา่งทนัท่วงที เพราะการท่ีเน้ือหาการเรียน 
อยูใ่นรูปของขอ้ความอิเล็กทรอนิกส์ (E-text) ไดแ้ก่ ขอ้ความ ซ่ึงไดรั้บการจดัเก็บ ประมวลผล 
น าเสนอ และเผยแพร่ทางคอมพิวเตอร์ จึงท าใหมี้ขอ้ไดเ้ปรียบส่ืออ่ืน ๆ หลายประการ โดยเฉพาะ
อยา่งยิง่ ในดา้นของความสามารถในการปรับปรุงเน้ือหาสารสนเทศใหท้นัสมยัไดต้ลอดเวลา  
การเขา้ถึงขอ้มูลท่ีตอ้งการดว้ยความสะดวกและรวดเร็วและความคงทนของขอ้มูล  
 6. ขอ้ความ ซ่ึงไดรั้บการจดัเก็บ ประมวลผล น าเสนอ และเผยแพร่ทางคอมพิวเตอร์ 
จึงท าใหมี้ขอ้ไดเ้ปรียบส่ืออ่ืน ๆ หลายประการ โดยเฉพาะอยา่งยิง่ ในดา้นของความสามารถ 
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ในการปรับปรุงเน้ือหาสารสนเทศใหท้นัสมยัไดต้ลอดเวลา การเขา้ถึงขอ้มูลท่ีตอ้งการ 
ดว้ยความสะดวก รวดเร็ว และความคงทนของขอ้มูล  
 7. E-learning ถือเป็นรูปแบบการเรียนท่ีสามารถจดัการเรียนการสอนให้แก่ผูเ้รียน 
ในวงกวา้งข้ึน เพราะผูเ้รียนใชก้ารเรียนในลกัษณะ E-learning จะไม่มีขอ้จ ากดั ในดา้นการท่ีจะตอ้ง
เดินทางมาศึกษาในเวลาใดเวลาหน่ึง และสถานท่ีใดสถานท่ีหน่ึง ดงันั้น E-learning ยงัสามารถ
น าไปใชเ้พื่อสนบัสนุนการเรียนในลกัษณะตลอดชีวติ (Lifelong learning)ไดด้ว้ย และยิง่ไปกวา่นั้น 
เราสามารถน า E-learning ไปใชเ้พื่อเปิดโอกาสส าหรับผูเ้รียนท่ีขาดโอกาสในการศึกษา 
ในระดบัอุดมศึกษาไดเ้ป็นอยา่งดี ซ่ึงจากงานวจิยัในประเทศไทย พบวา่ ยงัมีผูเ้รียนท่ีขาดโอกาส 
ในการศึกษาขั้นอุดมศึกษา อนัเน่ืองมาจากขอ้จ ากดัของสถาบนัการศึกษา ท่ีจ  ากดัจ านวน 
การรับผูเ้รียนอยูอี่กเป็นจ านวนมาก และมีแนวโนม้ท่ีจะเพิ่มมากข้ึนเร่ือย ๆ ในอีกทศวรรษขา้งหนา้ 
ซ่ึงการจดัการเรียนการสอนส าหรับผูเ้รียนจ านวนท่ีมากข้ึน โดยมีค่าใชจ่้ายเท่าเดิม ก็เท่ากบั 
เป็นการลดตน้ทุนในการจดัการศึกษานั้น ๆ  
   

การเรียนรู้แบบผสมผสาน 
 การจดัการศึกษาในปัจจุบนั ไดมี้การน ารูปแบบและเทคนิควธีิการสอน เพื่อให้
สนองตอบต่อการพฒันาทรัพยากรมนุษยแ์ละการแข่งขนัของประเทศ ทั้งดา้นความกา้วหนา้
ทางดา้นเทคโนโลย ีการปรับตวัต่อการกระจายความรู้ การเช่ือมโยงความรู้ดา้นต่าง ๆ ท่ีเช่ือมถึงกนั
ทัว่โลก การน าเทคโนโลยสีารสนเทศและการส่ือสารมาใชใ้นการจดัการศึกษานั้น สามารถ 
ท าไดห้ลายรูปแบบ ตั้งแต่การน าคอมพิวเตอร์มาใชเ้ป็นอุปกรณ์ในการสอน การน าบริการต่าง ๆ  
ในระบบเครือข่ายอินเตอร์เน็ต โดยเฉพาะเวลิดไ์วด์เวบ็มาพฒันาเป็นส่ือการสอนในทุกระดบั
การศึกษา และการจดัการเรียนการสอนผา่นระบบอิเล็กทรอนิกส์ โดยใชเ้ทคโนโลยอิีนเตอร์เน็ต 
เป็นส่ือกลางในการติดต่อระหวา่งผูเ้รียนและผูส้อน ผูเ้รียนสามารถเรียนไดโ้ดยไม่มีขอ้จ ากดั 
ในเร่ืองเวลาและสถานท่ี (Anytime anywhere) เป็นการสร้างโอกาสและความเสมอภาค 
ในการเรียนรู้ให้แก่ผูเ้รียน ผูเ้รียนสามารถแลกเปล่ียนเรียนรู้และส่งข่าวสารถึงกนัไดย้า่งรวดเร็ว
ก่อใหเ้กิดสังคมแห่งการเรียนรู้ ในการเรียนผา่นระบบอิเล็กทรอนิกส์ 
 ความหมายของการเรียนรู้แบบผสมผสาน (Blended learning)  
  การเรียนรู้แบบผสมผสาน มีผูใ้หค้วามหมายไว ้ดงัน้ี 
  สมาคมสโลน (Allen & Seaman, 2005) ใหค้  าจ  ากดัความของการเรียนแบบผสมผสานวา่ 
มีสัดส่วนของเน้ือหาท่ีน าเสนอออนไลน์ระหวา่ง ร้อยละ 30 ต่อ ร้อยละ 70 ค าอธิบายของการเรียน
แบบผสมผสาน คือ การเรียนท่ีผสมการเรียนออนไลน์และการเรียนในชั้นเรียน โดยท่ีเน้ือหา 
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ส่วนใหญ่ ส่งผา่นระบบออนไลน์ ใชก้ารอภิปรายออนไลน์และมีการพบปะกนัในชั้นเรียนบา้ง  
และมีส่วนท่ีน่าสนใจวา่ การอภิปรายออนไลน์ถือเป็นการส่งผา่นเน้ือหาออนไลน์เช่นกนั ส าหรับ
การเรียนในรูปอ่ืน ๆ อยา่งเช่น การเรียนแบบปกติจะไม่มีการส่งผา่นเน้ือหาออนไลน์  
การเรียนแบบใชเ้วบ็ช่วยสอน จะมีการส่งผา่นเน้ือหาออนไลน์ ร้อยละ 1-20 และการเรียนออนไลน์ 
มีการส่งผา่นเน้ือหา ร้อยละ 80-100 
 Charles R. Graham (2012) มหาวทิยาลยั Brigham Young University สหรัฐอเมริกา 
ใหค้วามหมายวา่ เป็นระบบการเรียนการสอนท่ีผสมผสานระหวา่งการเรียนแบบเผชิญหนา้ 
กบัการสอนผา่นระบบเครือข่ายคอมพิวเตอร์ 
 Michael B. Horn and Heather Staker (2011) แห่ง Innosight Instituteไดนิ้ยามเก่ียวกบั
การเรียนแบบผสมผสานของผูเ้รียนในระดบั K-12 หมายถึง การเรียนรู้ท่ีผูเ้รียนไดรั้บ 
มวลประสบการณ์ทางการเรียนรู้อยา่งเป็นอิสระ ผา่นระบบเครือข่ายคอมพิวเตอร์ โดยนกัเรียน
สามารถควบคุมตวัแปรทางการเรียนรู้ดว้ยตนเอง ทั้งในดา้นเวลา สถานท่ี แนวทางการเรียนรู้ 
และอตัราการเรียนรู้ของตนเอง 
 Radames Bernath (2012) สรุปวา่ การเรียนแบบผสมผสานหรือ Blended learning
หมายถึง โปรแกรมทางการเรียนรู้ท่ีใชว้ธีิการผสมผสานระหวา่งการเรียนรู้จากส่ืออิเล็กทรอนิกส์
หรือ E-learning กบัการสอนในชั้นเรียน 
  Wikipedia (2007) ใหค้วามหมายของการเรียนแบบผสมผสานวา่ เป็นการรวมการเรียนรู้
หลายรูปแบบ การเรียนแบบผสมผสานจะสมบูรณ์ไดด้ว้ยการใชก้ารผสมผสาน ระหวา่งทรัพยากร
การเรียนรู้ท่ีเป็นส่ือเสมือนจริงและทรัพยากรทางกายภาพ เช่น การรวมเอาส่ือท่ีตอ้งใชเ้ทคโนโลยี
กบัการเรียนในหอ้งเรียนเขา้ดว้ยกนั เพื่อใหผู้เ้รียนเกิดการเรียนรู้ 
  จากนิยามขา้งตน้อาจสรุปไดว้า่ Blended leaning หมายถึง กระบวนการเรียนรู้  
ท่ีผสมผสานรูปแบบการเรียนรู้ท่ีหลากหลาย ไม่วา่จะเป็นการเรียนรู้ท่ีเกิดข้ึนในห้องเรียน 
ผสมผสานกบัการเรียนรู้นอกหอ้งเรียน ท่ีผูเ้รียนผูส้อนไม่เผชิญหนา้กนั หรือการใชแ้หล่งเรียนรู้ 
ท่ีมีอยูห่ลากหลาย กระบวนการเรียนรู้และกิจกรรมเกิดข้ึนจากยทุธวธีิ การเรียนการสอน 
ท่ีหลากรูปแบบ เป้าหมายอยูท่ี่การใหผู้เ้รียนบรรลุเป้าหมายการเรียนรู้เป็นส าคญั 
  การเรียนแบบผสมผสาน  
 การเรียนแบบผสมผสาน ตามมโนทศัน์ (Concepts) ท่ีก าหนดนั้น จะเป็นลกัษณะ 
ของการผสมผสานการเรียนรู้ใน 4 ลกัษณะ ดงัต่อไปน้ี (Oliver & Trigwell, 2005) 
  1. การผสมผสานเทคโนโลยีการเรียนการสอนจากการเรียนผา่นเวบ็ (Web-based 
instruction) ใหเ้ป็นไปตามจุดมุ่งหมาย หรือวตัถุประสงคท่ี์ก าหนดไว ้
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  2. การผสมผสานในรูปแบบหรือวธีิการท่ีเนน้เชิงวิชาการ ในการสร้างผลผลิต 
ทางการเรียนรู้ใหสู้งข้ึนโดยปราศจากเทคโนโลยเีพื่อการสอนอ่ืน ๆ เขา้มาช่วย 
  3. การผสมผสานรูปแบบวธีิการทางเทคโนโลยทีางการสอน ผา่นหลกัสูตรเฉพาะ 
และ/ หรือการฝึกอบรม 
  4. การผสมผสานเทคโนโลยีการสอนเขา้กบังานปกติ หรือการเรียนตามปกติท่ีกระท าอยู่
ในขณะเดียวกนักบัท่ี Horn & Staker (2011) ไดจ้  าแนกถึงคุณลกัษณะในการจดัการเรียนการสอน
แบบผสมผสาน ส าหรับผูเ้รียนในระดบั K-12 ไวว้า่ การการสอนรูปแบบดงักล่าว สามารถจ าแนก
ออกเป็น 6 รูปแบบ ดงัน้ี 
 รูปแบบท่ี 1 Face to face driver เป็นรูปแบบการเรียนการสอนแบบปกติ ท่ีมี 
การเรียนแบบเผชิญหนา้ระหวา่งผูเ้รียนกบัผูส้อนในชั้นเรียนโดยการเรียนรู้แบบออนไลน์ 
ในแต่ละเร่ืองหรือแต่ละประเด็นท่ีก าหนด ในหลกัสูตรของการเรียนรู้แต่ละคร้ัง 
 รูปแบบท่ี 2 Rotation เป็นรูปแบบการเรียนรู้แบบหมุนเวยีน ตามหลกัสูตรเน้ือหา 
ในตารางท่ีก าหนดของการสอนปกติในชั้นเรียน ภายใตส้ถานการณ์ท่ีมีความหลากหลาย 
และเป็นไปตามอตัราการเรียนของแต่ละบุคคลเป็นส าคญั 
 รูปแบบท่ี 3 Flex เป็นลกัษณะการเรียนแบบผสมผสาน ท่ีมีความยดืหยุน่ในการปรับใช้
ภายใตส้ถานการณ์ท่ีต่างกนั ท่ีครูสามารถจดัใหก้บัผูเ้รียนในการเรียนรู้หลายรูปแบบ ทั้งการเรียน
แบบ Tutoring หรือการเรียนแบบกลุ่มเล็กตามกลุ่มสนใจ เป็นตน้ 
 รูปแบบท่ี 4 Online lab เป็นรูปแบบการเรียนรู้แบบผสมผสาน ท่ีเนน้การเรียน 
ในหอ้งเรียนออนไลน์ ภายใตส้ภาพการณ์ของการใชห้้องปฏิบติัการทางเทคโนโลยสีารสนเทศ 
เตม็รูปแบบ โดยครูและผูเ้ช่ียวชาญเป็นผูค้อยควบคุมใหค้วามช่วยเหลือทางการเรียนรู้แก่ผูเ้รียน 
 รูปแบบท่ี 5 Self blended เป็นรูปแบบของการเรียนแบบผสมผสานดว้ยตวัของผูเ้รียนเอง
ตามประเด็นหรือหลกัสูตรก าหนด ลกัษณะดงักล่าวน้ี ส่วนใหญ่เป็นการเรียนรู้ในระดบัอุดมศึกษา
หรือมหาวทิยาลยัท่ีมีการเช่ือมโยงขอ้มูลทางการเรียนระหวา่งกนั หรือระหวา่งสถาบนั ลกัษณะ
ดงักล่าวน้ี จะมีโปรแกรมควบคุมหลกัอยูท่ี่หอ้งปฏิบติัการตาม รูปแบบท่ี 4 ท่ีจะคอยควบคุม 
และอ านวยความสะดวกในการเรียนรู้แบบผสมผสานดว้ยตนเอง 
 รูปแบบท่ี 6 Online driver เป็นลกัษณะการเรียนแบบผสมผสานท่ีเตม็รูปแบบ 
โดยมีการเรียนแบบออนไลน์ ทั้งผูเ้รียนและผูส้อนจากหลกัสูตรท่ีก าหนด เทคโนโลยคีอมพิวเตอร์
และสารสนเทศ จะมีบทบาทค่อนขา้งสูงต่อกระบวนการขบัเคล่ือนในรูปแบบดงักล่าว 
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  จากรูปแบบของการเรียนแบบผสมผสานขา้งตน้ เห็นไดว้า่การน าเอากระบวนการเรียน
แบบผสมผสานมาใชใ้นการเรียนการสอนนั้น ประเด็นส าคญัคงตอ้งค านึงถึงความพร้อม 
และความเป็นไปไดห้ลายประการ ท่ีจะเป็นเกณฑใ์นการพิจารณาปรับใชก้ารเรียนรู้ในลกัษณะน้ี 
ใหเ้หมาะสมกบัสภาพการณ์ บริบทและความพร้อมทุกดา้น เพื่อเกิดผลและประสิทธิภาพสูงสุด 
ของการประยกุตใ์ช ้
 องค์ประกอบของการเรียนแบบผสมผสาน (5 Keys ingredients) 
 ภายใตส้ถานการณ์ของการเรียนแบบผสมผสานนั้น ประกอบดว้ย ส่ิงบ่งช้ีส าคญั  
5 ประการต่อไปน้ี ท่ีบ่งบอกถึงสภาพการณ์ของการเรียนแบบ Blended learning ไดแ้ก่  
(Carman, 2005) 
 1. เหตุการณ์หรือปรากฏการณ์ท่ีเกิดข้ึนเป็นปัจจุบนั (Live events) เป็นลกัษณะ 
ของการเรียนรู้ท่ีเรียกวา่ “การเรียนแบบประสานเวลา” (Synchronous) จากเหตุการณ์จริง 
หรือสถานการณ์จ าลองท่ีสร้างข้ึน เพื่อใหผู้เ้รียนมีส่วนร่วมในการเรียนในช่วงเวลาเดียวกนั  
เช่นเหตุการณ์ในการเรียนรู้ในชั้นเรียน ท่ีเรียกวา่ “หอ้งเรียนเสมือน” (Virtual classroom) เป็นตน้ 
 2. การเรียนเน้ือหาแบบออนไลน์ (Online content) เป็นลกัษณะการเรียน ท่ีผูเ้รียน
สามารถเรียนรู้ไดด้ว้ยตนเอง ตามสภาพความพร้อมหรืออตัราการเรียนรู้ของแต่ละคน (Self-paced 
learning) รูปแบบการเรียนเช่นการเรียนแบบส่ือปฏิสัมพนัธ์ (Interactive) การเรียนจากการสืบคน้ 
(Internet-based) หรือการฝึกอบรมจากส่ือ CD-ROM เป็นตน้ 
  3. การมีส่วนร่วมในการเรียนรู้ (Collaboration) เป็นสภาพการณ์ทางการเรียนรู้ ท่ีผูเ้รียน
สามารถส่ือสารขอ้มูลร่วมกนักบัผูอ่ื้น จากระบบส่ือออนไลน์ เช่น E-mail, Chat, Blogs เป็นตน้ 
  4. การวดัและประเมินผล (Assessment) การเรียนลกัษณะดงักล่าว ตอ้งมีการประเมินผล
ความกา้วหนา้ทางการเรียนรู้ของผูเ้รียนทุกระยะ นบัตั้งแต่การประเมินผลก่อนเรียน  
(Pre-assessment) การประเมินผลระหวา่งเรียน (Self-paced evaluation) และการประเมินผล 
หลงัเรียน (Post assessment) เพื่อน าไปสู่การปรับปรุงพฒันาการเรียนรู้ใหดี้ข้ึนต่อไป 
  5. วสัดุประกอบการอา้งอิง (Reference materials) การเรียนหรือการสร้างงาน 
ในการเรียนรู้แบบผสมผสานนั้น ตอ้งมีการเรียนรู้และสร้างประสบการณ์จากการศึกษาคน้ควา้  
และอา้งอิงจากหลากหลายแหล่งขอ้มูล เพื่อเพิ่มคุณภาพทางการเรียนใหสู้งข้ึน ลกัษณะดงักล่าวน้ี
อาจเป็นลกัษณะของการสืบคน้ขอ้มูลในระบบ Search engine จาก PDA, PDF downloads เป็นตน้ 
 แนวคิดและทฤษฎกีารเรียนรู้ทีเ่กีย่วข้อง 
  แนวคิดของการเรียนแบบผสมผสาน สามารถแบ่งออกเป็น 4 แนวคิด ไดแ้ก่ 
 1. แนวคิดผสมผสานเทคโนโลยกีารเรียนการสอนบนเวบ็กบัการเรียนในชั้นเรียน 
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แบบดั้งเดิม (To combine or mix modes of web-based technology) เช่น การเรียนในห้องเรียน
เสมือน แบบการเรียนดว้ยตนเอง การเรียนรู้ร่วมกนั วิดีโอสตรีมม่ิง เสียง และขอ้ความ เป็นตน้  
เพื่อใหบ้รรลุตามเป้าหมายของการจดัการศึกษา ซ่ึงสอดคลอ้งกบัแนวคิดของ Singh ท่ีใหนิ้ยาม 
ของการเรียนแบบผสมผสานไวว้า่ เป็นการเรียนโดยใชก้ารผสมผสานวธีิสอนท่ีหลากหลาย 
เขา้ดว้ยกนั เพื่อใหผู้เ้รียนเกิดผลสัมฤทธ์ิทางการเรียนสูงสุด 
  2. แนวคิดการผสมผสานวธีิสอนท่ีหลากหลายเขา้ดว้ยกนั (To combine various 
pedagogical approaches) เช่น แนวคิดสร้างสรรคนิ์ยม (Constructivism) แนวคิดพฤติกรรมนิยม 
(Behaviorism) และแนวคิดพุทธินิยม (Cognitivist) เพื่อใหไ้ดผ้ลลพัธ์จากการเรียนท่ีดีท่ีสุด  
ซ่ึงอาจใชห้รือไม่ใชเ้ทคโนโลยเีทคโนโลยกีารสอน (Instructional technology) ก็ได ้ซ่ึงสอดคลอ้ง
กบัแนวคิดของ Bonk & Graham ท่ีกล่าววา่ การเรียนแบบผสมผสาน เป็นการผสมผสาน 
ระบบการเรียน (Learning systems) ท่ีหลากหลายเขา้ดว้ยกนั เพื่อเป็นการแกปั้ญหาท่ีหลากหลาย 
ในการเรียน และสอดคลอ้งกบัแนวคิดของ Carman ท่ีกล่าววา่ การเรียนแบบผสมผสาน 
เป็นการผสมผสานทฤษฎีการเรียนรู้เขา้ดว้ยกนั เพื่อใหบ้รรลุวตัถุประสงคข์องการจดัการเรียนรู้ 
 3. แนวคิดการผสมผสานเทคโนโลยกีารเรียนการสอนทุกรูปแบบกบัการเรียนการสอน
ในชั้นเรียนแบบดั้งเดิม ท่ีมีการเผชิญหนา้ระหวา่งผูเ้รียนกบัผูส้อน (To combine any form of 
instructional technology with face-to-face instructor-led training) ซ่ึงเป็นมุมมองท่ีมีผูย้อมรับ 
กนัอยา่งแพร่หลายมากท่ีสุด ซ่ึงสอดคลอ้งกบั Uwes ท่ีกล่าววา่ การเรียนแบบผสมผสาน  
เป็นการบูรณาการการเรียนแบบเผชิญหนา้ การเรียนดว้ยตนเอง และการเรียนแบบร่วมมือ 
แบบออนไลน์เขา้ดว้ยกนั 
 4. แนวคิดการผสมผสานเทคโนโลยกีารเรียนการสอนกบัการท างานจริง (To mix or 
combine instructional technology with actual job tasks in order to create a harmonious effect of 
learning and working) ซ่ึงสอดคลอ้งกบั Bersin ท่ีกล่าววา่ การเรียนแบบผสมผสาน เป็นส่วนหน่ึง
ของการฝึกอบรมในองคก์ร เป็นการผสมผสานการเรียนผา่นระบบอิเล็กทรอนิกส์และส่ืออ่ืน ๆ  
ในการส่งผา่นความรู้ในการเรียนและการฝึกอบรม 
   จากแนวคิดการจดัการเรียนการสอนบนเวบ็แบบผสมผสานท่ีกล่าวมาขา้งตน้ สามารถ
สรุปไดว้า่ การเรียนแบบผสมผสาน เป็นรูปแบบการเรียนท่ีมุ่งเนน้การจดักิจกรรมการเรียนการสอน
โดยการสร้างส่ิงแวดลอ้มและบรรยากาศในการเรียนรู้ วธีิการสอนของผูส้อน รูปแบบการเรียนรู้
ผูเ้รียน ส่ือการเรียนการสอน ช่องทางการส่ือสาร และรูปแบบปฏิสัมพนัธ์ระหวา่งผูเ้รียนกบัผูส้อน 
ผูเ้รียนกบัผูเ้รียน ผูเ้รียนกบัเน้ือหา ผูเ้รียนกบับริบทในการเรียนรู้ท่ีหลากหลาย และจดักิจกรรม 
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การเรียนการสอนท่ีเนน้ความยดืหยุน่ เพื่อตอบสนองต่อความแตกต่างระหวา่งบุคคลของผูเ้รียน
เพื่อใหผู้เ้รียนแต่ละคนไดผ้ลลพัธ์ท่ีดีท่ีสุดจากการเรียนการสอน 
 เทคโนโลยกีารศึกษากบัการเรียนรู้แบบผสมผสาน 
  จากลกัษณะการเรียนรู้แบบผสมผสาน เป็นการน าเทคโนโลยทีางการศึกษาเขา้มาร่วม 
ในการจดักิจกรรมการเรียนการสอนนอกชั้นเรียน ซ่ึงสามารถน ามาใชร่้วมกนัได ้ดงัน้ี 
  1. การใชเ้ทคโนโลยกีารศึกษาในการช่วยใหก้ารเรียนการสอน มีรูปแบบ วธีิการ 
และส่ิงแวดลอ้มทางการเรียนรู้ท่ีแตกต่างไปจากเดิม (พงศป์ระเสริฐ หกสุวรรณ, 2548) เช่น 
ในงานวจิยัของ Ausburn (2004) การศึกษาเก่ียวขอ้งกบัการสร้างส่ิงแวดลอ้มทางการเรียนรู้ 
แบบผสมผสาน ในหลกัสูตรการออกแบบเบ้ืองตน้ส าหรับผูใ้หญ่ และท าการเปรียบกบักลุ่มท่ีศึกษา
จากการเรียนรู้ภายในชั้นเรียนเพียงอยา่งเดียว พบวา่ โดยทั้งสองกลุ่มมีลกัษณะคลา้ยคลึงกนั 
ทั้งทางดา้นเพศ พื้นฐานของหลกัสูตรทางการใชเ้ทคโนโลย ีทกัษะทางดา้นทิศทาง ประสบการณ์ 
และการทราบถึงวตัถุประสงคท์างการเรียน ผลการศึกษา พบวา่ ผูเ้รียนท่ีเรียนโดยใชรู้ปแบบ 
การเรียนรู้แบบผสมผสาน มีความสามารถในการรับรู้ตนเอง เกิดการรับรู้ ตระหนกัถึงการก ากบั
ตนเองไปสู่เป้าหมายของการเรียนรู้และการทบทวนความรู้ และทกัษะทางดา้นเทคโนโลย ี
ของตนเองอยูเ่สมอ นอกจากน้ี Dowling & Godfrey (2003) ท าการศึกษาการเปรียบเทียบ 
ผลการเรียนรู้ระหวา่งการสอนโดยใชก้ารเรียนการสอนแบบเผชิญหนา้ (Face to face)                  
ของการสอนแบบดั้งเดิม (Traditional) และการจดัการเรียนรู้แบบผสมผสาน จากการศึกษา พบวา่ 
ผูเ้รียนมีความพึงพอใจในการเรียน และผลการเรียนรู้แบบผสมผสานช่วยใหเ้กิดการพฒันา 
ผลการเรียนรู้ของผูเ้รียน 
 จากผลการศึกษาและวจิยัจึง พบวา่ การเรียนรู้แบบผสมผสาน เปล่ียนบทบาทครู 
จากเดิมเป็นผูส้อนภายในชั้นเรียนกลายเป็นผูอ้  านวยความสะดวกและน าเสนอเน้ือหาบทเรียน 
นอกจากน้ี ผูเ้รียนจะกลายเป็นผูแ้สวงหาความรู้ดว้ยตนเองผา่นคอมพิวเตอร์ รับรู้ความสามารถ 
ท่ีมีภายในตนเอง พฒันาทกัษะและความรู้ของตน ตลอดจนส่งผลต่อการพฒันาผลสัมฤทธ์ิ  
ทางการเรียนของผูเ้รียน 
  2. การใชเ้ทคโนโลยกีารศึกษาเป็นเคร่ืองมือ เช่น การใชค้อมพิวเตอร์ผา่นเครือข่าย
อินเทอร์เน็ตในการส่งเสริมการเรียนรู้ โดยการน าเสนอเน้ือหา กิจกรรมการเรียนการสอน แบบฝึก
ทกัษะใหผู้เ้รียน ตลอดจนเป็นเคร่ืองมือท่ีสามารถช่วยสร้างลกัษณะของการน าเสนอเน้ือหาบทเรียน
ท่ีมีปฏิสัมพนัธ์กบัผูเ้รียนเป็นรายบุคคล นอกจากน้ี ยงัสามารถช่วยลดระยะเวลาในการเรียน 
ภายในชั้นเรียน และผูเ้รียนสามารถหาความรู้เพิ่มเติมจากแหล่งการเรียนรู้บนเครือข่ายอินเทอร์เน็ต
ได ้ตวัอยา่งเช่น งานวิจยัของ Boyle & Others (2003) ท่ีมุ่งพฒันาการเรียนรู้ของผูเ้รียนใหเ้กิด



30 
 

ความส าเร็จ โดยใชก้ารผสมผสานระหวา่งการเรียนรู้แบบดั้งเดิม (Traditional) ร่วมกบัการเรียนรู้
โดยใชแ้หล่งการเรียนรู้บนเครือข่าย (Online resources) และสนบัสนุนการเรียนรู้ทางดา้นเน้ือหา 
(Tutorial support) พบวา่ การเรียนการสอนโดยใชค้อมพิวเตอร์ผา่นเครือข่ายอินเทอร์เน็ต  
เพื่อสนบัสนุนการเรียนรู้ทางเน้ือหา เพื่อสอนเน้ือหาใหม่ และการใชแ้หล่งความรู้บนเครือข่าย
อินเทอร์เน็ต มีผลต่อการช่วยพฒันาการเรียนรู้ใหผู้เ้รียนประสบผลส าเร็จเป็นรายบุคคล มากข้ึนกวา่
การสอนแบบดั้งเดิม (Traditional) เพียงอยา่งเดียว 
  นอกจากน้ี คอมพิวเตอร์ผา่นเครือข่ายอินเทอร์เน็ต ยงัช่วยลดระยะเวลาในการเขา้ชั้นเรียน
ของนกัศึกษาในมหาวทิยาลยั ดงัเช่น การวจิยัของ Cottrell & Robinson (2003) ศึกษาเก่ียวกบั 
ความเป็นไปไดข้องการลดเวลาการเรียนภายในชั้นเรียน เพื่อเอ้ือต่อการเปิดหลกัสูตรส าหรับ
นกัศึกษาท่ีอยูห่่างไกล ไดมี้โอกาสทางการเรียน ผลการวจิยั พบวา่ การเรียนรู้แบบผสมผสาน 
ท่ีมีการจดัการเรียนรู้ภายนอกชั้นเรียน โดยอาศยัเคร่ืองมือทางเทคโนโลยกีารศึกษา คือ การเรียน 
โดยใชค้อมพิวเตอร์ผา่นเครือข่ายอินเทอร์เน็ต ส่งผลใหส้ามารถลดระยะเวลาในการเรียนภายใน 
ชั้นเรียนใหล้ดลงได ้นอกจากน้ี จากการสอบถามผูเ้รียน พบวา่ มีความพึงพอใจในการจดัการเรียนรู้
แบบผสมผสาน เน่ืองจากช่วยลดระยะเวลาในการเขา้ชั้นเรียนลง  นอกจากน้ี ยงัพบวา่ การจดั 
การเรียนรู้แบบผสมผสาน เป็นแนวทางในการเพิ่มจ านวนนกัศึกษาในหลกัสูตรใหม้ากข้ึน 
การเรียนรู้แบบผสมผสาน จึงเป็นการใชป้ระโยชน์จากคอมพิวเตอร์และเครือข่ายอินเทอร์เน็ต
สนบัสนุนการเรียนรู้ของผูเ้รียน ดา้นการออกแบบการเรียนการสอนรวมถึงการจดัประสบการณ์ 
ของผูเ้รียนใหมี้รูปแบบท่ีหลากหลาย เช่น การสอนแบบน าเสนอเน้ือหาใหม่ การสอนแบบจ าลอง
สถานการณ์ และการใชเ้ครือข่ายอินเทอร์เน็ตเป็นแหล่งสนบัสนุนทรัพยากรการเรียนรู้ เม่ือการเรียน
ผา่นเครือข่ายอินเทอร์เน็ต ท าใหผู้เ้รียนไดรั้บขอ้มูลและสารสนเทศไดอ้ยา่งหลากหลาย ครูผูส้อน 
จึงควรส่งเสริมการคิดวเิคราะห์ คดัเลือกขอ้มูล หรือสารสนเทศของผูเ้รียน รวมทั้งช้ีแนะการรับ
ขอ้มูลข่าวสารท่ีเหมาะสมและน่าเช่ือถือให้แก่ผูเ้รียน 
 3. การใชเ้ทคโนโลยกีารศึกษาช่วยสร้างการเรียนรู้แบบร่วมมือของนกัเรียนและผูเ้รียน
เกิดสังคมแห่งการเรียนรู้ รวมถึงความกลา้ในการซกัถามและช่วยสร้างบรรยากาศ  
เพื่อลดความวิตกกงัวลในการเรียน เน่ืองจากการน าเทคโนโลยกีารศึกษามาใช ้สามารถสร้าง
ช่องทางในการติดต่อส่ือสารระหวา่งผูเ้รียนกบัผูเ้รียน ผูเ้รียนกบัผูส้อน ไดอ้ยา่งหลากหลายช่องทาง 
ทั้งแบบประสานเวลา (Synchronous) สามารถโตต้อบกนัไดท้นัที เช่น การสนทนาผา่นเครือข่าย
อินเทอร์เน็ต และแบบไม่ประสานเวลา (Asynchronous) โดยสามารถสร้างขอ้ค าถามไว ้ในขณะท่ี
ผูต้อบสามารถเขา้มาตอบค าถามหลงัจากนั้น เช่น ไปรษณียอิ์เล็กทรอนิกส์ 
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  การเรียนบนเวบ็แบบผสานสาน เป็นการจดักิจกรรมการเรียนการสอนท่ีบูรณาการ 
การเรียนออนไลน์ผา่นระบบเครือข่ายและการเรียนในหอ้งเรียนแบบดั้งเดิม ท่ีมีการเรียน 
แบบเผชิญหนา้เขา้ดว้ยกนั โดยใชส่ิ้งอ านวยผา่นระบบเครือข่ายอินเทอร์เน็ตเป็นส่ือ ช่องทาง 
และเคร่ืองมือในบริบทของสภาพแวดลอ้มในการเรียนออนไลน์ผา่นระบบเครือข่าย (Online 
learning environment) เพื่อสนบัสนุนการจดัการเรียนการสอน โดยเนน้การมีปฏิสัมพนัธ์ 
จากการเรียนออนไลน์ผา่นระบบเครือข่ายและการมีส่วนร่วมในการเรียนแบบดั้งเดิม ร่วมกบั 
การผสมผสานทฤษฎีการสอน (Mixing theories of learning) เขา้ดว้ยกนั โดยรวมเอาหลกัการ 
แนวคิด วธีิการของทฤษฎีพฤติกรรมนิยม ทฤษฎีพุทธินิยม และทฤษฎีสร้างสรรคนิ์ยม โดยการใช้
ทฤษฎีการสอน/ ท่ีหลากหลาย เพื่อตอบสนองความแตกต่างระหวา่งบุคคลของผูเ้รียน ใหผู้เ้รียนเกิด
การเรียนรู้ไดอ้ยา่งเท่าเทียมกนั ตามศกัยภาพท่ีตนเองมีอยู ่การพฒันารูปแบบการจดัการเรียน 
การสอนบนเวบ็แบบผสมผสาน ประกอบดว้ย 5 ขั้นตอน คือ 1) การวเิคราะห์และการวางแผน  
2) การออกแบบ 3) การพฒันา 4) การน าไปใช ้และ 5) การประเมินผล ปัจจยัส าคญัท่ีควรค านึงถึง 
ในการออกแบบระบบการเรียนการสอนบนเวบ็แบบผสมผสานใหป้ระสบผลส าเร็จ คือ ผูเ้รียน 
เน้ือหา และระบบโครงข่ายพื้นฐาน โดยมีองคป์ระกอบหลกั คือ เหตุการณ์สด การเรียนตนเอง/ 
เน้ือหาการเรียน แบบออนไลน์ การเรียนแบบร่วมมือ การประเมินผลการเรียนรู้ และอุปกรณ์
สนบัสนุนการเรียน 
 

แนวคดิเกีย่วกบั Google apps for education    
  ความหมายของ Google apps for education    
 Google apps for education หรือ Google apps ส าหรับการศึกษา คือ ชุดของฟรีอีเมล์ 
จาก Google  และเคร่ืองมือต่าง ๆ เป็นระบบเปิดในการท างานร่วมกนั เปิดกวา้งส าหรับคุณครู 
นกัเรียน นกัศึกษา ชั้นเรียนและสมาชิกครอบครัวในโลก ตวัอยา่งเคร่ืองมือท่ีนิยมใชรู้้จกักนัดี  
เช่น อีเมล ์(E-mail), เอกสาร (Docs), ปฏิทิน (Calendar), และ Group เป็นตน้ แต่เคร่ืองมือเหล่าน้ี 
จะใชส้ าหรับในการศึกษา เป็นโปรแกรมท่ี Google พฒันาใหแ้ก่โรงเรียนใชง้าน เพื่อสนบัสนุน 
การใชเ้ทคโนโลยต่ีอการเรียนการสอนและการน าอินเทอร์เน็ตไปใชใ้นเชิงสร้างสรรค ์ 
โดยโปรแกรม ประกอบดว้ย Communication: โปรแกรมส่ือสารภายในและภายนอกโรงเรียน 
Collaboration: โปรแกรมออฟฟิศ ส าหรับการแชร์และท างานร่วมกนัออนไลน์ Content: โปรแกรม
สร้างเวบ็ไซตแ์ละเน้ือหาออนไลน์ มีคุณสมบติัท่ีน่าสนใจ ดงัน้ี 
 1. การบริการรับส่งจดหมาย (Gmail) ส าหรับการด าเนินการธุรกิจและการศึกษา ใหพ้ื้นท่ี
ในการจดัเก็บขอ้มูล 25 กิกะไบต ์ไม่มีอีเมลข์ยะ และ 99.9% ในช่วงเวลาท่ีใชง้าน จะมีบริการดูแล
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เร่ืองความปลอดภยัเป็นอยา่งดีและมีระบบสนบัสนุนผูใ้ชใ้หเ้กิดความพึงพอใจมากท่ีสุด ข้ึนอยูก่บั
ขอ้ตกลงท่ีผูใ้ชท้  าไวก้บัผูใ้ห้บริการระบบเครือข่าย 
  2. Google voice search เป็นแอพพลิเคชัน่ใหม่ล่าสุดของ Google ซ่ึงน ามาเปิดตวัอีกคร้ัง
ในงาน "World Mobile Congress 2010" ท่ีกรุงบาร์เซโลนา ประเทศสเปน Google voice search  
เป็นเคร่ืองมือท่ีเกิดมาจาก Google  labs ท่ีอนุญาตใหผู้ใ้ชง้านสามารถคน้หาขอ้มูล 
ผา่นโทรศพัทมื์อถือได ้โดยผูใ้ชต้อ้งโทรเขา้ไปท่ีเบอร์ (650) 623-6702 ซ่ึงเป็นเบอร์โทรศพัท ์
ของระบบการคน้หาดว้ยเสียงของ Google  
   3. Google drive เป็นบริการจาก Google ท่ีท าใหเ้ราสามารถน าไฟลต่์าง ๆ ไปฝากไว ้
กบั Google  ซ่ึงท าใหเ้ราสามารถใชไ้ฟลเ์หล่านั้นท่ีไหนก็ได ้ไม่เพียงแค่ฝากไฟลไ์ดเ้ท่านั้น แต่ยงั
สามารถแบ่งปันไฟลก์บัคนท่ีตอ้งการและสามารถแกไ้ขร่วมกนัไดจ้ากอุปกรณ์หลายประเภท  
เช่น อุปกรณ์มือถือ อุปกรณ์แทบเลตหรือคอมพิวเตอร์ ส าหรับพื้นท่ีท่ี Google  ใหเ้ราใชบ้ริการฟรี 
อยูท่ี่ 5 GB และหากตอ้งการพื้นท่ีมากข้ึน ก็สามารถซ้ือพื้นท่ีจดัเก็บขอ้มูลเพิ่มได ้ส่วนราคาข้ึนอยูก่บั
ขนาดของพื้นท่ีการจะใชง้าน Google  drive หรือบริการต่าง ๆ ของ Google  นั้น เราจ าเป็นตอ้งมี
บญัชีอีเมลก์บัทาง Gmail ก่อน จึงจะใชง้านได ้หากจะใชบ้ญัชีอีเมลท่ี์ไม่ใช่ของ Gmail ก็จะใชง้าน
ไม่ไดค้รบถว้นสมบูรณ์เหมือน 
   4. Google maps คือบริการของ Google ท่ีใหบ้ริการเทคโนโลยดีา้นแผนท่ีประสิทธิภาพ
สูง ใชค้น้หาแผนท่ี (Web mapping) ใชง้านง่าย และใหข้อ้มูลของธุรกิจในทอ้งถ่ิน ไดแ้ก่ ท่ีตั้ง 
ของธุรกิจ รายละเอียดการติดต่อ และเส้นทางการขบัข่ี โดยบริการแผนท่ีน้ี เร่ิมตน้ใหบ้ริการ 
ตั้งแต่กลางปี ค.ศ. 2005 เป็นบริการฟรี จดัให้แก่ผูใ้ชท้ ัว่โลก ส่วนประกอบส าคญัท่ีดึงดูดผูใ้ชง้าน
เป็นอยา่งมาก คือ แผนท่ีและภาพถ่ายดาวเทียมคุณภาพดี ซ่ึงครอบคลุมพื้นผวิโลกในมาตราส่วน 
ต่าง ๆ ตามความเหมาะสม เพื่อใหง่้ายและสะดวกต่อการคน้หาและการเดินทางของผูใ้ชง้าน 
  5. Google calendar บริการดา้นปฏิทิน การจดัท าก าหนดการ ตารางการท างาน การจดั
ตารางการท างาน การนดัหมายประชุม ตอบรับการประชุม การแบ่งปันการใชป้ฏิทินร่วมกนั 
ทางระบบออนไลน์ และการใชป้ฏิทินบนโทรศพัทมื์อถือ 
  6. Google docs บริการดา้นเอกสารอิเล็กทรอนิกส์ สามารถท างานร่วมกนัได ้ 
ไม่วา่จะเป็นระหวา่งอาจารยก์บัอาจารย ์หรืออาจารยก์บันกัศึกษา สามารถแบ่งปันใชเ้อกสาร
ออนไลน์ร่วมกนัได ้ทุกท่ีทุกเวลาและทุกโอกาส มีโปรแกรมตารางค านวณอิเล็กทรอนิกส์  
และโปรแกรมน าเสนอผลงาน การท างานในระบบออนไลน์ท่ีไม่ตอ้งมีการแนบไฟล ์
 7. Google groups บริการท่ีอนุญาตให้ผูใ้ช ้ซ่ึงท างานร่วมกนัเป็นกลุ่ม สามารถ 
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สร้างรายช่ืออีเมล์ของกลุ่มคนท่ีท างานร่วมกนั สามารถแบ่งปันเน้ือหาร่วมกนัได ้สามารถคน้หา
ขอ้มูลไดอ้ยา่งรวดเร็ว 
  8. Google site เป็นบริการท่ีมีความปลอดภยัสูง บริการรหสัเขียนโปรแกรมส าหรับสร้าง
เวบ็ไซตผ์า่นระบบอินทราเน็ต และสามารถบริหารจดัการในกลุ่มคนท่ีท างานร่วมกนัเป็นอยา่งดี  
มีลกัษณะการท างานคลา้ยกบับล็อกหรือเวบ็ไซตส์ าเร็จรูป สามารถใชใ้นการสร้างโครงการสอน 
แผนการสอน สอดแทรกรูปภาพและวดิีโอประกอบการสอนทั้งหมด ลงไปในเวบ็ไซตน้ี์ได ้
 9. Google video บริการเร่ืองวดิีโอไดเ้ป็นการส่วนตวั มีความปลอดภยัสูง และมีเวบ็ 
แม่ข่ายส าหรับแบ่งปันการใชว้ดิีโอร่วมกนั  
  10. Google plus หรือ Google + เป็นเวบ็เครือข่ายสังคมออนไลน์ของ Google มีลกัษณะ
การใชง้านคลา้ยกบั Facebook ปัจจุบนัมีผูใ้ชง้านทั้งหมดประมาณ 540 ลา้นคน สามารถเช่ือมต่อ 
ไปยงั Gmail และ YouTube ได ้ 
 ขั้นตอนการใช้ Google apps for education ในการพฒันานวตักรรมการเรียนการสอน 
 Google plus เป็น Social network คลา้ยกบั Facebook เป็นหน่ึงใน Application ท่ี Google 
พฒันาข้ึนมา และสามารถตอบสนองระหวา่งผูส้อนกบัผูเ้รียนในเร่ืองของการมีปฏิสัมพนัธ์ 
ระหวา่งกนั การพูดคุยโตต้อบกนั รวมไปถึงการเรียนการสอนทางไกลผา่นเครือขายอินเทอร์เน็ต 
ไดเ้ป็นอยา่งดี จุดเด่นของ Google plus ในการจดัการเรียนการสอน คือ 
  1. มีส่วนสนทนา (Chat) ส าหรับการโตต้อบแบบทนัทีทนัใด ระหวา่งผูเ้รียนกบัผูส้อน 
 2. แฮงคเ์อาท ์(Hang out) ใชส้ าหรับพูดคุยหรือสนทนา ผา่นภาพและเสียงระหวา่งบุคคล
ท่ีอยูใ่นกลุ่มหรือแวดวงนั้น ๆ 
 3. ไทมไ์ลน์ (Timeline) เป็นส่วนท่ีแสดงการอพัเดต (Update) ต่าง ๆ ของผูส้อน 
และผูเ้รียน ท าใหท้ราบความเคล่ือนไหวต่าง ๆ ไดท้นัท่วงที 
  4. การจดัการเอกสารต่าง ๆ เช่น การสร้างเอกสาร การสร้างไฟลน์ าเสนอ การสร้างตาราง
ค านวณ เป็นตน้ สามารถท าไดแ้บบออนไลน์ เผยแพร่ไดท้นัที 
 ปัจจุบนั Google apps for education มีการพฒันากา้วหนา้และมีแอพพลิเคชัน่มากมาย
หลายชนิดใหผู้ใ้ชไ้ดติ้ดตั้งบน Web browser เพื่ออ านวยความสะดวกในการใชง้าน รวมถึง 
การพฒันาแอพพลิเคชัน่ส าหรับ Mobile phone และ Tablet เพื่อให้ผูเ้รียนเกิดการเรียนรู้ไดทุ้กท่ี  
ทุกเวลา มีการส่ือสารระหวา่งผูส้อนและผูเ้รียนไดต้ลอดเวลาเช่นกนั 
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  ข้อดี Google apps for education   
  นอกจาก Google apps for education จะมีโปรแกรมจดัการเอกสารพื้นฐานต่าง ๆ ใหใ้ช้
งานแลว้ ผูใ้ชไ้ม่จ  าเป็นตอ้งติดตั้งชุดโปรแกรมลงในเคร่ืองคอมพิวเตอร์ของตนเอง เพราะการใชง้าน 
จะใชง้านแบบออนไลน์ทั้งหมด กล่าวคือ จะตอ้งมีการเช่ือมต่อและใชง้านผา่นบราวเซอร์ 
หรือผา่นอุปกรณ์มือถือ ซ่ึงจะช่วยสร้างไฟลเ์อกสาร ไฟล ์Spread sheet หรือ Presentation รวมถึง
ผลงานต่าง ๆ ผา่น Google apps ไดเ้กือบหมด ปัจจุบนั Google apps for education มีการพฒันา
กา้วหนา้และมีแอพพลิเคชัน่มากมายหลายชนิดใหผู้ใ้ชไ้ดติ้ดตั้งบน Web Browser เพื่อ 
อ านวยความสะดวกในการใชง้าน รวมถึงการพฒันาแอพพลิเคชัน่ส าหรับ Mobile phone  
และ Tablet เพื่อให้ผูเ้รียนเกิดการเรียนรู้ไดทุ้กท่ี ทุกเวลา มีการส่ือสารระหวา่งผูส้อนและผูเ้รียน 
ไดต้ลอดเวลาเช่นกนั  
 กรณีศึกษา การใชเ้ทคโนโลยี Google apps for education ในการพฒันานวตักรรม 
การเรียนการสอน ประเทศสหรัฐอเมริกา โรงเรียน Hillsborough Township Public Schools (HTPS) 
ในเขตพื้นท่ีการศึกษา ท่ีประกอบดว้ย โรงเรียน ชุมชนท่ีเป็นของรัฐ คน้พบวา่ แอปจาก Google play 
for education สามารถใชป้ระโยชน์ไดห้ลากหลายอยา่งมากในชั้นเรียน ซ่ึงดีมาก เพราะเด็กไดมี้
ส่วนร่วมในประสบการณ์การเรียนรู้จริง ๆ จนไม่รู้ตวัเลยวา่ก าลงัเรียนอยู ่ท  าใหเ้ด็กมีแรงกระตุน้ท่ี
จะเรียนรู้มากข้ึน และน า Google apps for education มาใชใ้นการพฒันาการเรียนการสอน เน่ืองจาก
เป็นตวัเลือกดา้นเทคโนโลยใีนชั้นเรียนท่ีเรียบง่ายและประหยดัใหก้บั Hillsborough Township 
Schools ดว้ยการเร่ิมใชง้านท่ีรวดเร็วและวธีิช าระเงิน เพื่อช่วยใหค้รูสามารถบริหารจดัการการ
แจกจ่ายแอปท่ีมีประโยชน์ในชั้นเรียนง่ายข้ึน (Google Inc, 2014) 
  KIPP (Knowledge is power program) เป็นเครือข่ายระดบัประเทศของประเทศ
สหรัฐอเมริกา ประกอบดว้ย โรงเรียนแบบเปิดท่ีด าเนินการจากเงินอุดหนุนของรัฐ มุ่งเนน้ 
เตรียมความพร้อมใหน้กัเรียนประสบความส าเร็จในระดบัอุดมศึกษา และในการด าเนินชีวติ KIPP 
Bridge Charter School เป็นโรงเรียนสมาชิกท่ีตั้งอยูใ่นโอ๊คแลนด ์แคลิฟอร์เนีย มีนกัเรียน 319 คน 
ไดน้ าแทบ็เล็ตพร้อม Google apps for education มาใชใ้นการเรียนการสอน ซ่ึงช่วยใหค้รูของ KIPP 
สามารถแจกจ่ายแอปส าคญัในชั้นเรียนไดผ้า่นระบบคลาวด ์นกัเรียนมีช่องทางใหม่ในการใชเ้วบ็
ภายในชั้นเรียน และสามารถเขา้ถึงกิจกรรมการเรียนรู้ท่ีครบครัน การแนะน าเทคโนโลย ี
สร้างความต่ืนตวัอยา่งมาก และเป็นกระบวนการท่ีราบร่ืน อินเทอร์เฟซของอุปกรณ์นั้นใชง้านง่าย 
ท าใหน้กัเรียนเขา้ใจวธีิใชโ้ดยแทบไม่ตอ้งเรียนรู้กนัใหม่ นกัเรียนไดเ้ห็นภาพรวม ไดรั้บมุมมอง 
ท่ีหลากหลายและแสดงความคิดเห็นไดอ้ยา่งชาญฉลาด ดว้ยเหตุน้ี การท างานของนกัเรียน 
จะมีความหลากหลายยิง่ข้ึน (Google Inc, 2014)  
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 ประเทศองักฤษ ทางเขตพื้นท่ีการศึกษา Clark stown central (CCSD) ใหบ้ริการนกัเรียน
ประมาณ 8,600 คน ทางตอนใตข้องนิวยอร์ก Clark stown มีความภาคภูมิใจกบัการสนบัสนุน
บรรยากาศของโรงเรียนขนาดเล็ก การมีส่วนร่วมของชุมชน และการมุ่งเนน้ท่ีตวับุคคล เขตพื้นท่ี
การศึกษาน้ี มีโรงเรียนระดบัประถมศึกษา 10 แห่ง มธัยมตน้ 1 แห่ง มธัยมปลาย 2 แห่ง  
และศูนยก์ารศึกษาทางเลือกระดบัอนุบาลถึงมธัยมปลายอีก 1 แห่ง เขตพื้นท่ีการศึกษาน้ี น าเสนอ
โปรแกรมท่ีเป็นนวตักรรมใหแ้ก่นกัเรียนผา่นเทคโนโลยทีางเวบ็ และเป็นหน่ึงในเขตแรก ๆ ท่ีใช ้
Google apps for education ตลอดจนเคร่ืองมือนวตักรรมใหม่ ๆ อีกมากมาย แมใ้นช่วงเวลา 
ท่ีมีงบประมาณจ ากดั ทางเขตก็ยงัสามารถหาเคร่ืองมือท่ีเหมาะสมใหก้บัคณาจารยแ์ละนกัเรียนได ้
และหลงัจากใช ้Google classroom เป็นเวลา 2-3 เดือน นกัการศึกษาและทีมไดช้ี้ใหเ้ห็นประโยชน์
ส าคญั 2 ประการ คือ นกัเรียนมีส่วนร่วมเพิ่มข้ึนและชั้นเรียนมีการจดัระเบียบดียิง่ข้ึน Google 
classroom ช่วยใหง้านของนกัเรียนไดรั้บการจดัระเบียบดีข้ึน มีเคร่ืองมือและแอปพลิเคชัน่ 
ส าหรับการท างานร่วมกนั ซ่ึงมีความจ าเป็นอยา่งยิง่ ใชง้านง่ายและแจกจ่ายไดง่้าย (Google Inc, 
2014) ประเทศอินเดีย Fountainhead Global School ตั้งอยูใ่นกรุงไฮเดอราบดั ประเทศอินเดีย  
เป็นโรงเรียนเอกชนทอ้งถ่ิน ไดมี้ความห่วงใยวา่ผูป้กครองจะไม่ไดท้ราบถึงความส าเร็จของเด็ก ๆ 
และข่าวสารของโรงเรียน ทางโรงเรียนจึงจ าเป็นตอ้งหาวธีิส่ือสารข่าวใหม่ ๆ ของโรงเรียน 
กบัผูป้กครอง เจา้หนา้ท่ีและนกัเรียนอยา่งสะดวกและรวดเร็ว จึงน าเทคโนโลย ีGoogle apps for 
education มาใชใ้นการพฒันาการเรียนการสอน เน่ืองจาก เป็นช่องทางท่ีปลอดภยั ราคาประหยดั
และส่ือสารกบัทุกคนในโรงเรียนไดอ้ยา่งราบร่ืน โดยไม่ตอ้งมีผูดู้แลเวบ็ แค่คลิกเพียงไม่ก่ีคร้ัง  
ครูก็สามารถแชร์ผลงานความส าเร็จของนกัเรียนกบัผูใ้ชไ้ซตไ์ดอ้ยา่งปลอดภยั ผูป้กครองจึงสามารถ
ดูวา่บุตรหลานมีความส าเร็จอยา่งไรบา้ง และยงัสามารถส่ือสารกบัผูบ้ริหารโรงเรียนไดโ้ดยตรง 
ส่วนนกัเรียนนั้นไดรั้บประโยชน์จากการท างานร่วมกนัในแต่ละวนั (Google Inc, 2014) 
ประเทศเมก็ซิโก Centro de Formación Escolar Banting หรือเรียกอีกอยา่งวา่ Colegio Banting
ประกอบดว้ยโรงเรียนเอกชน 2 แห่งใน Coyoacán กรุงเมก็ซิโกซิตี นกัเรียนของ Colegio Banting  
มีตั้งแต่นกัเรียนอนุบาลไปจนถึงมธัยมศึกษาปีท่ี 6 ซ่ึงส่วนใหญ่มาจากครอบครัวท่ีมีฐานะปานกลาง
ถึงยากจน Colegio Banting ก่อตั้งข้ึนโดยมีพนัธกิจท่ีจะส่งเสริมการเรียนรู้อยา่งครบวงจร และมี
เป้าหมายท่ีจะเตรียมความพร้อมใหน้กัเรียนสามารถตอบสนองความตอ้งการและพร้อมรับโอกาส
ในศตวรรษท่ี 21 โดยอาศยัการมุ่งเนน้การผสมผสานเทคโนโลยเีขา้กบัการเรียนรู้ โดย Colegio 
Banting พบความทา้ทายในการเตรียมความพร้อมใหก้บันกัเรียนท่ีมาจากครอบครัวหลากหลาย
ระดบั และมีจ านวนมากท่ีไม่สามารถจ่ายค่าเล่าเรียนไดเ้อง ในการสอบแข่งขนัเขา้เรียน 
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ในมหาวทิยาลยัชั้นน าของโลก ทางสถาบนัตอ้งการสร้างความเสมอภาคโดยใชเ้ทคโนโลยท่ีีดีท่ีสุด 
ในราคาต ่าท่ีสุด เพื่อพฒันาการศึกษาและเพิ่มสัมฤทธ์ิผลทางวชิาการของนกัเรียนและทางโรงเรียน 
ตอ้งการแพลตฟอร์มท่ีเป็นหน่ึงเดียว เพื่อใหน้กัเรียน ครู ผูป้กครอง และผูบ้ริหารสามารถเขา้ถึง
ขอ้มูลท่ีแชร์กนัไดม้ากข้ึน ทั้งในและนอกสถานศึกษา และน า Google apps for education มาใช ้
ในการจดัการเรียนการสอน เน่ืองจากเป็นเคร่ืองมือรวมบทเรียน งาน และประกาศของโรงเรียน 
ไวใ้นระบบออนไลน์ระบบเดียว ท่ีสามารถเขา้ถึงไดจ้ากทุกท่ี และ Google apps for education 
ยงัช่วยยกระดบัความโปร่งใสและสนบัสนุนการท างานร่วมกนัระหวา่งนกัเรียน ผูป้กครอง ครู  
และผูบ้ริหารอีกดว้ย (Google Inc, 2014) 
  ประเทศไทย มหาวทิยาลยัขอนแก่น จบัมือ Google ร่วมพฒันาส่งเสริมศกัยภาพดา้นไอที 
ใหน้กัศึกษาและบุคลากร เติมเตม็ความตอ้งการผูใ้ชง้านอีเมล ์พร้อมกระตุน้การติดต่อส่ือสาร 
ผา่นโซเชียลเน็ตเวิร์คอยา่งมีคุณค่า โดยสืบเน่ืองจากปัญหาระบบ E-mail โดเมน kku.ac.th  
ของมหาวทิยาลยัขอนแก่น ไม่สามารถเช่ือมต่อกบัระบบอ่ืนของมหาวทิยาลยั และไม่สามารถ
รองรับความตอ้งการของผูใ้ชไ้ดเ้ตม็ท่ี ทางคณะผูบ้ริหารและ รองศาสตราจารย ์ดร.กิตติชยั  
ไตรรัตนศิริชยั อธิการบดีมหาวทิยาลยัขอนแก่น จึงไดร่้วมหารือกบัทีมงานจาก Google   
ในการพฒันาระบบ Google apps for education ซ่ึงทาง Google ใหค้วามช่วยเหลือโดยไม่มีค่าใชจ่้าย
ใด ๆ โดย ผูช่้วยศาสตราจารย ์ดร.เด่นพงษ ์สุดภกัดี รองอธิการบดีฝ่ายวชิาการและเทคโนโลยี
สารสนเทศ มหาวทิยาลยัขอนแก่น กล่าววา่ ทางมหาวทิยาลยัไม่สามารถติดต่อกบัศิษยเ์ก่า 
ผา่นช่องทางอีเมล์ kku.ac.th ได ้เพราะไม่ถูกใชอ้ยา่งต่อเน่ือง มหาวทิยาลยัขอนแก่นจึงตอ้งการ
พฒันาระบบเพื่อตอบสนองความตอ้งการใหก้บันกัศึกษาใหม่ ศิษยปั์จจุบนัและบุคลากร จากเหตุผล
ท่ีกล่าวมา จึงเป็นจุดประสงคข์องการพฒันา Google apps for education ในมหาวทิยาลยัขอนแก่น 
  สังคมในยคุปัจจุบนั เป็นสังคมท่ีพฒันาดว้ยเคร่ืองมือท่ีเก่ียวของกบัเทคโนโลย ี
และการส่ือสาร การจดัการเรียนการสอนในห้องเรียน จึงมีความจ าเป็นอยา่งมากท่ีจะตอ้ง 
น าเคร่ืองมือหรือเทคโนโลยใีหม่ ๆ เขา้มาใชใ้นการจดัระบบการเรียนการสอน เพื่อช่วย 
อ านวยความสะดวกในหลาย ๆ ดา้น ไม่วา่จะเป็นการสร้างปฏิสัมพนัธ์ระหวา่งผูส้อนกบัผูเ้รียน  
การจดัการเรียนรู้ท่ีเนน้ผูเ้รียนเป็นส าคญั การเรียนการสอนผา่นเครือข่ายอินเทอร์เน็ต ท่ีสามารถ 
เขา้เรียนไดทุ้กท่ี ทุกเวลา ซ่ึงจะเห็นวา่สังคมออนไลน์ ไดเ้ขา้มามีบทบาทอยา่งมากในการจดั 
การเรียนการสอน แต่ในบางคร้ังสังคมออนไลน์ท่ีครูผูส้อนใชอ้ยูใ่นปัจจุบนั อาจจะยงัตอบสนอง
ความตอ้งการหรือปัญหาตาง ๆ ไดไ้ม่มากนกั เคร่ืองมือท่ีน่าสนใจในการจดัการเรียนการสอน
ปัจจุบนั คือ Google apps for education ท่ีจดัไดว้า่เป็นเคร่ืองมือท่ีช่วยตอบสนองปัญหาต่าง ๆ  
ของการเรียนการสอนในห้องเรียนไดอ้ยา่งหลากหลายและมีประสิทธิภาพอีกเคร่ืองมือหน่ึง 
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ในการจดัการเรียนการสอนของไทย ดงันั้นจะเห็นไดว้า่ Google apps for education สามารถ 
ตอบโจทยก์ารศึกษายคุใหม่ไดอ้ยา่งมีประสิทธิภาพ จึงไดช่ื้อวา่เป็นการสร้างต านานแห่งโลก
การศึกษายคุใหม่ เพราะไดท้  าใหรู้ปแบบการจดัการเรียนการสอน การติดต่อส่ือสาร  
การมีปฏิสัมพนัธ์แปรเปล่ียนไปจากอดีตอยา่งส้ินเชิง 
  

การหาประสิทธิภาพของบทเรียนและดัชนีประสิทธิผลของบทเรียน 
 การผลิตส่ือหรือชุดการสอนนั้น ก่อนน าไปใชจ้ริงจะตอ้งน าส่ือหรือชุดการสอน 
ท่ีผลิตข้ึนไปทดสอบประสิทธิภาพ เพื่อดูวา่ส่ือหรือชุดการสอนท าใหผู้เ้รียนมีความรู้เพิ่มข้ึนหรือไม่ 
มีประสิทธิภาพในการช่วยใหก้ระบวนการเรียนการสอนด าเนินไปอยา่งมีประสิทธิภาพเพียงใด 
 มีความสัมพนัธ์กบัผลลพัธ์หรือไม ่และผูเ้รียนมีความพึงพอใจต่อการเรียนจากส่ือหรือชุดการสอน
ในระดบัใด ดงันั้น ผูผ้ลิตส่ือการสอนจ าเป็นจะตอ้งน าส่ือหรือชุดการสอนไปหาคุณภาพ เรียกวา่ 
การทดสอบประสิทธิภาพ 
 ความหมายของการทดสอบประสิทธิภาพ 
 ประสิทธิภาพ (Efficiency) หมายถึง สภาวะหรือคุณภาพของสมรรถนะ 
ในการด าเนินงานเพื่อใหง้านมีความส าเร็จ โดยใชเ้วลา ความพยายามและค่าใชจ่้ายคุม้คา่ท่ีสุด 
ตามจุดมุ่งหมายท่ีก าหนดไว ้เพื่อใหไ้ดผ้ลลพัธ์โดยก าหนดเป็นอตัราส่วนหรือร้อยละ ระหวา่งปัจจยั
น าเขา้ กระบวนการ และผลลพัธ์ (Ratio between input, process and output) ประสิทธิภาพ 
เนน้การด าเนินการท่ีถูกตอ้งหรือกระท าส่ิงใด ๆ อยา่งถูกวธีิ (Doing the thing right)  ค  าวา่
ประสิทธิภาพ มกัสับสนกบัค าวา่ ประสิทธิผล (Effectiveness) ซ่ึงเป็นค าท่ีคลุมเครือ ไม่เนน้ปริมาณ 
และมุ่งใหบ้รรลุวตัถุประสงค ์และเนน้การท าส่ิงท่ีถูกท่ีควร (Doing the right thing) ดงันั้น สองค าน้ี
จึงมกัใชคู้่กนั คือ ประสิทธิภาพและประสิทธิผล 
  การทดสอบประสิทธิภาพของส่ือหรือชุดการสอน หมายถึง การหาคุณภาพของส่ือ 
หรือชุดการสอน โดยพิจารณาตามขั้นตอนของการพฒันาส่ือหรือชุดการสอนแต่ละขั้น ตรงกบั
ภาษาองักฤษวา่ “Developmental testing”  คือ การทดสอบคุณภาพตามพฒันาการของการผลิตส่ือ
หรือชุดการสอนตามล าดบัขั้น เพื่อตรวจสอบคุณภาพของแต่ละองคป์ระกอบของตน้แบบช้ินงาน 
ใหด้ าเนินไปอยา่งมีประสิทธิภาพ ส าหรับการผลิตส่ือและชุดการสอน  
  การทดสอบประสิทธิภาพ หมายถึง การน าส่ือหรือชุดการสอนไปทดสอบ 
ดว้ยกระบวนการ 2 ขั้นตอน คือ การทดสอบประสิทธิภาพใชเ้บ้ืองตน้ (Try out) และทดสอบ
ประสิทธิภาพสอนจริง (Trial run) เพื่อหาคุณภาพของส่ือ ตามขั้นตอนท่ีก าหนดใน 3 ประเด็น  
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คือ การท าใหผู้เ้รียนมีความรู้เพิ่มข้ึน การช่วยใหผู้เ้รียนผา่นกระบวนการเรียน และท าแบบประเมิน
สุดทา้ยไดดี้ และการท าใหผู้เ้รียนมีความพึงพอใจ น าผลท่ีไดม้าปรับปรุงแกไ้ขก่อนท่ีจะผลิตออกมา
เผยแพร่เป็นจ านวนมาก        
  การก าหนดเกณฑ์ประสิทธิภาพ  
 1. ความหมายของเกณฑ ์(Criterion) เกณฑเ์ป็นขีดก าหนดท่ีจะยอมรับวา่ ส่ิงใด หรือ
พฤติกรรมใดมีคุณภาพและ/ หรือปริมาณท่ีจะรับได ้การตั้งเกณฑ ์ตอ้งตั้งไวค้ร้ังแรก คร้ังเดียว  
เพื่อจะปรับปรุงคุณภาพใหถึ้งเกณฑข์ั้นต ่าท่ีตั้งไว ้จะตั้งเกณฑก์ารทดสอบประสิทธิภาพไวต่้างกนั
ไม่ได ้เช่น เม่ือมีการทดสอบประสิทธิภาพแบบเด่ียว ตั้งเกณฑไ์ว ้60/ 60 แบบกลุ่ม ตั้งไว ้70/ 70  
ส่วนแบบสนาม ตั้งไว ้80/ 80 ถือวา่ เป็นการตั้งเกณฑท่ี์ไม่ถูกตอ้ง อน่ึงเน่ือง จากเกณฑท่ี์ตั้งไว ้
เป็นเกณฑต์ ่าสุด ดงันั้น หากการทดสอบคุณภาพของส่ิงใดหรือพฤติกรรมใดไดผ้ลสูงกวา่เกณฑท่ี์ตั้ง
ไว ้อยา่งมีนยัส าคญัท่ีระดบั .05 หรืออนุโลมใหมี้ความคลาดเคล่ือนต ่าหรือสูงกวา่ค่าประสิทธิภาพ
ท่ีตั้งไวเ้กิน 2.5 ก็ใหป้รับเกณฑข้ึ์นไปอีกหน่ึงขั้น แต่หากไดค้่าต ่ากวา่ค่าประสิทธิภาพท่ีตั้งไว ้ตอ้ง
ปรับปรุงและน าไปทดสอบประสิทธิภาพใชห้ลายคร้ังในภาคสนาม จนไดค้่าถึงเกณฑท่ี์ก าหนด  
 2. ความหมายของเกณฑป์ระสิทธิภาพ หมายถึง ระดบัประสิทธิภาพของส่ือ 
หรือชุดการสอน ท่ีจะช่วยใหผู้เ้รียนเกิดการเปล่ียนแปลงพฤติกรรม เป็นระดบัท่ีผลิตส่ือหรือ 
ชุดการสอนจะพึงพอใจวา่ หากส่ือหรือชุดการสอนมีประสิทธิภาพถึงระดบันั้นแลว้ ส่ือหรือ 
ชุดการสอนนั้น ก็มีคุณค่าท่ีจะน าไปสอนนกัเรียนและคุม้แก่การลงทุนผลิตออกมาเป็นจ านวนมาก
การก าหนดเกณฑป์ระสิทธิภาพกระท าไดโ้ดยการประเมินผลพฤติกรรมของผูเ้รียน 2 ประเภทคือ   
 ประเภทท่ี 1 พฤติกรรมต่อเน่ือง (กระบวนการ) ก าหนดค่าประสิทธิภาพ 
เป็น E1 = Efficiency of process(ประสิทธิภาพของกระบวนการ) และพฤติกรรมสุดทา้ย (ผลลพัธ์) 
ก าหนดค่าประสิทธิภาพเป็น E2 = Efficiency of product (ประสิทธิภาพของผลลพัธ์) 
 ก. ประเมินพฤติกรรมต่อเน่ือง (Transitional behavior) คือ ประเมินผลต่อเน่ือง 
ซ่ึงประกอบดว้ยพฤติกรรมยอ่ยของผูเ้รียน เรียกวา่ “กระบวนการ” (Process) ท่ีเกิดจากการประกอบ
กิจกรรมกลุ่ม ไดแ้ก่ การท าโครงการ หรือท ารายงานเป็นกลุ่ม และรายงานบุคคล ไดแ้ก่ 
งานท่ีมอบหมายและกิจกรรมอ่ืนใดท่ีผูส้อนก าหนดไว ้
 ข. ประเมินพฤติกรรมสุดทา้ย (Terminal behavior) คือประเมินผลลพัธ์ (Product) 
ของผูเ้รียน โดยพิจารณาจากการสอบหลงัเรียนและการสอบไล่ ประสิทธิภาพของส่ือหรือ 
ชุดการสอนจะก าหนดเป็นเกณฑท่ี์ผูส้อนคาดหมายวา่ ผูเ้รียนจะเปล่ียนพฤติกรรมเป็นท่ีพึงพอใจ 
โดยก าหนดให้ผลเฉล่ียของคะแนนการท างานและการประกอบกิจกรรมของผูเ้รียนทั้งหมด 
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ต่อร้อยละของผลการประเมินหลงัเรียนทั้งหมด นัน่คือ E1/ E2 = ประสิทธิภาพของกระบวนการ/
ประสิทธิภาพของผลลพัธ์ ตวัอยา่ง 80/ 80 หมายความ วา่เม่ือเรียนจากส่ือหรือชุดการสอนแลว้ 
ผูเ้รียนจะสามารถท าแบบฝึกปฏิบติั หรืองานไดผ้ลเฉล่ีย 80% และประเมินหลงัเรียนและงานสุดทา้ย
ไดผ้ลเฉล่ีย 80% การท่ีจะก าหนดเกณฑ ์E1/ E2 ใหมี้ค่าเท่าใดนั้น ใหผู้ส้อนเป็นผูพ้ิจารณา 
ตามความพอใจ โดยพิจารณาพิสัยการเรียนท่ีจ าแนกเป็นวิทยพิสัย(Cognitive domain) จิตพิสัย 
(Affective domain) และทกัษพิสัย (Skill domain) ในขอบข่ายวทิยพิสัย (เดิมเรียกวา่ พุทธิพิสัย) 
เน้ือหาท่ีเป็นความรู้ความจ ามกัจะตั้งไวสู้งสุดแลว้ลดต ่าลงมาคือ 90/ 90, 85/ 85 และ 80/ 80 ส่วน
เน้ือหาสาระท่ีเป็นจิตพิสัย จะตอ้งใชเ้วลาไปฝึกฝนและพฒันา ไม่สามารถท าใหถึ้งเกณฑร์ะดบัสูงได ้
ในหอ้งเรียนหรือในขณะท่ีเรียน จึงอนุโลมใหต้ั้งไวต้  ่าลง นัน่คือ 80/ 80 และ 75/ 75 แต่ไม่ต ่ากวา่ 
75/ 75 เพราะเป็นระดบัความพอใจต ่าสุด จึงไม่ควรตั้งเกณฑไ์วต้  ่ากวา่น้ี หากตั้งเกณฑไ์วเ้ท่าใด  
ก็มกัไดผ้ลเท่านั้น ดงัจะเห็นไดจ้ากระบบการสอนของไทยปัจจุบนั (2520) ไดก้ าหนดเกณฑ ์ 
โดยไม่เขียนเป็นลายลกัษณ์อกัษรไว ้0/ 50 นัน่คือ ใหป้ระสิทธิภาพกระบวนการมีค่า 0 เพราะครู 
มกัไม่มีเกณฑเ์วลาในการให้งานหรือแบบฝึกปฏิบติัแก่นกัเรียน ส่วนคะแนนผลลพัธ์ท่ีใหผ้า่นคือ 
50% ผลจึงปรากฏวา่ คะแนนวชิาต่าง ๆ ของนกัเรียนต ่าในทุกวชิา เช่น คะแนนภาษาไทยนกัเรียน
ชั้นประถมศึกษาปีท่ี 4 โดยเฉล่ียแต่ละปีเพียง 51% เท่านั้น  
 วธีิการค านวณหาประสิทธิภาพ 

 วธีิการค านวณหาประสิทธิภาพ กระท าได ้2 วธีิ คือ โดยใชสู้ตรและโดยการค านวณ
ธรรมดา 
 1. การใชสู้ตร ด าเนินการดงัน้ี 
 สูตรท่ี 1  
                 E1 =    ∑ 𝑥 
 
 

 เม่ือ E1  คือ ประสิทธิภาพของกระบวนการ 
       ∑ 𝑥 คือ คะแนนรวมของแบบฝึกปฏิบติักิจกรรมหรืองานท่ีท าระหวา่งเรียน 
         ทั้งท่ีเป็นกิจกรรมในห้องเรียน นอกหอ้งเรียนหรือออนไลน์ 
           A  คือ คะแนนเตม็ของแบบฝึกปฏิบติัทุกช้ินรวมกนั 
                          N  คือ จ านวนผูเ้รียน 
 สูตรท่ี 2  
                 E2 =  ∑ 𝑓 

 

×100 N 
   100 

×100 B 
   100 
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 เม่ือ E2  คือ ประสิทธิภาพของผลลพัธ์ 
       ∑ 𝑓 คือ คะแนนรวมของผลลพัธ์ของการประเมินหลงัเรียน            
         B  คือ คะแนนเตม็ของการประเมินสุดทา้ยของแต่ละหน่วย ประกอบดว้ย 
         ผลการสอบหลงัเรียนและคะแนนจากการประเมินงานสุดทา้ย 
                         N  คือ จ านวนผูเ้รียน 
  การค านวณหาประสิทธิภาพโดยใชสู้ตรดงักล่าวขา้งตน้ กระท าไดโ้ดยการน าคะแนน
รวมแบบฝึกปฏิบติัหรือผลงาน ในขณะประกอบกิจกรรมกลุ่ม/ เด่ียว และคะแนนสอบหลงัเรียน  
มาเขา้ตาราง แลว้จึงค านวณหาค่า E1/ E2  
  2. โดยใชว้ธีิการค านวณโดยไม่ใชสู้ตร 
 หากจ าสูตรไม่ไดห้รือไม่อยากใชสู้ต ผูผ้ลิตส่ือหรือชุดการสอนก็สามารถใช ้
วธีิการค านวณธรรมดา หาค่า E1/ E2 ดว้ยวธีิการค านวณธรรมดา ส าหรับ E1 คือ ค่าประสิทธิภาพ
ของงานและแบบฝึกปฏิบติั กระท าไดโ้ดยการน าคะแนนงานทุกช้ินของนกัเรียนในแต่ละกิจกรรม 
แต่ละคนมารวมกนั แลว้หาค่าเฉล่ียและเทียบส่วนโดยเป็นร้อยละ ส าหรับค่า E2 คือประสิทธิภาพ
ผลลพัธ์ของการประเมินหลงัเรียนของแต่ละส่ือหรือชุดการสอน กระท าไดโ้ดยการเอาคะแนน 
จากการสอบหลงัเรียนและคะแนนจากงานสุดทา้ยของนกัเรียนทั้งหมดรวมกนั หาค่าเฉล่ียแลว้ 
เทียบส่วนร้อย เพื่อหาค่าร้อยละ 
 3. การตีความหมายผลการค านวณ 
 หลงัจากค านวณหาค่า E1/ E2 ไดแ้ลว้ ผูห้าประสิทธิภาพตอ้งตีความหมายของผลลพัธ์ 
โดยยดึหลกัการและแนวทางดงัน้ี 
 หลกัการท่ี 1 ความคลาดเคล่ือนของผลลพัธ์ ใหมี้ความคลาดเคล่ือนหรือความแปรปรวน
ของผลลพัธ์ไดไ้ม่เกิน .05 (ร้อยละ 5) จากช่วงต ่าไปสูง เท่ากบั ±2.5 ใหผ้ลลพัธ์ของค่า E1/ E2  
ท่ีถือวา่ เป็นไปตามเกณฑ ์มีค่าต ่ากวา่เกณฑ ์ไม่เกิน 2.5% และสูงกวา่เกณฑท่ี์ตั้งไว ้ไม่เกิน 2.5%
หากคะแนน E1/ E2 ห่างกนัเกิน 5% แสดงวา่ กิจกรรมท่ีใหน้กัเรียนท ากบัการสอบหลงัเรียน 
ไม่สมดุลกนัเช่น ค่า E1 มากกวา่ E2 แสดงวา่ งานท่ีมอบหมายอาจจะง่ายกวา่การสอบ หรือ 
หากค่า E2 มากกวา่ค่า E1 แสดงวา่ การสอบง่ายกวา่หรือไม่สมดุลกบังานท่ีมอบหมายใหท้ า จ  าเป็น
ท่ีจะตอ้งปรับแก ้หากส่ือหรือชุดการสอนไดรั้บการออกแบบและพฒันาอยา่งดีมีคุณภาพ ค่า E1 
หรือ E2 ท่ีค  านวณไดจ้ากการทดสอบประสิทธิภาพ จะตอ้งใกลเ้คียงกนัและห่างกนัไม่เกิน 5%  
ซ่ึงเป็นตวัช้ีท่ีจะยนืยนัไดว้า่นกัเรียนไดมี้การเปล่ียนพฤติกรรมต่อเน่ืองตามล าดบัขั้นหรือไม่ 
ก่อนท่ีจะมีการเปล่ียนพฤติกรรมขั้นสุดทา้ย หรืออีกนยัหน่ึงตอ้งประกนัไดว้า่นกัเรียนมีความรู้จริง
ไม่ใช่ท ากิจกรรมหรือท าสอบได ้เพราะการเดาการประเมินในอนาคต จะเสนอผลการประเมิน 
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เป็นเลขสองตวั คือ E1 คู่ E2 เพราะจะท าใหผู้อ่้านผลการประเมินทราบลกัษณะนิสัยของผูเ้รียน
ระหวา่งนิสัยในการท างานอยา่งต่อเน่ือง คงเส้นคงวาหรือไม่ (ดูจากค่า E1 คือกระบวนการ) 
กบัการท างานสุดทา้ยวา่มีคุณภาพมากนอ้ยเพียงใด (ดูจากค่า E2 คือ กระบวนการ) เพื่อประโยชน์
ของการกลัน่กรองบุคลากรเขา้ท างาน 
   ขั้นตอนการทดสอบประสิทธิภาพ  
 เม่ือผลิตส่ือหรือชุดการสอนข้ึน เป็นตน้แบบแลว้ ตอ้งน าส่ือหรือชุดการสอน 
ไปหาประสิทธิภาพ ตามขั้นตอนต่อไปน้ี  
 1. การทดสอบประสิทธิภาพแบบเด่ียว (1: 1) เป็นการทดสอบประสิทธิภาพท่ีผูส้อน 1 
คนทดสอบประสิทธิภาพส่ือหรือชุดการสอนกบัผูเ้รียน 1-3 คน โดยใชเ้ด็กอ่อน ปานกลาง และเด็ก
เก่งระหวา่งทดสอบประสิทธิภาพใหจ้บัเวลาในการประกอบกิจกรรม สังเกตพฤติกรรมของผูเ้รียน
วา่ หงุดหงิด ท าหนา้ฉงน หรือท าท่าทางไม่เขา้ใจหรือไม่ ประเมินการเรียนจากกระบวนการ  
คือ กิจกรรมหรือภารกิจและงานท่ีมอบใหท้ า และทดสอบหลงัเรียน น าคะแนนมาค านวณ 
หาประสิทธิภาพ หากไม่ถึงเกณฑต์อ้งปรับปรุงเน้ือหาสาระ กิจกรรมระหวา่งเรียนและแบบทดสอบ
หลงัเรียนใหดี้ข้ึน โดยปกติ คะแนนท่ีไดจ้ากการทดสอบประสิทธิภาพแบบเด่ียวน้ี จะไดค้ะแนน 
ต ่าวา่เกณฑม์าก แต่ไม่ตอ้งวิตกเม่ือปรับปรุงแลว้จะสูงข้ึนมาก ก่อนน าไปทดสอบประสิทธิภาพ 
แบบกลุ่ม ทั้งน้ี E1/ E2 ท่ีไดจ้ะมีค่าประมาณ 60/ 60 
 2. การทดสอบประสิทธิภาพแบบกลุ่ม (1: 10) เป็นการทดสอบประสิทธิภาพท่ีผูส้อน  
1 คน ทดสอบประสิทธิภาพส่ือหรือชุดการสอนกบัผูเ้รียน 6-10 คน คละผูเ้รียนท่ีเก่ง ปานกลาง 
กบัอ่อน ระหวา่งทดสอบประสิทธิภาพใหจ้บัเวลาในการประกอบกิจกรรม สังเกตพฤติกรรม 
ของผูเ้รียนวา่ หงุดหงิด ท าหนา้ฉงน หรือท าท่าทางไม่เขา้ใจหรือไม่ หลงัจากทดสอบประสิทธิภาพ
ใหป้ระเมินการเรียนจากกระบวนการ คือ กิจกรรมหรือภารกิจและงานท่ีมอบใหท้ า และประเมิน
ผลลพัธ์ คือ การทดสอบหลงัเรียนและงานสุดทา้ยท่ีมอบใหน้กัเรียนท าส่ง ก่อนสอบประจ าหน่วย  
ใหน้ าคะแนนมาค านวณหาประสิทธิภาพ หากไม่ถึงเกณฑต์อ้งปรับปรุงเน้ือหาสาระกิจกรรม
ระหวา่งเรียนและแบบทดสอบหลงัเรียนใหดี้ข้ึน ค านวณหาประสิทธิภาพแลว้ปรับปรุง ในคราวน้ี
คะแนนของผูเ้รียนจะเพิ่มข้ึนอีกเกือบเท่าเกณฑ์ โดยเฉล่ียจะห่างจากเกณฑป์ระมาณ 10% คือ E1/ E2 
ท่ีไดจ้ะมีค่าประมาณ 70/ 70 
 3. การทดสอบประสิทธิภาพภาคสนาม (1: 100) เป็นการทดสอบประสิทธิภาพท่ีผูส้อน  
1 คน ทดสอบประสิทธิภาพส่ือหรือชุดการสอนกบัผูเ้รียนทั้งชั้น ระหวา่งทดสอบประสิทธิภาพ 
ใหจ้บัเวลาในการประกอบกิจกรรม สังเกตพฤติกรรมของผูเ้รียนวา่ หงุดหงิด ท าหนา้ฉงน  
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หรือท าท่าทางไม่เขา้ใจหรือไม่ หลงัจากทดสอบประสิทธิภาพภาคสนามแลว้ ใหป้ระเมินการเรียน
จากกระบวนการ คือ กิจกรรมหรือภารกิจและงานท่ีมอบใหท้ าและทดสอบหลงัเรียน น าคะแนน 
มาค านวณหาประสิทธิภาพ หากไม่ถึงเกณฑต์อ้งปรับปรุงเน้ือหาสาระ กิจกรรมระหวา่งเรียน 
และแบบทดสอบหลงัเรียนใหดี้ข้ึน แลว้น าไปทดสอบประสิทธิภาพภาคสนามซ ้ ากบันกัเรียน 
ต่างกลุ่ม อาจทดสอบประสิทธิภาพ 2-3 คร้ัง จนไดค้่าประสิทธิภาพถึงเกณฑข์ั้นต ่า ปกติไม่น่าจะ
ทดสอบประสิทธิภาพเกินสามคร้ัง ดว้ยเหตุน้ี ขั้นทดสอบประสิทธิภาพภาคสนามจึงแทนดว้ย  
1: 100 ผลลพัธ์ท่ีไดจ้ากการทดสอบประสิทธิภาพภาคสนามควรใกลเ้คียงกบัเกณฑท่ี์ตั้งไว ้หากต ่า 
จากเกณฑไ์ม่เกิน 2.5% ก็ใหย้อมรับวา่ ส่ือหรือชุดการสอนมีประสิทธิภาพตามเกณฑท่ี์ตั้งไว ้
หากค่าท่ีไดต้  ่ากวา่เกณฑม์ากกวา่ -2.5 ใหป้รับปรุงและทดสอบประสิทธิภาพภาคสนามซ ้ า 
จนกวา่จะถึงเกณฑ ์จะหยดุปรับปรุงแลว้สรุปวา่ชุดการสอนไม่มีประสิทธิภาพตามเกณฑท่ี์ตั้งไว้
หรือจะลดเกณฑล์งเพราะ “ถอดใจ” หรือยอมแพไ้ม่ไดห้ากสูงกวา่เกณฑไ์ม่เกิน +2.5 ก็ยอมรับวา่ 
ส่ือหรือชุดการสอนมีประสิทธิภาพตามเกณฑท่ี์ตั้งไว ้หากค่าท่ีไดสู้งกวา่เกณฑเ์กิน +2.5 ใหป้รับ
เกณฑข้ึ์นไปอีกหน่ึงขั้น เช่น ตั้งไว ้80/ 80 ก็ใหป้รับข้ึนเป็น 85/85 หรือ 90/90 ตามค่าประสิทธิภาพ 
ท่ีทดสอบประสิทธิภาพได ้
 การหาค่าดัชนีประสิทธิผลของบทเรียน 
 เผชิญ กิจระการ (2546) กล่าวไวว้า่ การหาค่าดชันีประสิทธิผล (Effectiveness index: 
E.I.) ของส่ือการเรียนการสอนหรือนวตักรรมท่ีศึกษาคน้ควา้ไดพ้ฒันาข้ึน รวมถึงแผนการเรียนรู้ 
วา่สามารถพิจารณาไดโ้ดยการดูจากการพฒันาของผูเ้รียน กล่าวคือ การพิจารณาวา่ ก่อนและหลงั
เรียนรู้เร่ืองใด ผูเ้รียนไดพ้ฒันาการหรือมีความรู้ความสามารถเพิ่มข้ึนอยา่งเช่ือถือไดห้รือไม่   
หรือเพิ่มข้ึนเท่าใด โดยพิจารณาจากส่ิงต่อไปน้ี 
 1. การพฒันาการท่ีเพิ่มข้ึนของผูเ้รียน โดยอาศยัการหาค่า t-test (Dependent samples) 
เป็นการพิจารณาดูวาผูเ้รียนมีพฒันาการเพิ่มข้ึนอยา่งน่าเช่ือถือไดห้รือไม่ โดยท าการทดสอบผูเ้รียน
ทุกคนก่อนเรียน (Pretest) และหลงัเรียน (Posttest) แลว้น าค่ามาหา T-test หากมีนยัส าคญัทางสถิติ 
ก็ถือไดว้าผูเ้รียนกลุ่มดงักล่าวมีพฒันาการเพิ่มข้ึนอยา่ง เช่ือถือได ้
  2. การหาพฒันาการท่ีเพิ่มข้ึนของผูเ้รียน โดยอาศยัการหาดชันีประสิทธิผล มีวธีิการหา
โดยใชสู้ตร ดงัน้ี 
 E.I. = คะแนนรวมของคะแนนหลงัเรียนทุกคน-ผลรวมของคะแนนก่อนเรียนทุกคน                                          
                                     จ  านวนนกัเรียนxคะแนนเตม็-ผลรวมของคะแนนก่อนเรียนทุกคน 
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      ดชันีประสิทธิผล = 

E.I. =   

 การหาค่า E.I. เป็นการพิจารณาพฒันาการในลกัษณะท่ีวา่เพิ่มข้ึนเท่าไร ไม่ไดท้ดสอบวา่
เพิ่มข้ึนอยา่งน่าเช่ือถือไดห้รือไม่ นิยมเขียนในรูปของร้อยละ เน่ืองจากส่ือความหมายไดง่้ายข้ึน เช่น 
ค่า E.I. ท่ีไดจ้ากการค านวณเป็น  0.67 หรือคิดเป็นร้อยละ 67 
  บุญชม ศรีสะอาด (2545) ไดเ้สนอวธีิการค านวณหาค่าดชันีประสิทธิผลไว ้ดงัน้ี 
 1. การหาพฒันาการของผูเ้รียนโดยอาศยัการหาค่า T-test เป็นการพิจารณาดูวา่นกัเรียนมี
พฒันาการเพิ่มข้ึนอยา่งเช่ือถือไดห้รือไม่ โดยการทดสอบนกัเรียนทุกคนก่อนเรียนและหลงัเรียน  
แลว้น ามาหาค่า T-test หากมีนยัส าคญัทางสถิติ ก็ถือวา่นกัเรียนกลุ่มท่ีผูศึ้กษาคน้ควา้  
มีพฒันาการเพิ่มข้ึนอยา่งเช่ือถือได ้
 2. พฒันาการท่ีเพิ่มข้ึนของผูเ้รียน โดยอาศยัการหาค่าดชันีประสิทธิผลมีสูตร ดงัน้ี 
                     ผลรวมของคะแนนทดสอบหลงัเรียน-ผลรวมของคะแนนทดสอบก่อนเรียน 
                (จ  านวนผูน้กัเรียนxคะแนนเตม็)-ผลรวมของคะแนนทดสอบก่อนเรียน 
หรือ                 P1-P2  
                       Total-P  
               เม่ือ E.I.   แทน ดชันีประสิทธิผล 
       P1   แทน ผลรวมของคะแนนทดสอบก่อนเรียน 
       P2   แทน ผลรวมของคะแนนทดสอบหลงัเรียน 
  Total    แทน ผลคูณของจ านวนผูเ้รียนกบัคะแนนเตม็ 
 จากการศึกษาสรุปไดว้า่ ดชันีประสิทธิผล หมายถึง ค่าแสดงความกาวหนา้ทางการเรียนรู้
ของนกัเรียนท่ีเรียนโดยใชบ้ทเรียนออนไลน์แบบผสมผสาน 
 

การสร้างแบบทดสอบวดัผลสัมฤทธ์ิทางการเรียน 
 พิชิต ฤทธ์ิจรูญ (2545) กล่าววา่ แบบทดสอบวดัผลสัมฤทธ์ิทางการเรียน หมายถึง
แบบทดสอบท่ีใชว้ดัความรู้ ทกัษะ และความสามารถทางวชิาการท่ีนกัเรียนไดเ้รียนรู้มาแลว้วา่
บรรลุผลส าเร็จตามจุดประสงคท่ี์ก าหนดไวเ้พียงใด 
          สิริพร ทิพยค์ง (2545) กล่าววา่ แบบทดสอบวดัผลสัมฤทธ์ิทางการเรียน หมายถึง 
ชุดค าถามท่ีมุ่งวดัพฤติกรรมการเรียนของนกัเรียนวา่มีความรู้ ทกัษะ และสมรรถภาพดา้นสมอง 
ดา้นต่าง ๆ ในเร่ืองท่ีเรียนรู้ไปแลว้มากนอ้ยเพียงใด 
           สมพร เช้ือพนัธ์ (2547) กล่าววา่ แบบทดสอบวดัผลสัมฤทธ์ิทางการเรียน หมายถึง
แบบทดสอบหรือชุดของขอ้สอบท่ีใชว้ดัความส าเร็จ หรือความสามารถในการท ากิจกรรม 
การเรียนรู้ของนกัเรียน ท่ีเป็นผลมาจากการจดักิจกรรมการเรียนการสอนของครูผูส้อน 
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วา่ผา่นจุดประสงคก์ารเรียนรู้ท่ีตั้งไวเ้พียงใด 
           แบบทดสอบวดัผลสัมฤทธ์ิทางการเรียน มีหลายแบบ แต่ท่ีนิยมใชมี้ 6 แบบ ดงัน้ี 
 1. ขอ้สอบอตันยัหรือความเรียง (Subjective or essay test) เป็นขอ้สอบท่ีมีเฉพาะค าถาม 
แลว้ใหน้กัเรียนเขียนตอบอยา่งเสรี เขียนบรรยายตามความรู้และเขียนขอ้คิดเห็นของแต่ละคน 
  2. ขอ้สอบแบบกาถูก-ผดิ (True-false test) คือ ขอ้สอบแบบเลือกตอบท่ีมี 2 ตวัเลือก 
แต่ตวัเลือกดงักล่าวเป็นแบบคงท่ีและมีความหมายตรงกนัขา้ม เช่น ถูก-ผดิ ใช่-ไม่ใช่ จริง-ไม่จริง 
เหมือนกนั-ต่างกนั เป็นตน้ 
 3. ขอ้สอบแบบเติมค า (Completion test) เป็นขอ้สอบท่ีประกอบดว้ยประโยค หรือ
ขอ้ความท่ียงัไม่สมบูรณ์แลว้ใหต้อบเติมค าหรือประโยค หรือขอ้ความลงในช่องวา่งท่ีเวน้ไวน้ั้น
เพื่อใหมี้ใจความสมบูรณ์และถูกตอ้ง 
 4. ขอ้สอบแบบตอบสั้น ๆ (Short answer test) เป็นขอ้สอบท่ีคลา้ยกบัขอ้สอบแบบเติมค า 
แต่แตกต่างกนัท่ีขอ้สอบแบบตอบสั้น ๆ เขียนเป็นประโยคค าถามสมบูรณ์ (ขอ้สอบเติมค า 
เป็นประโยคหรือขอ้ความท่ียงัไม่สมบูรณ์) แลว้ใหผู้ต้อบเขียนตอบ ค าตอบท่ีตอ้งการจะสั้น 
และกะทดัรัด ไดใ้จความสมบูรณ์ ไม่ใช่เป็นการบรรยายแบบขอ้สอบอตันยัหรือความเรียง 
 5. ขอ้สอบแบบจบัคู่ (Matching test) เป็นขอ้สอบแบบเลือกตอบชนิดหน่ึงโดยมีค่า 
หรือขอ้ความแยกออกจากกนัเป็น 2 ชุด แลว้ใหผู้ต้อบเลือกจบัคู่วา่แต่ละขอ้ความในชุดหน่ึงจะคู่ 
กบัค าหรือขอ้ความใดในอีกชุดหน่ึง ซ่ึงมีความสัมพนัธ์กนัอยา่งใดอยา่งหน่ึง ตามท่ีผูอ้อกขอ้สอบ
ก าหนดไว ้
 6. ขอ้สอบแบบเลือกตอบ (Multiple choice test) ค  าถามแบบเลือกตอบโดยทัว่ไป 
จะประกอบดว้ย 2 ตอน คือ ตอนน าหรือค าถาม (Stem) กบัตอนเลือก (Choice) ในตอนเลือกนั้น 
จะประกอบดว้ย ตวัเลือกท่ีเป็นค าตอบถูกและตวัเลือกลวง ปกติจะมีค าถามท่ีก าหนดให้พิจารณา 
แลว้หาตวัเลือกท่ีถูกตอ้งมากท่ีสุดเพียงตวัเลือกเดียวจากตวัเลือกอ่ืน ๆ และค าถามแบบเลือกตอบท่ีดี
นิยมใชต้วัเลือกท่ีใกลเ้คียงกนั 
             ดงันั้น ในการสร้างแบบทดสอบวดัผลสัมฤทธ์ิทางการเรียน จึงเป็นวธีิการวดัประเมินผล
การเรียนรู้วทิยาศาสตร์ ซ่ึงมีการสร้างแบบทดสอบหลากหลาย ไดแ้ก่ ขอ้สอบอตันยัหรือความเรียง
ขอ้สอบแบบกาถูกกาผดิ ขอ้สอบแบบเติมค า ขอ้สอบแบบตอบสั้น ๆ ขอ้สอบแบบจบัคู่ และขอ้สอบ
แบบเลือกตอบ ในการวิจยัคร้ังน้ี ผูว้จิยัสร้างแบบทดสอบวดัผลสัมฤทธ์ิทางการเรียนแบบเลือกตอบ
เน่ืองจากเป็นแบบทดสอบท่ีสามารถวดัพฤติกรรมทั้ง 6 ดา้นไดแ้ก่ ดา้นความรู้ ดา้นความเขา้ใจ  
ดา้นการน าไปใช ้ดา้นการวิเคราะห์ ดา้นการสังเคราะห์และดา้นการประเมินค่า 
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ความพงึพอใจ 
 ทวพีงษ ์หินคา (2541) ไดใ้หค้วามหมายของความพึงพอใจวา่ เป็นความชอบของบุคคล 
ท่ีมีต่อส่ิงหน่ึงส่ิงใด ซ่ึงสามารถลดความดึงเครียดและตอบสนองความตอ้งการของบุคคลได ้
ท าใหเ้กิดความพึงพอใจต่อส่ิงนั้น 
  ธนียา ปัญญาแกว้ (2541) ไดใ้หค้วามหมายวา่ ส่ิงท่ีท าใหเ้กิดความพึงพอใจท่ีเก่ียวกบั
ลกัษณะของงานปัจจยัเหล่านั้น ไปสู่ความพอใจในงานท่ีท า ไดแ้ก่ ความส าเร็จ การยกยอ่ง  
ลกัษณะงาน ความรับผดิชอบ และความกา้วหนา้ เม่ือปัจจยัเหล่าน้ีอยูต่  ่ากวา่ จะท าใหเ้กิด 
ความไม่พอใจงานท่ีท า ถา้หากงานใหค้วามกา้วหนา้ ความทา้ทา้ย ความรับผดิชอบ ความส าเร็จ 
และการยกยอ่งแก่ผูป้ฏิบติังานแลว้ พวกเขาจะพอใจและมีแรงจูงใจในการท างานเป็นอยา่งมาก 
  วทิย ์เท่ียงบูรณธรรม (2541) ใหค้วามหมายของความพึงพอใจวา่ หมายถึง ความพอใจ
การท าใหพ้อใจ ความสาแก่ใจ ความหน าใจ ความจุใจ ความแน่ใจ การชดเชย การไถ่บาป  
การแกแ้คน้ส่ิงท่ีชดเชย 
 วรุิฬ พรรณเทว ี(2542) ใหค้วามหมายไวว้า่ ความพึงพอใจเป็นความรู้สึกภายในจิตใจ 
ของมนุษยท่ี์ไม่เหมือนกนั ซ่ึงเป็นอยูก่บัแต่ละบุคคลวา่จะคาดหมายกบัส่ิงหน่ึง ส่ิงใด อยา่งไร  
ถา้คาดหวงัหรือมีความตั้งใจมากและไดรั้บการตอบสนองดว้ยดี จะมีความพึงพอใจมาก 
แต่ในทางตรงกนัขา้มอาจผดิหวงัหรือไม่พึงพอใจเป็นอยา่งยิง่ เม่ือไม่ไดรั้บการตอบสนอง 
ตามท่ีคาดหวงัไว ้ทั้งน้ีข้ึนอยูก่บัส่ิงท่ีตนตั้งใจไวว้า่จะมีมากหรือนอ้ย 
 กาญจนา อรุณสุขรุจี (2546) กล่าววา่ ความพึงพอใจของมนุษย ์เป็นการแสดงออก 
ทางพฤติกรรมท่ีเป็นนามธรรม ไม่สามารถมองเห็นเป็นรูปร่างได ้การท่ีเราจะทราบวา่บุคคล 
มีความพึงพอใจหรือไม่ สามารถสังเกตโดยการแสดงออกท่ีค่อนขา้งสลบัซบัซอ้น และตอ้งมี 
ส่ิงท่ีตรงต่อความตอ้งการของบุคคล จึงจะท าใหบุ้คคลเกิดความพึงพอใจ ดงันั้น การสร้างส่ิงเร้า 
จึงเป็นแรงจูงใจของบุคคลนั้นใหเ้กิดความพึงพอใจในงานนั้น 
  สรุปไดว้า่ ความพึงพอใจ หมายถึง ความรู้สึกท่ีดีหรืทศันคติท่ีดีของบุคคลท่ีมีอยูภ่ายใน
จิตใจของมนุษย ์ซ่ึงมกัเกิดจากการไดรั้บการตอบสนองตามท่ีตนตอ้งการ ก็จะเกิดความรู้สึกท่ีดี 
ต่อส่ิงนั้น ตรงกนัขา้มหากความตอ้งการของตนไม่ไดรั้บการตอบสนอง ความไม่พึงพอใจ 
ก็จะเกิดข้ึน 
 ทฤษฏีทีเ่กีย่วกบัความพงึพอใจ 
 ความพึงพอใจ เป็นความรู้สึกท่ีดี ท่ีชอบ ท่ีพอใจ หรือท่ีประทบัใจของบุคคล 
ต่อส่ิงใดส่ิงหน่ึงท่ีไดรั้บ โดยส่ิงนั้นสามารถตอบสนองความตอ้งการทั้งดา้นร่างกายและจิตใจ 
บุคคลทุกคนมีความตอ้งการหลายส่ิงหลายอยา่ง และมีความตอ้งการหลายระดบั ซ่ึงหากไดรั้บ 
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การตอบสนองก็จะก่อให้เกิดความพึงพอใจ การจดัการเรียนรู้ใด ๆ ท่ีจะท าใหผู้เ้รียน 
เกิดความพึงพอใจ การเรียนรู้นั้นจะตอ้งสนองความตอ้งการของผูเ้รียน ทฤษฏีเก่ียวกบัความตอ้งการ
ท่ีส่งผลต่อความพึงพอใจท่ีส าคญั คือ ทฤษฏีล าดบัชั้นของความตอ้งการ Maslow (Needs-hierarchy 
theory) เป็นทฤษฎีหน่ึงท่ีไดรั้บการยอมรับอยา่งกวา้งขวาง โดยตั้งอยูบ่นสมมติฐานเก่ียวกบั
พฤติกรรมของมนุษย ์ดงัน้ี 
 1. ลกัษณะความตอ้งการของมนุษย ์ไดแ้ก่ 
 1.1 ความตอ้งการของมนุษย ์เป็นไปตามล าดบัชั้นความส าคญั โดยเร่ิมระดบั 
ความตอ้งการขั้นสูงสุด 
 1.2 มนุษยมี์ความตอ้งการอยูเ่สมอ เม่ือความตอ้งการอยา่งหน่ึงไดรั้บการตอบสนอง 
 ก็มีความตอ้งการส่ิงใหม่เขา้มาแทนท่ี 
 1.3 เม่ือความตอ้งการในระดบัหน่ึงไดรั้บการตอบสนองแลว้ จะไม่จูงใหเ้กิด
พฤติกรรมต่อส่ิงนั้น แต่จะมีความตอ้งการในระดบัสูงเขา้มาแทน และเป็นแรงจูงใจให้เกิด
พฤติกรรมนั้น 
 1.4 ความตอ้งการท่ีเกิดข้ึนอาศยัซ่ึงกนัและกนั มีลกัษณะควบคู่ คือ เม่ือความตอ้งการ
อยา่งหน่ึงยงัไม่หมดส้ินไป ก็จะมีความตอ้งการอีกอยา่งหน่ึงเกิดข้ึนมา 
 2. ล าดบัขั้นความตอ้งการของมนุษย ์มี 5 ระดบั ไดแ้ก่ 
 2.1 ความตอ้งการพื้นฐานทางดา้นร่างกาย (Physiological needs) เป็นความตอ้งการ
เบ้ืองตน้ เพื่อความอยูร่อดของชีวติ เช่น ความตอ้งการ อาหาร น ้า อากาศ เคร่ืองนุ่งห่ม ยารักษาโรค 
ท่ีอยูอ่าศยั และความตอ้งการทางเพศ ความตอ้งการทางดา้นร่างกายจะมีอิทธิพลต่อพฤติกรรม 
ของคน ก็ต่อเม่ือความตอ้งการทั้งหมดของคนยงัไม่ไดรั้บการตอบสนอง 
  2.2 ความตอ้งการความมัน่คง ปลอดภยั (Security needs) เป็นความรู้สึกท่ีตอ้งการ 
ความมัน่คงปลอดภยัในปัจจุบนัและอนาคต ซ่ึงรวมถึงความกา้วหนา้และความอบอุ่นใจ 
 2.3 ความตอ้งการทางสังคม (Social or belonging needs) ไดแ้ก่ ความตอ้งการ 
ท่ีจะเขา้ร่วมและไดรั้บการยอมรับในสังคม ความเป็นมิตรและความรักจากเพื่อน 
 2.4 ความตอ้งการท่ีจะไดรั้บการยกยอ่งหรือมีช่ือเสียง (Esteem needs)  
เป็นความตอ้งการระดบัสูง ไดแ้ก่ ความตอ้งการอยากเด่นในสังคม รวมถึงความส าเร็จ ความรู้
ความสามารถ ความเป็นอิสรภาพและเสรี และการเป็นท่ียอมรับนบัถือของคนทั้งหลาย 
 2.5 ความตอ้งการท่ีจะไดรั้บความส าเร็จในชีวติ (Self-actualization needs)  
เป็นความตอ้งการระดบัสูงของมนุษย ์ส่วนมากจะเป็นการนึกอยากจะเป็น อยากจะได ้ 
ตามความคิดเห็นของตวัเอง แต่ไม่สามารถแสวงหาได ้(Maslow, 1970) 
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 สรุปไดว้า่ การวิจยัในคร้ังน้ี ไดน้ าความพึงพอใจมาใชใ้นการตรวจสอบความพึงพอใจ 

ของผูใ้ช ้จากการท่ีประเมินความพึงพอใจต่อการเรียนดว้ยบทเรียนออนไลน์แบบผสมผสาน       
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรมอยา่งง่าย และความสามารถน ามาใชใ้หเ้กิดประโยชน์ในการออกแบบบทเรียน 

ใหต้รงตามความตอ้งการของนกัเรียนและครูผูส้อน เพื่อท าใหส้ามารถเกิดการเรียนรู้ไดดี้ข้ึน  
ใชใ้นการออกแบบการเรียนการสอนและในบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้ 

การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรมอยา่งง่าย 

 

งานวจิัยทีเ่กีย่วข้อง 
 งานวจิยัท่ีเก่ียวขอ้งกบัการสร้างบทเรียนออนไลน์แบบผสมผสาน มีรายละเอียด ดงัน้ี  
 ศุภลกัษณ์ ปริสุทโกศล (2557) ไดท้  าการศึกษาผลการเรียนดว้ยโปรแกรมบทเรียน 
แบบผสมผสาน เร่ือง การใชอิ้นเทอร์เน็ต ท่ีมีต่อผลสัมฤทธ์ิทางการเรียน การคิดวจิารณญาณ  
และความคงทนในการเรียนรู้ของนกัเรียนชั้นประถมศึกษาปีท่ี 4 ท่ีมีการน าตนเองในการเรียนรู้
ต่างกนั ผลการวจิยั พบวา่ โปรแกรมบทเรียนแบบผสมผสานมีประสิทธิภาพเท่ากบั 84.06/ 83.83 
และมีดชันีประสิทธิผลเท่ากบั 0.7043 นกัเรียนโดยรวมและจ าแนกตามการน าตนเองในการเรียนรู้  
มีผลสัมฤทธ์ิทางการเรียนและการคิดวจิารณญาณโดยรวมเป็นรายดา้นเพิ่มข้ึนจากก่อนเรียน 
อยา่งมีนยัส าคญัทางสถิติท่ีระดบั .05 และมีความพึงพอใจต่อการเรียนดว้ยโปรแกรมบทเรียน 
แบบผสมผสานโดยรวมอยูใ่นระดบัมากถึงมากท่ีสุด 
 วรลกัษณ์ เวโน (2549) ไดท้  าการศึกษาผลการเรียนของนกัเรียนบนเครือข่าย  
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีท่ีมีต่อผลสัมฤทธ์ิทางการเรียนและแรงจูงใจ 
ใฝ่สัมฤทธ์ิของนกัเรียนชั้นมธัยมศึกษาปีท่ี 3 โรงเรียนหนองหม่ืนถ่านวทิยา อ าเภออาจสามารถ 
จงัหวดัร้อยเอด็ จ านวน 40 คน พบวา่ บทเรียนบนเครือข่ายท่ีพฒันาข้ึน มีประสิทธิภาพ 
เท่ากบั 80.88/ 80.06 สูงกวา่เกณฑท่ี์คาดหวงัไว ้คือ 80/ 80 และมีดชันีประสิทธิผล เท่ากบั 0.4231  
ซ่ึงหมายความวา่ นกัเรียนมีความรู้เพิ่มข้ึนคิดเป็นร้อยละ 42.31 อยูใ่นระดบัมาก 
 จกัรกฤษณ์ ถินคาเชิด (2548) ไดท้  าการเปรียบเทียบผลการเรียนรู้สาระการเรียนรู้ 
การงานอาชีพและเทคโนโลย ีเร่ืองการสร้างเวบ็เพจของนกัเรียนท่ีเรียนโดยใชบ้ทเรียนคอมพิวเตอร์
บนเครือข่ายแบบฝึกอบรม (WBT) แบบโครงงาน ตามคู่มือครู ผลการวจิยั พบวา่ บทเรียน             
บนเครือข่ายแบบฝึกอบรมท่ีพฒันาข้ึน มีประสิทธิภาพ เท่ากบั 87.95/ 86.36 ซ่ึงสูงกวา่เกณฑ ์
ท่ีก าหนดไว ้และมีค่าดชันีประสิทธิผลเท่ากบั 0.72 ดชันีประสิทธิผลของบทเรียนบนเครือข่าย 
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แบบฝึกอบรมและการเรียนแบบโครงงานตามคู่มือครู มีค่าเท่ากบั 0.7309 และ 0.6398 มีความรู้
เพิ่มข้ึนร้อยละ 73.09 และ 64.98 ตามล าดบั มีผลสัมฤทธ์ิทางการเรียนสูงกวา่กลุ่มควบคุม  
อยา่งมีนยัส าคญัทางสถิติท่ีระดบั .01 ซ่ึงมีความพึงพอใจทางการเรียนไม่แตกต่างกนั 
 นุจรินทร์ นาชยัเวยีง (2549) ไดท้  าการพฒันาบทเรียนคอมพิวเตอร์ เร่ืองการใชโ้ปรแกรม
ประมวลผลค า กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีชั้นมธัยมศึกษาปีท่ี 2 
โรงเรียนหนองบวัไชยวารพิทยาสรรพ ์อ าเภอหนองกุงศรี จงัหวดักาฬสินธ์ุ จ  านวน 30 คน 
การศึกษาคน้ควา้ พบวา่ ประสิทธิภาพของบทเรียนคอมพิวเตอร์ มีประสิทธิภาพเท่ากบั 90.67/ 81.53
สูงกวา่เกณฑ ์80/ 80 มีดชันีประสิทธิผลของบทเรียนคอมพิวเตอร์ท่ีพฒันาข้ึน มีค่าเท่ากบั 0.6819
หมายความวา่ หลงัการเรียนดว้ยบทเรียนคอมพิวเตอร์แลว้นกัเรียนมีคะแนนเพิ่มข้ึน คิดเป็น 
ร้อยละ 68.19 และมีความพึงพอใจต่อการเรียนโดยใชบ้ทเรียนคอมพิวเตอร์ เร่ือง การใชโ้ปรแกรม
ประมวลผลค่าโดยรวมอยูใ่นระดบัมาก 
 นิสิต ประเสริฐศรี (2549) ไดท้  าการเปรียบเทียบผลการเรียนโดยใชบ้ทเรียนบนเครือข่าย 
ของนกัเรียนท่ีใชว้ธีิเรียนแบบร่วมมือกบัแบบรายบุคคล เร่ือง ความรู้เบ้ืองตน้เก่ียวกบัเทคโนโลยี
สารสนเทศของนกัเรียนบทเครือข่ายท่ีพฒันาข้ึน มีประสิทธิภาพ เท่ากบั 82.19/ 81.17 และมีค่าดชันี
ประสิทธิผลเท่ากบั 0.65 แสดงวา่ นกัเรียนมีความกา้วหนา้ในการเรียนร้อยละ 65 นกัเรียน 
ท่ีเรียนดว้ยวธีิการเรียนแบบร่วมมือ มีผลสัมฤทธ์ิทางการเรียนสูงกวา่การเรียนแบบรายบุคคล  
อยา่งมีนยัส าคญัทางสถิติท่ีระดบั .05 และนกัเรียนทั้ง 2 กลุ่ม มีความพึงพอใจต่อการเรียน 
ดว้ยบทเรียนบนเครือข่ายโดยรวมอยูใ่นระดบัมาก 
  จากการศึกษาเอกสารและงานวจิยัท่ีเก่ียวขอ้งพบวา่ นกัการศึกษาของไทยใหค้วามส าคญั
ในการวจิยัเก่ียวกบัการพฒันาโปรแกรมบทเรียน ซ่ึงมีประโยชน์ทั้งต่อตวัผูส้อนและนกัเรียน 
เป็นอยา่งมาก ช่วยใหน้กัเรียนเรียนรู้ไดต้ามความสามารถของตนเอง ท าใหมี้ผลสัมฤทธ์ิ 
ทางการเรียนเพิ่มข้ึน นกัเรียนท่ีใชโ้ปรแกรมบทเรียนมีการคิดวจิารณญาณสูงกวา่ก่อนเรียน  
และมีความคงทนในการเรียนรู้ นอกจากน้ี นกัเรียนท่ีเรียนดว้ยโปรแกรมบทเรียนแบบผสมผสาน 
ยงัมีความรู้สึกชอบหรือพึงพอใจในการเรียนแบบผสมผสาน เน่ืองจาก โปรแกรมบทเรียน 
เป็นตวัเสริมแรงในการจดัการเรียนการสอน และการเรียนแบบผสมผสานดว้ยโปรแกรมบทเรียน 
จะท าใหผู้เ้รียนเขา้ใจในบทเรียนมากยิง่ข้ึน เพราะเป็นการเรียนการสอนท่ีมีกิจกรรมท่ีหลากหลาย 
เพื่อตอบสนองต่อความตอ้งการในการอยากรู้อยากเรียน และยงัเป็นการกระตุน้ใหผู้เ้รียนสนใจ
บทเรียนมากยิง่ข้ึน 
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บทที ่3 
วธีิด ำเนินกำรวจิยั 

 
 การด าเนินการวิจยัในคร้ังน้ี เป็นการวจิยัและพฒันา (Research and development) ผูว้จิยั
ไดส้ร้างบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี 
เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษา 
ปีท่ี 6 ซ่ึงผูว้จิยัไดด้ าเนินการตามขั้นตอน ADDIE  ดงัน้ี 
 1. ขั้นตอนการวิเคราะห์ (A: Analysis) 
 2. ขั้นตอนการออกแบบ (D: Design) 
 3. ขั้นตอนการพฒันา (D: Development) 
 4. ขั้นตอนการทดลอง (I: Implementation) 
 5. ขั้นตอนการประเมินผล (E: Evaluation) 
 โดยมีรายละเอียดการด าเนินการ ดงัน้ี 
 

ขั้นตอนกำรวเิครำะห์ (A: Analysis) 
 ขั้นตอนการวิเคราะห์ขอ้มูล มีการด าเนินงาน ดงัน้ี 
 1. วเิครำะห์ปัญหำ  
  1.1 การเรียนทางคอมพิวเตอร์ในปัจจุบนั เป็นการเรียนท่ีเนน้การปฏิบติัเป็นส่วนใหญ่
และในการปฏิบติัต่าง ๆ นั้น ผูเ้รียนจะลงมือปฏิบติังานคนเดียว ซ่ึงผูเ้รียนจะประสบปัญหา 
ในการเรียน หากเกิดความไม่เขา้ใจในการเรียนและเวลาท่ีเรียนมีจ ากดั จึงท าใหผู้เ้รียนขาดความรู้ 
ความเขา้ใจในการเรียน 
 1.2 การเรียนการสอนคอมพิวเตอร์นั้น เป็นการปฏิบติั ซ่ึงผูเ้รียนตอ้งเขา้ใจถึงขั้นตอน 
ในการสร้างหนงัสืออิเล็กทรอนิกส์ Google และการเรียนการสอนในปัจจุบนั ผูส้อนจะเป็นลงมือ
ปฏิบติัใหดู้ ในการปฏิบติัแต่ละคร้ังจะตอ้งใชเ้วลามากกวา่ นกัเรียนจะเรียนรู้ไดท้ั้งห้อง ท าให้
เสียเวลาในการสอนไป 
 2. วเิครำะห์เน้ือหำ 
 เน้ือหาท่ีจะน ามาใชใ้นการจดัการเรียนการสอน เป็นการสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรมอยา่งง่าย  ผูว้จิยัไดแ้บ่งเน้ือหาเป็น 5 หน่วยการเรียนรู้ ดงัรายละเอียดในตารางท่ี 3-1 
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ตารางท่ี 3-1 วเิคราะห์เน้ือหาและรูปแบบการเรียนรู้ กลุ่มสาระการงานอาชีพและเทคโนโลย ี 
  

เน้ือหำ สำระกำรเรียนรู้ รูปแบบกำรเรียน/กจิกรรม 

หน่วยที ่1 ความหมายและคุณสมบติั
ของหนงัสืออิเลก็ทรอนิกส์ (E-book)  
จ านวน 2 ชัว่โมง 
ผลกำรเรียนรู้ 
1. อธิบายความหมายของหนงัสือ
อิเลก็ทรอนิกส์ (E-book) ได ้(K) 
 

1. ความหมายของหนงัสือ 
    อิเลก็ทรอนิกส์ 
2. คุณสมบติัของหนงัสือ 
    อิเลก็ทรอนิกส์ 
3. ความแตกต่างระหวา่ง 
    หนงัสืออิเลก็ทรอนิกส์ 
    และหนงัสือแบบปกติ 
4. ขอ้ดีขอ้เสียของหนงัสือ 
    อิเลก็ทรอนิกส์ 

แบบออนไลน์ (1 ช่ัวโมง) 
1. ท าแบบทดสอบก่อนเรียน 
2. ตอบค าถามเพื่อกระตุน้ 
    ความคิดท่ีครูท่ีไดต้ั้งข้ึน 
    ผา่นทาง Google classroom 
3. นกัเรียนศึกษาขอ้มูลเพ่ิมเติม 
    จากบทเรียนออนไลน ์ท่ีครู 
    ไดส้ร้างข้ึนผา่น Google site  
    โดยน าเสนอในรูปแบบ 
    ของขอ้ความ ภาพและวดิีโอ  
4. ท าใบงานท่ี 1 ผา่น Google from 
5. ร่วมกนัอภิปรายและแสดง 
    ความคิดเห็นในหวัขอ้ท่ีครู 
    ก าหนดผา่น  
    Google classroom 
6. สรุปความรู้ดว้ยตนเอง 
    ผา่นทาง Google from 
7. ครูสรุปขอ้มูลใหน้กัเรียน 
    ผา่น Google classroom 
8. ติดต่อซกัถามขอ้สงสยัผา่น 
    Google hangouts 
เรียนแบบปกต ิ(1 ช่ัวโมง) 
1. ทบทวนความรู้  
2. มอบหมายงานกลุ่มใหน้กัเรียน 
    ช่วยกนัอภิปรายถึงขอ้ดีขอ้เสีย 
    ของหนงัสืออิเลก็ทรอนิกส์ 
3. น าเสนองานหนา้ชั้นเรียน 
4. ครูใหค้  าแนะน า 
    และขอ้เสนอแนะในแต่ละกลุ่ม 
5. ท าแบบทสอบประจ าหน่วยท่ี 1 
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ตารางท่ี 3-1 (ต่อ) 
  

เน้ือหำ สำระกำรเรียนรู้ รูปแบบกำรเรียน/กจิกรรม 

หน่วยที ่2 เร่ิมตน้ใชง้าน 
โปรแกรม Flip album pro 
ผลกำรเรียนรู้ 
1. อธิบายประโยชน ์
    และความสามารถของโปรแกรม  
    Flip album ได ้(K) 
2. อธิบายส่วนประกอบ 
    ของโปรแกรม Flip album ได ้(K) 

1. รู้จกักบัโปรแกรม  
    Flip album 
2. การเรียกใชโ้ปรแกรม  
    Flip album 

แบบออนไลน์ (1 ช่ัวโมง) 
 1. ตอบค าถามเพื่อกระตุน้ความคิด 
     ท่ีครูท่ีไดต้ั้งข้ึนผา่น  
     Google Classroom 
2. นกัเรียนศึกษาขอ้มูลเพ่ิมเติม 
    จากบทเรียนออนไลน ์
    ท่ีครูไดส้ร้างข้ึนผา่น Google site  
    โดยน าเสนอในรูปแบบ 
    ของขอ้ความ ภาพและวดิีโอ  
3. ท าใบงานท่ี 2 ผา่น Google from 
4. ร่วมกนัอภิปรายและแสดง 
    ความคิดเห็นในหวัขอ้ท่ีครู 
    ก าหนดผา่น Google classroom 
5. สรุปความรู้ดว้ยตนเองผา่น 
   Google from 
6. ครูสรุปขอ้มูลใหน้กัเรียน 
    ผา่น Google classroom 
7. ติดต่อซกัถามขอ้สงสยัผา่น 
    Google hangouts 
เรียนแบบปกต ิ(1 ช่ัวโมง) 
1. ทบทวนความรู้  
2. มอบหมายงานกลุ่มใหน้กัเรียน 
    ช่วยกนัอภิปรายถึงประโยชน ์
    และความสามารถของโปรแกรม  
    Flip album 
3. น าเสนองานหนา้ชั้นเรียน 
4. ครูใหค้  าแนะน า 
    และขอ้เสนอแนะในแต่ละกลุ่ม 
5. ท าแบบทสอบประจ าหน่วยท่ี 2 
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ตารางท่ี 3-1 (ต่อ) 
  

เน้ือหำ สำระกำรเรียนรู้ รูปแบบกำรเรียน/กจิกรรม 

หน่วยที ่3 การออกแบบ 
และการสร้างหนงัสืออิเลก็ทรอนิกส์ 
ผลกำรเรียนรู้ 
1. อธิบายวธีิการขั้นตอนในการสร้าง 
    หนงัสืออิเลก็ทรอนิกส์ใหม่ได ้
2. อธิบายวธีิการบนัทึกและการเปิด 
    หนงัสืออิเลก็ทรอนิกส์ได ้
3. อธิบายวธีิการใส่ภาพและการท า 
    ปกหนา้ของหนงัสืออิเลก็ทรอนิกส์ 
    ได ้
4. มีทกัษะในการใส่ภาพ 
    และภาพเคล่ือนไหว     
   ในหนงัสืออิเลก็ทรอนิกส์ได ้
 

1. ขั้นตอนการสร้าง E-book 
2. การเพ่ิมและลบหนา้กระดาษ 
3. การแทรกขอ้ความ 
4. การแทรกภาพ/ เสียง/ วดีีโอ
5. เทคนิคกราฟิกดีไซน ์
6. การสร้างการเช่ือมโยง 
7. การบนัทึกและการจดัเก็บ 
 

แบบออนไลน์ (1 ช่ัวโมง) 
1. ตอบค าถาม เพื่อกระตุน้ความคิด 
    ท่ีครูท่ีไดต้ั้งข้ึนผา่น  
    Google classroom 
2. นกัเรียนศึกษาขอ้มูลเพ่ิมเติม 
    จากบทเรียนออนไลนท่ี์ ครู 
    ไดส้ร้างข้ึนผา่น Google site  
    โดยน าเสนอในรูปแบบ 
     ของขอ้ความ/ ภาพและวดิีโอ  
3. ท าใบงานท่ี 3 ผา่น Google from 
4. ร่วมกนัอภิปรายและแสดง 
    ความคิดเห็นในหวัขอ้ ท่ีครู 
    ก าหนดผา่น Google classroom 
5. สรุปความรู้ดว้ยตนเองผา่น 
    Google From 
6. ใหน้กัเรียนฝึกสร้างหนงัสือ 
    อิเลก็ทรอนิกส์ดว้ยตนเอง 
7. ติดต่อซกัถามขอ้สงสยัผา่น  
    Google hangouts 
เรียนแบบปกต ิ(1 ช่ัวโมง) 
1. ทบทวนความรู้  
2. ใหน้กัเรียนสร้างหนงัสือ 
    อิเลก็ทรอนิกส์ดว้ยตนเอง 
    ต่อจากชัว่โมงท่ีผา่นมา 
3. น าเสนองานหนา้ชั้นเรียน 
4. ครูใหค้  าแนะน า 
    และขอ้เสนอแนะในแต่ละกลุ่ม 
5. ท าแบบทสอบประจ าหน่วยท่ี 3 
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ตารางท่ี 3-1 (ต่อ) 
  

เน้ือหำ สำระกำรเรียนรู้ รูปแบบกำรเรียน/กจิกรรม 

หน่วยที ่4 การตกแต่งหนงัสือ
อิเลก็ทรอนิกส์ใหส้วยงาม 
ผลกำรเรียนรู้ 
1. มีทกัษะในการใช ้Themes  
    ในการตกแต่ง E-book 
2. มีทกัษะในการใส่สนั 
    ใหก้บัหนงัสือ 
3. มีทกัษะในการท าหนา้สารบญั 
    และดชันี 
 

1. การตกแต่ง E-book  
   โดยใช ้Themes 
2. การใส่สนัหนงัสือ 
3. การท าหนา้สารบญัและดชันี 

แบบออนไลน์ (1 ช่ัวโมง) 
 1. ตอบค าถามเพื่อกระตุน้ความคิด 
    ท่ีครูท่ีไดต้ั้งข้ึนผา่น  
    Google classroom 
2. นกัเรียนศึกษาขอ้มูลเพ่ิมเติม 
    จากบทเรียนออนไลนท่ี์ครู 
    ไดส้ร้างข้ึนผา่น Google site  
    โดยน าเสนอในรูปแบบ 
    ของขอ้ความ/ ภาพและวดิีโอ  
3. ท าใบงานท่ี 4 ผา่น Google from 
4. ร่วมกนัอภิปรายและแสดง 
    ความคิดเห็นในหวัขอ้ 
    ท่ีครูก าหนดผา่น  
    Google classroom 
5. สรุปความรู้ดว้ยตนเองผา่น 
    Google from 
6. ใหน้กัเรียนตกแต่งหนงัสือ 
    อิเลก็ทรอนิกส์ดว้ยตนเอง 
7. ติดต่อซกัถามขอ้สงสยั 
    ผา่น Google hangouts 
เรียนแบบปกต ิ(1 ช่ัวโมง) 
1. บทวนความรู้  
2. ใหน้กัเรียนตกแต่งหนงัสือ 
    อิเลก็ทรอนิกส์ดว้ยตนเอง 
    ต่อจากชัว่โมงท่ีผา่นมา 
3. น าเสนองานหนา้ชั้นเรียน 
4. ครูใหค้  าแนะน าและ 
    ขอ้เสนอแนะในแต่ละกลุ่ม 
5. ท าแบบทสอบประจ าหน่วยท่ี 4 
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ตารางท่ี 3-1 (ต่อ) 
  

เน้ือหำ สำระกำรเรียนรู้ รูปแบบกำรเรียน/กจิกรรม 

หน่วยที ่5 การน าหนงัสือไปใชง้าน 
ผลกำรเรียนรู้ 
1. อธิบายวธีิการบีบอดัไฟลห์นงัสือ 
    อิเลก็ทรอนิกส์เพ่ือเผยแพร่ 
    ดว้ยค าสัง่ Package ได ้
2. มีทกัษะในการบีบอดัไฟลห์นงัสือ 
    อิเลก็ทรอนิกส์ เพ่ือเผยแพร่ 
    ดว้ยค าสัง่ Package  
 

1. การบีบอดัไฟลแ์ละสร้าง CD 
2. เพื่อน าเสนอขอ้มูล 

แบบออนไลน์ (1 ช่ัวโมง) 
 1. ตอบค าถามเพื่อกระตุน้ความคิด 
     ท่ีครูท่ีไดต้ั้งข้ึนผา่น 
     Google classroom 
2. นกัเรียนศึกษาขอ้มูลเพ่ิมเติม 
    จากบทเรียนออนไลนท่ี์ครู 
    ไดส้ร้างข้ึนผา่น Google site  
    โดยน าเสนอในรูปแบบ 
    ของขอ้ความ/ ภาพและวดิีโอ  
3. ท าใบงานท่ี 5 ผา่น Google from 
4. ร่วมกนัอภิปรายและแสดง 
    ความคิดเห็นในหวัขอ้ท่ีครู 
    ก าหนดผา่น Google classroom 
5. สรุปความรู้ดว้ยตนเอง 
    ผา่น Google from 
6 สรุปขอ้มูลใหน้กัเรียน 
    ผา่น Google classroom 
7. ติดต่อซกัถามขอ้สงสยั 
    ผา่นทาง Google hangouts 
เรียนแบบปกต ิ(1 ช่ัวโมง) 
1. ทบทวนความรู้  
2. มอบหมายงานกลุ่มใหน้กัเรียน 
    ช่วยกนัอภิปรายถึงการน า  
    E-book ไปใชอ้ยา่งถูกตอ้ง 
3. น าเสนองานหนา้ชั้นเรียน 
4. ครูใหค้  าแนะน า 
    และขอ้เสนอแนะในแต่ละกลุ่ม 
5. ท าแบบทดสอบหลงัเรียน 
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 3. วเิครำะห์ผู้เรียน 
 ผูว้จิยั ไดศึ้กษาผลสัมฤทธ์ิทางการเรียนของนกัเรียน และสอบถามเก่ียวกบัสภาพปัญหา
การเรียนของนกัเรียนโรงเรียนวดัตโปทาราม พบวา่การเรียนการสอนในกลุ่มสาระการงานอาชีพ
และเทคโนโลย ี(คอมพิวเตอร์) ครูผูส้อนประสบปัญหาเร่ืองส่ือประกอบการเรียนการสอน 
ยงัไม่น่าสนใจ นกัเรียนแต่ละคนมีความสามารถในการรับรู้ไม่เท่ากนั แต่นกัเรียนทุกคน 
ผา่นการเรียนพื้นฐานในการใชค้อมพิวเตอร์มาแลว้ และมีทกัษะการใชค้อมพิวเตอร์ ในระดบั 
พื้นฐานได ้
  4. เคร่ืองมือทีใ่ช้ในกำรวจัิย 
 เคร่ืองมือท่ีใชใ้นการวจิยัในขั้นตอนน้ี คือ แผนการจดัการเรียนรู้แบบผสมผสาน 
กลุ่มสาระการงานอาชีพและเทคโนโลย ี มีรายละเอียดการสร้างและหาคุณภาพเคร่ืองมือ ดงัน้ี 
 4.1 ผูว้จิยัศึกษาและวเิคราะห์หลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน พุทธศกัราช 
2551 โดยศึกษาเก่ียวกบัวสิัยทศัน์ หลกัการ จุดมุ่งหมาย สมรรถนะส าคญัของผูเ้รียน คุณภาพผูเ้รียน  
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีก าหนดผลการเรียนรู้ และแบ่งเน้ือหาเพื่อจดัท า
แผนการจดัการเรียนรู้แบบผสมผสานกลุ่มสาระการงานอาชีพและเทคโนโลย ีเร่ือง การสร้าง
หนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรมคอมพิวเตอร์อยา่งง่าย ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  
 4.2 ผูว้จิยัน าเคร่ืองมือท่ีไดจ้ดัท าข้ึน เสนออาจารยท่ี์ปรึกษาเพื่อตรวจสอบเน้ือหา  
และการใชภ้าษา แลว้น าขอ้เสนอแนะจากอาจารยท่ี์ปรึกษามาปรับปรุงแกไ้ขใหถู้กตอ้ง ชดัเจน 
 5. กำรเกบ็รวบรวมข้อมูล 
 ผูว้จิยัไดเ้ก็บรวบรวมขอ้มูล โดยศึกษาจากผลสัมฤทธ์ิทางการเรียนของนกัเรียน 
สภาพปัญหาการจดัการเรียนการสอน  สอบถามจากนกัเรียนและครูผูส้อนกลุ่มสาระการเรียนรู้ 
การงานอาชีพและเทคโนโลย ี   
  

ขั้นตอนกำรออกแบบ (D: Design) 
              การออกแบบบทเรียน ผูว้จิยัไดด้ าเนินการสร้างบทเรียนตามขั้นตอน ดงัน้ี 
 2.1 กำรออกแบบบทเรียน ผูว้ิจยัไดด้ าเนินการสร้างบทเรียนผา่นทาง Google app for 
educations ตามขั้นตอนดงัน้ี 
 2.1.1 ก าหนดจุดประสงคก์ารเรียนรู้  
 2.1.2 ค าแนะน าการใชบ้ทเรียน 
 2.1.3 สร้างค าถามกระตุน้ความคิดผา่นทาง Google classroom 
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 2.1.4 น าเสนอเน้ือหาในแต่ละหน่วยการเรียนรู้ ผา่นทาง Google site ประกอบดว้ย 
ขอ้ความ ภาพ และวดิีโอ 
 2.1.5 แบบฝึกหดัระหวา่งเรียนผา่นทาง Google form 
 2.1.6 สรุปเน้ือหา 
 2.1.7 สร้างช่องการการติดต่อส่ือสารผา่นทาง Google hangouts 
 2.2 ออกแบบแบบทดสอบ 
 2.2.1 ออกแบบทดสอบวดัผลสัมฤทธ์ิทางการเรียนใหค้รอบคลุมจุดประสงค ์             
การเรียนรู้และเน้ือหา เป็นแบบปรนยั จ านวน 30 ขอ้ 
 2.2.2 ก าหนดจุดประสงคก์ารเรียนรู้ของการทดสอบ โดยพิจารณาจากจุดประสงค ์
ของการสอนแต่ละเร่ือง แลว้ก าหนดอตัราส่วนของแบบทดสอบใหค้รอบคลุมเน้ือหา 
 2.3 ออกแบบประเมินควำมพงึพอใจ   
 2.3.1 ก าหนดหวัขอ้และสร้างแบบประเมินความพึงพอใจการเรียน 
ดว้ยบทเรียนออนไลน์แบบผสมผสาน โดยผูว้จิยัไดแ้บ่งการประเมินออกเป็น 4 ดา้น ไดแ้ก่  
1) ดา้นเน้ือหาและการด าเนินเร่ือง จ านวน 5 ขอ้ 2) ดา้นภาพ ภาษา และเสียง จ านวน 7 ขอ้  
3) ดา้นตวัอกัษรและสี จ านวน 3 และ ขอ้ 4) ดา้นประสบการณ์การเรียน จ านวน 5 ขอ้   
โดยแบ่งการประเมินมาตรการส่วนประมาณค่า (Rating scale) 5 ระดบั ในการใหค้ะแนน 
โดยมีหลกัการใหค้ะแนนดงัน้ี 
  พอใจมากท่ีสุด  ใหค้ะแนน 5 
  พอใจมาก  ใหค้ะแนน 4 
  พอใจปานกลาง ใหค้ะแนน 3 
  พอใจนอ้ย  ใหค้ะแนน 2 
  พอใจนอ้ยท่ีสุด ใหค้ะแนน 1 
 

ขั้นตอนกำรพฒันำ (D: Development)  
 ขั้นตอนการพฒันา มีการด าเนินงาน ดงัน้ี 
 1. พฒันำบทเรียนออนไลน์แบบผสมผสำน 
 1.1 ศึกษาเอกสารหลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน พุทธศกัราช 2551 
 กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี 
 1.2 ก าหนดจุดประสงคก์ารเรียนรู้และเน้ือหาส าหรับออกแบบบทเรียนออนไลน์ 
แบบผสมผสาน 
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 1.3 ออกแบบบทเรียนออนไลน์แบบผสมผสาน 
 1.4 สร้างบทเรียนออนไลน์แบบผสมผสาน ผูว้จิยัไดเ้ลือกใช ้Google apps for 
education โดยแบ่งออกเป็น 2 ส่วน คือ ส่วนท่ีเป็นออนไลน์และส่วนท่ีเผชิญหนา้ในชั้นเรียน 
 1.5 น าบทเรียนออนไลน์แบบผสมผสานไปใหอ้าจารยท่ี์ปรึกษา และคณะกรรมการ 
ผูค้วบคุมวทิยานิพนธ์ตรวจ จากนั้น น าไปใหผู้เ้ช่ียวชาญ จ านวน 5 ท่าน ตรวจสอบ โดยใช ้
แบบประเมินความเหมาะสมของบทเรียนออนไลน์แบบผสมผสาน มีเกณฑแ์ปลความหมาย ดงัน้ี 
(พวงรัตน์ ทวีรัตน์, 2543) 
 ใหค้ะแนน 4.51-5.00 อยูใ่นระดบัท่ี เหมาะสมมากท่ีสุด 
 ใหค้ะแนน 3.51-4.50 อยูใ่นระดบัท่ี เหมาะสมมาก 
 ใหค้ะแนน 2.51-3.50 อยูใ่นระดบัท่ี เหมาะสมปานกลาง 
 ใหค้ะแนน 1.51-2.50 อยูใ่นระดบัท่ี เหมาะสมนอ้ย 
 ใหค้ะแนน 0.00-1.50 อยูใ่นระดบัท่ี เหมาะสมนอ้ยท่ีสุด 
 ผูเ้ช่ียวชาญดา้นเทคโนโลยีการศึกษา มีคุณสมบติั ดงัน้ี 
 1. จบการศึกษาระดบัปริญญาโท ข้ึนไป 
 2. มีประสบการณ์ดา้นบทเรียนออนไลน์ไม่นอ้ยกวา่ 5 ปี 
 ผูเ้ช่ียวชาญมีรายนาม ดงัน้ี  
 1. ดร.ฐิติชยั รักบ ารุง อาจารยป์ระจ าภาควชิานวตักรรมและเทคโนโลยกีารศึกษา  
คณะศึกษาศาสตร์ มหาวทิยาลยับูรพา 
 2. ดร.ณฐาภพ สมคิด อาจารยป์ระจ าภาควชิานวตักรรมและเทคโนโลยกีารศึกษา  
คณะศึกษาศาสตร์ มหาวทิยาลยับูรพา 
 3. ดร.แสงทอง บุญยิง่ อาจารยป์ระจ าภาควชิานวตักรรมและเทคโนโลยกีารศึกษา 
คณะศึกษาศาสตร์ มหาวทิยาลยับูรพา 
 4. ดร.สมพล เขม็ก าเหนิด อาจารยป์ระจ าภาควชิานวตักรรมและเทคโนโลยกีารศึกษา 
คณะศึกษาศาสตร์ มหาวทิยาลยับูรพา 
 5. ดร.นราวชิญ ์ศรีเปารยะ อาจารยป์ระจ าภาควชิานวตักรรมและเทคโนโลยกีารศึกษา 
คณะศึกษาศาสตร์ มหาวทิยาลยับูรพา 
 2. กำรสร้ำงแบบทดสอบ 
 2.1 สร้างแบบทดสอบวดัผลสัมฤทธ์ิทางการเรียน ใหค้รอบคลุมจุดประสงคก์ารเรียนรู้ 
และเน้ือหา เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรมคอมพิวเตอร์อยา่งง่าย 
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 2.2 วเิคราะห์จุดประสงคก์ารเรียนรู้ของเน้ือหาสาระแต่ละหวัเร่ือง เพื่อน าไปก าหนด
สัดส่วนในการออกขอ้สอบใหค้รอบคลุมตามวตัถุประสงค ์
 2.3 ก าหนดจุดประสงคก์ารเรียนรู้ของการทดสอบ โดยพิจารณาจากจุดประสงค ์     
ของการสอนแต่ละหวัเร่ือง และก าหนดอตัราส่วนของแบบทดสอบใหค้รอบคลุมเน้ือหา 
 2.4 สร้างแบบทดสอบท่ีสอดคลอ้งกบัจุดประสงคก์ารเรียนรู้ของแต่ละหวัเร่ือง 
เป็นขอ้สอบปรนยั จ านวน 30 ขอ้  
 2.5 น าแบบทดสอบท่ีสร้างข้ึนเสนออาจารยท่ี์ปรึกษา เพื่อตรวจสอบเน้ือหาและการใช้
ภาษา แลว้น าขอ้เสนอแนะจากอาจารยท่ี์ปรึกษามาปรับปรุงแกไ้ขขอ้ค าถามใหถู้กตอ้ง ชดัเจน 
 2.6 น าแบบทดสอบท่ีปรับปรุงแกไ้ขแลว้ใหผู้เ้ช่ียวชาญ จ านวน 5 คน ตรวจสอบ 
ความสอดคลอ้งระหวา่งขอ้ค าถามกบัจุดประสงคก์ารเรียนรู้หรือเน้ือหา (Index of item objective 
congruence: IOC) โดยก าหนดเกณฑใ์นการพิจารณาค่า IOC ดงัน้ี 
  2.6.1 ขอ้ค าถามท่ีมีค่า IOC ตั้งแต่ 0.6-1.00 คดัเลือกไวใ้ชไ้ด ้
  2.6.2 ขอ้ค าถามท่ีมีค่า IOC ต ่ากวา่ 0.6 ควรพิจารณาปรับปรุงหรือตดัทิ้ง 
  2.6.3 การตรวจสอบความสอดคลอ้งระหวา่งขอ้ค าถามกบัวตัถุประสงคห์รือเน้ือหา 
ใชเ้กณฑใ์นการตรวจพิจารณาขอ้ค าถาม ดงัน้ี 
  ก าหนดคะแนนเป็น +1 มีความเห็นวา่ สอดคลอ้ง 
  ก าหนดคะแนนเป็น +0 มีความเห็นวา่ ไม่แน่ใจ 
  ก าหนดคะแนนเป็น  -1 มีความเห็นวา่ ไม่สอดคลอ้ง 
 จากนั้นน ามาแทนค่าในสูตรหาดชันีความสอดคลอ้ง 
   IOC =  ∑R/N  
 เม่ือ  IOC   หมายถึง ดชันีความสอดคลอ้ง 
        ∑R   หมายถึง ผลรวมคะแนนความคิดเห็นของผูเ้ช่ียวชาญ 
      N   หมายถึง จ านวนผูเ้ช่ียวชาญ 
 ไดผ้ลการหาค่าความสอดคลอ้งระหวา่งขอ้ค าถามกบัวตัถุประสงคห์รือเน้ือหา   
อยูร่ะหวา่ง .87-1.00 แสดงวา่มีความสอดคลอ้ง ถือวา่อยูใ่นเกณฑใ์ชไ้ด ้ไม่ตอ้งท าการปรับปรุง 
 2.8 น าแบบทดสอบไปทดสอบกบักลุ่มเป้าหมายจ านวน 30 คน 
 2.9 น าผลการทดสอบมาตรวจใหค้ะแนน แลว้วิเคราะห์หาความยากง่าย (p)  
และค่าอ านาจจ าแนกของขอ้สอบ (r) โดยใชเ้ทคนิค ร้อยละ 33 กลุ่มสูง กลุ่มต ่า โดยใชสู้ตร 
ของจอห์นสันและกิลฟอร์ด 
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  2.10 เลือกขอ้ความท่ีมีความยากง่าย (p) ระหวา่ง .20-.80 จ านวน 15 ขอ้ ไวใ้ช ้
ในการทดลองและไดค้่าอ านาจจ าแนกของขอ้สอบรวมเป็น r = .86 
  2.11 หาความเช่ือมัน่ของแบบทดสอบทั้งฉบบั ดว้ยสูตร KR20 ของคูเดอร์ ริชาร์ดสัน    
  2.12 น าแบบทดสอบไปใชก้บักลุ่มเป้าหมาย 
 3. สร้ำงแบบสอบถำมควำมพึงพอใจ 
 3.1 ศึกษาเอกสาร ต าราและงานวจิยัท่ีเก่ียวขอ้งกบัการสร้างแบบสอบถาม 
ความพึงพอใจ โดยศึกษาตวัอยา่งแบบสอบถามความพึงพอใจในการเรียนการสอนผา่นบทเรียน
ออนไลน ์เพื่อน ามาสร้างแบบสอบถามความพึงพอใจท่ีผูเ้รียนมีต่อรูปแบบการจดักิจกรรมการเรียน
การสอน ดว้ยบทเรียนออนไลน์แบบผสมผสาน 
 3.2 ก าหนดวตัถุประสงคก์ารเรียนรู้ของแบบสอบถาม 
 3.3 ก าหนดโครงสร้างของแบบสอบถาม ไดแ้ก่ 1) ค  าช้ีแจง 2) ขอ้ค าถาม  
 3.4 ออกแบบแบบสอบถามตามวตัถุประสงคท่ี์ก าหนด 
 3.5 สร้างแบบสอบถามความพึงพอใจท่ีมีต่อการเรียนดว้ยบทเรียนออนไลน์ 
แบบผสมผสาน เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ ดว้ยโปรแกรม Flip album ส าหรับนกัเรียน
ชั้นประถมศึกษาปีท่ี 6 มีเกณฑก์ารประเมินความพึงพอใจ 5 ระดบั ไดแ้ก่ มากท่ีสุด มาก ปานกลาง 
นอ้ย และนอ้ยท่ีสุด 
 3.6 น าแบบสอบถามความพึงพอใจท่ีสร้างข้ึน ไปใหอ้าจารยท่ี์ปรึกษาวทิยานิพนธ์
ตรวจสอบเพื่อปรับปรุงแกไ้ข และใหผู้เ้ช่ียวชาญประเมินตรวจสอบความสอดคลอ้ง 
ของแบบสอบถามความพึงพอใจ 
 3.7 น าแบบสอบถามความพึงพอใจท่ีผา่นการตรวจสอบและปรับปรุงแกไ้ขเรียบร้อย
แลว้ ไปทดลองกบักลุ่มเป้าหมายและวเิคราะห์ผล โดยความพึงพอใจท่ีไดจ้ากการวิจยัคร้ังน้ี อยูใ่น
ระดบัค่าเฉล่ียเท่ากบั 4.58 ค่าเบ่ียงเบนมาตรฐานเท่ากบั 0.54    
 3.8 ทดลองใชเ้บ้ืองตน้ (Try out) เพื่อหาขอ้บกพร่องจากการเรียนดว้ยบทเรียน
ออนไลน์แบบผสมผสานท่ีไดพ้ฒันาข้ึน ดงัน้ี 
 3.8.1. ทดลองแบบรายบุคคล โดยน าบทเรียนออนไลน์แบบผสมผสานท่ีสร้างข้ึน
ไปทดลองใชก้บันกัเรียนชั้นประถมศึกษาปีท่ี 6 จ านวน 3 คน ท่ีไม่ใช่กลุ่มตวัอยา่ง เพื่อจะไดท้ราบ
การปฏิสัมพนัธ์กบับทเรียนท่ีไดอ้อกแบบไว ้เม่ือดูวา่ผูเ้รียนท าไดห้รือไม่ได ้ตรวจสอบความสนใจ 
ความเขา้ใจ โดยผูว้จิยัไดส้ังเกต พูดคุย สอบถามและบนัทึกผลไว ้พบวา่ ร้อยละของคะแนนเฉล่ีย
การท าแบบทดสอบก่อนเรียน เท่ากบั 66.67 หลงัเรียนเท่ากบั 62.22  
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 จากการสังเกตและสอบถามผูเ้รียนท่ีใชบ้ทเรียนออนไลน์แบบผสมผสานท่ีผูว้จิยั
ไดส้ร้างข้ึน ถึงขอ้บกพร่องท่ีตอ้งการปรับแกไ้ข ดงัน้ี  
 ก. กลุ่มตวัอยา่งไม่เขา้ใจค าวา่บทเรียนออนไลน์แบบผสมผสาน 
 ข. ยงัเขา้ใชง้านไม่ถูกตอ้ง 
 ค. ยงัไม่เขา้ใจล าดบัในการเรียน 
 ง. ยงัไม่เขา้ใจแบบทดสอบบางขอ้ 
 3.8.2 เม่ือผูเ้รียนท าแบบทดสอบแลว้ สามารถเห็นคะแนนไดท้นัที ผูว้จิยั 
จึงสังเกตเห็นกลุ่มตวัอยา่งมีความกระตือรือร้นในการเรียนมากข้ึน 
 3.8.3 น าผลสรุปทั้งหมด ปรึกษาอาจารยท่ี์ปรึกษาและสอบถามผูเ้ช่ียวชาญ 
เพื่อท าการปรับปรุงแกไ้ขตามขอ้เสนอแนะ สรุปได ้ดงัน้ี 
 ก. สร้างวดิีโอแนะน าแนวทางการใชบ้ทเรียนออนไลน์แบบผสมผสาน 
 ข. อธิบายเมนูต่าง ๆ ในบทเรียนออนไลน์แบบผสมผสาน ใหผู้เ้รียนไดเ้ขา้ใจ 
ก่อนท ากิจกรรมการเรียน 
 ค. ออกแบบกิจกรรมการเรียนรู้ทั้งในออนไลน์และแบบเผชิญหนา้ในแต่ละคร้ัง 
ใหช้ดัเจน มีการเพิ่มตวัอยา่งประกอบเน้ือหาเพิ่มเติม เพี่อใหผู้เ้รียนเห็นเป็นรูปธรรมมากยิง่ข้ึน 
 3.9 การทดลองใชเ้บ้ืองตน้ (Try out) แบบกลุ่มยอ่ย (1:10) ดงัน้ี 
 3.9.1 ทดลองแบบกลุ่มยอ่ย โดยน าบทเรียนออนไลน์แบบผสมผสานท่ีผูว้จิยั 
สร้างข้ึน ไปทดลองใชก้บันกัเรียนชั้นประถมศึกษาปีท่ี 6 จ านวน 10 คน ท่ีไม่ใช่กลุ่มตวัอยา่ง เพื่อหา
ค่าประสิทธิภาพและขอ้บกพร่องของบทเรียนออนไลน์แบบผสมผสาน พบวา่ ร้อยละของคะแนน
เฉล่ียการท าแบบทดสอบก่อนเรียน เท่ากบั 71.67 หลงัเรียนเท่ากบั 78.00  
  จากการสังเกตและสอบถามผูเ้รียนท่ีใชบ้ทเรียนออนไลน์แบบผสมผสาน ท่ีผูว้จิยั
สร้างข้ึน ถึงขอ้บกพร่องท่ีตอ้งท าการปรับปรุงแกไ้ข ดงัน้ี 
 ก. ค  าแนะน าของบทเรียนไม่ชดัเจน 
 ข. เน้ือหาบางหน่วยในบทเรียนออนไลน์ มีมากเกินไป 
 ค. การลิงคข์อ้มูลจากภายนอก ยงัไม่หลากหลาย 
 ง. กิจจกรรมบนออนไลน์และแบบเผชิญหนา้ มีมากเกินไป 
 3.9.2 น าผลสรุปทั้งหมด ปรึกษาอาจารยท่ี์ปรึกษาและสอบถามผูเ้ช่ียวชาญ เพื่อท า
การปรับปรุงแกไ้ขตามขอ้เสนอแนะ สรุปไดด้งัน้ี 
 ก. จดัท าค าแนะน าบทเรียนใหม่ ใหมี้ความสอดคลอ้งกบัเน้ือหาและชดัเจนมากข้ึน 
 ข. ตดัในส่วนท่ีเป็นขอ้ความออก แลว้เพิ่มวดิีโอเขา้ไป ท าใหผู้เ้รียนเขา้ใจไดง่้ายข้ึน 



61 
 

 ค. เพิ่มลิงคแ์หล่งเรียนรู้ไปยงัเวบ็ต่าง ๆ ใหม้ากข้ึน  
 3.10.3 การทดลองใชเ้บ้ืองตน้ (Try out) แบบภาคสนาม (1:100) ดงัน้ี 
 3.10.4 น าบทเรียนออนไลน์แบบผสมผสานท่ีผูว้จิยัไดส้ร้างข้ึน ไปทดลองใชก้บั
นกัเรียนชั้นประถมศึกษาปีท่ี 6 จ านวน 30 คนพบวา่ ร้อยละของคะแนนเฉล่ียการท าแบบทดสอบ
ก่อนเรียนเท่ากบั 80.44 หลงัเรียนเท่ากบั 82.00 ผา่นตามเกณฑ ์ท่ีตั้งไว ้E1/ E2 = 85.85 
 4. กำรเกบ็รวบรวมข้อมูล  
 เก็บรวบรวมขอ้มูลจากผูเ้ช่ียวชาญ น ามาวเิคราะห์หาประสิทธิภาพและดชันีประสิทธิผล
ของบทเรียน 
  5. กำรวเิครำะห์ข้อมูล 
 5.1 น าบทเรียนออนไลน์แบบผสมผสานท่ีไดจ้ากการทดลองใช ้มาทดสอบ
ประสิทธิภาพ E1/ E2 น าผลท่ีไดจ้ากการทดลองเทียบเกณฑท่ี์ก าหนดไว ้(E1/ E2 = 85/ 85)  
ของ ชยัยงค ์พรหมวงศ ์(2536) 
 5.2 น าบทเรียนออนไลน์แบบผสมผสานไดจ้ากการทดลองใช ้มาทดสอบ 
หาดชันีประสิทธิผล 
 5.3 น าแบบทดสอบ มาวิเคราะห์ค่าความสอดคลอ้งระหวา่งขอ้ค าถามกบัจุดประสงค์
การเรียนรู้หรือเน้ือหา 
 5.4 น าแบบสอบถามความพึงพอใจไดจ้ากการทดลองใช ้ประเมินค่าความสอดคลอ้ง 
สถิติท่ีใชใ้นการวเิคราะห์ 
 6. สถิติพืน้ฐำน  
 6.1 ประกอบดว้ย ค่าร้อยละ ค่าเฉล่ีย (Mean) ค่าความเบ่ียงเบนมาตรฐาน (Standard 
deviation) 
 6.2 สถิติท่ีใชใ้นการตรวจสอบคุณภาพของเคร่ืองมือ ประกอบดว้ย การวิเคราะห์ 
หาความยากง่าย (p) ค่าอ านาจจ าแนก (r) ของแบบทดสอบ ใชสู้ตรของ จอห์นสัน (อา้งถึงใน
ประคอง กรรณสูตร, 2541) 
 6.3 การหาค่าความเช่ือมัน่ของแบบทดสอบ ใชสู้ตร KR-20 ของคูเดอร์ ริชาร์ดสัน 
(อา้งถึงในประคอง กรรณสูตร, 2541) 
 6.4 สถิติท่ีใชใ้นการทดสอบประสิทธิภาพของบทเรียนออนไลน์แบบผสมผสาน 
ใชสู้ตร E1/ E2 ของ ชยัยงค ์พรหมวงศ ์(2536) 
 6.5 สถิติท่ีใชใ้นการทดสอบหาค่าดชันีประสิทธิผล ใชสู้ตรของ บุญชม ศรีสะอาด 
(2545) 
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ขั้นตอนกำรทดลอง (I: Implementation) 
 ขั้นตอนการทดลอง ด าเนินการทดลองกบักลุ่มเป้าหมาย เพื่อหาประสิทธิภาพ 
ประสิทธิผลของบทเรียน และผลสัมฤทธ์ิทางการเรียนดว้ยการเรียนดว้ยบทเรียนออนไลน์ 
แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสือ
อิเล็กทรอนิกส์ ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ด าเนินการทดลอง
ใชจ้ริง (Trial run) ดงัน้ี 
 4.1 ผูว้จิยั น าขอ้บกพร่องท่ีไดรั้บจากการทดลองขา้งตน้ มาปรับปรุงและพฒันาบทเรียน 
ออนไลน์แบบผสมผสานให้สมบูรณ์มากยิง่ข้ึน 
 4.2 ผูว้จิยั น าบทเรียนออนไลน์แบบผสมผสานใชก้บัผูเ้รียนท่ีเป็นกลุ่มเป้าหมาย 
คือ นกัเรียนชั้นประถมศึกษาปีท่ี 6 โรงเรียนวดัตโปทาราม 1 หอ้งเรียน จ านวน 30 คน  
และน าผลคะแนนจากแบบฝึกหดัในบทเรียน มาใชใ้นการหาค่าประสิทธิภาพของบทเรียนออนไลน์
แบบผสมผสาน พบวา่ ร้อยละของคะแนนเฉล่ียการท าแบบทดสอบก่อนเรียนเท่ากบั 86.22 หลงั
เรียนเท่ากบั 86.44 ผา่นตามเกณฑ ์ท่ีตั้งไว ้E1/ E2 = 85/ 85 
 

ขั้นตอนกำรประเมนิผล (E: Evaluation)  
 หลงัจากเสร็จส้ินการทดลองใชบ้ทเรียนออนไลน์แบบผสมผสาน และเก็บขอ้มูลต่าง ๆ 
เรียบร้อยแลว้ ผูว้จิยัท าการวเิคราะห์ขอ้มูลในประเด็นต่าง ๆ  ดงัน้ี 
 5.1 การประเมินประสิทธิภาพของบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระ 
การเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip 
album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ใชก้ารหาประสิทธิภาพ E1/ E2 (ชยัยงค ์พรหมวงศ,์ 
2520) ดงัน้ี   
                 E1 =  ∑X 

 
                 E2 =  ∑f 

 
 เม่ือ E1 ตวัแรก หมายถึง คะแนนท่ีแสดงถึงความสามารถของกระบวนการ ท าใหเ้กิด 
การเรียนรู้ไดจ้ากค่าเฉล่ียของคะแนนของผูเ้รียนท่ีไดจ้ากการท าแบบฝึกหดัระหวา่งเรียน คะแนน
ดงักล่าวตอ้งไปต ่ากวา่ 85% ของคะแนนเตม็ 

×100 N 
   100 

×100 B 
   100 
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      ดชันีประสิทธิผล = 

 E2 ตวัหลงั หมายถึง คะแนนท่ีแสดงถึงความสามารถของกระบวนการ ท าใหเ้กิด 
การเรียนรู้ไดจ้ากค่าเฉล่ียของคะแนนของผูเ้รียนท่ีไดจ้ากการท าแบบทดสอบหลงัเรียน  
ซ่ึงตอ้งไม่ต ่ากวา่ 85% ของคะแนนเตม็ 
 ∑X  คือ คะแนนรวมของแบบฝึกปฏิบติักิจกรรมหรืองานท่ีท าระหวา่งเรียน ทั้งท่ี 
เป็นกิจกรรมในห้องเรียน นอกหอ้งเรียนหรือออนไลน์ 
 ∑f  คือ คะแนนรวมของผลลพัธ์ของการประเมินหลงัเรียน 
    N  คือ จ านวนผูเ้รียน 
    A  คือ คะแนนเตม็ของแบบทดสอบทา้ยบท 
    B  คือ คะแนนเตม็ของแบบทดสอบหลงัเรียน 
 5.2 หาค่าดชันีประสิทธิผลของบทเรียนออนไลน์ กลุ่มสาระการเรียนรู้การงานอาชีพ 
และเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียน 
ชั้นประถมศึกษาปีท่ี 6 โดยใชสู้ตร ดงัน้ี (บุญชม ศรีสะอาด, 2545) 
 
                     ผลรวมของคะแนนทดสอบหลงัเรียน-ผลรวมของคะแนนทดสอบก่อนเรียน 
                (จ  านวนผูน้กัเรียนxคะแนนเตม็)-ผลรวมของคะแนนทดสอบก่อนเรียน 
 
 5.3 ประเมินความพึงพอใจของผูเ้รียนต่อบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระ
การเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip 
album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 โดยก าหนดเกณฑก์ารประเมินเป็นแบบช่วงคะแนน  
5 ระดบั (Best & Kahn, 1993)  
 ระดบั 5 หมายถึง  มีความพึงพอใจ มากท่ีสุด 
           ระดบั 4 หมายถึง  มีความพึงพอใจ มาก 
           ระดบั 3 หมายถึง  มีความพึงพอใจ ปานกลาง 
           ระดบั 2 หมายถึง  มีความพึงพอใจ นอ้ย 
          ระดบั 1 หมายถึง  มีความพึงพอใจ นอ้ยท่ีสุด 
           จากนั้น น าแบบประเมินบทเรียนมาหาค่าเฉล่ีย โดยก าหนดค่าคะแนนในการแปลผล    
(บุญชม ศรีสะอาด และบุญส่ง นิลแกว้, 2535) 
          ค่าเฉล่ีย 4.51-5.00  หมายถึง  มีความพึงพอใจมากท่ีสุด 
           ค่าเฉล่ีย 3.51-4.50  หมายถึง  มีความพึงพอใจมาก 
           ค่าเฉล่ีย 3.51-3.50  หมายถึง  มีความพึงพอใจปานกลาง 
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                 N 

              N (N-1) 

           ค่าเฉล่ีย 1.51-2.50  หมายถึง  มีความพึงพอใจนอ้ย 
           ค่าเฉล่ีย 1.00-1.50  หมายถึง  มีความพึงพอใจมากท่ีสุด 
 และน าคะแนนในการท าแบบประเมินบทเรียนมาหาค่าเฉล่ียโดยใชสู้ตร ดงัน้ี 
(บุญชม ศรีสะอาด, 2545) 
   X̅ =∑X 
   
                               X̅ คือ    คะแนนเฉล่ีย 
  ∑X   แทน ผลรวมของคะแนนทั้งหมด 
       N   แทน จ านวนของนกัเรียนทั้งหมด 
 ค่าส่วนเบ่ียงเบนมาตรฐาน ใชสู้ตร ดงัน้ี (บุญชม ศรีสะอาด, 2545) 
 

    SD = √  N ∑X2- (∑X)2 
    
    SD คือ   ค่าเบ่ียงเบนมาตรฐาน 
   ∑X แทน ผลรวมคะแนนทั้งหมด 
   ∑X2 แทน ผลรวมคะแนนทั้งหมดก าลงัสอง 
      N   แทน จ านวนนกัเรียน 
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บทที ่4 
ผลการวเิคราะห์ข้อมูล 

 
 การวจิยั เพื่อพฒันาบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพ
และเทคโนโลย ี เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียน
ชั้นประถมศึกษาปีท่ี 6 ผูว้จิยัไดน้ าเสนอการวเิคราะห์ขอ้มูล ดงัน้ี 
 ตอนท่ี 1 ลกัษณะของบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้ 
การงานอาชีพและเทคโนโลยี เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album 
ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6   
 ตอนท่ี 2 ผลการวเิคราะห์เพื่อหาประสิทธิภาพของบทเรียนออนไลน์แบบผสมผสาน 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ตามเกณฑม์าตรฐาน 85/ 85      
             ตอนท่ี 3 ผลการวเิคราะห์เพื่อหาดชันีประสิทธิผล (EI) ของการเรียนดว้ยบทเรียน
ออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสือ
อิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6   
             ตอนท่ี 4 ผลการวเิคราะห์เพื่อหาความพึงพอใจของการเรียนดว้ยบทเรียนออนไลน์ 
แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสือ
อิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6   
 

ตอนที ่1 ลกัษณะของบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้ 
การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนังสืออเิลก็ทรอนิกส์ด้วยโปรแกรม  
Flip album ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6   
 บทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี 
เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษา  
ปีท่ี 6 ประกอบดว้ย การแนะน าบทเรียน แบบทดสอบก่อนเรียน เน้ือหาบทเรียนออนไลน์ กิจกรรม
ในบทเรียนออนไลน์และกิจกรรมในชั้นเรียนแบบปกติ การท าแบบทดสอบระหวา่งเรียน  
ช่องทางการติดต่อส่ือสารระหวา่งครูผูส้อนกบันกัเรียนผา่นทางออนไลน์ การส่งงานทางออนไลน์  
การน าเสนองานในชั้นเรียนและการท าแบบทดสอบหลงัเรียน มีลกัษณะ ดงัน้ี 



66 
 

 
 

 1. การแนะน าบทเรียน แจง้จุดประสงคก์ารเรียนรู้ ผูว้จิยัไดน้ าเสนอการแนะน าบทเรียน 
ผา่นทาง Google site มีการน าเสนอในรูปแบบของขอ้ความและรูปภาพ 
 2. แบบทดสอบก่อนเรียน เป็นแบบทดสอบแบบปรนยั จ านวน 30 ขอ้ น าเสนอ 
ผา่นทาง Google form 
 3. เน้ือหาของบทเรียน แบ่งออกเป็น 5 หน่วยการเรียนรู้ น าเสนอในรูปแบบ 
ของมลัติมีเดีย ประกอบดว้ย ขอ้ความ ภาพและวดิีโอ กระบวนการเรียนรู้ คือ ตั้งค  าถามเพื่อเร้า 
ความสนใจ จากนั้นศึกษาเน้ือหาจากแหล่งเรียนรู้จาก Google site ซ่ึงเป็นทั้งขอ้ความ และ VDO    
ท าแบบฝึกหดัในแต่ละหน่วยการเรียนรู้ ผา่นทาง Google form และท าแบบทดสอบหลงัเรียนแบบ
ปรนยั จ านวน 30 ขอ้ ผา่นทาง Google form 
 4. นกัเรียนสามารถเลือกยอ้นกลบัไปทบทวนเน้ือหาได ้

 ตวัอยา่งรายละเอียดของบทเรียนออนไลน ์ดงัภาพท่ี 4-1 ถึง ภาพท่ี 4-6 

 
ภาพท่ี 4-1 แนะน าบทเรียน                                 
                                    
 
 

 
 
 
 



67 
 

 
 

 
ภาพท่ี 4-2 หนา้ค าถามกระตุน้ความคิด เร้าความสนใจ 

 
ภาพท่ี 4-3 แบบทดสอบก่อนเรียน 
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ภาพท่ี 4-4 เน้ือหาบทเรียน ประกอบดว้ย ขอ้ความ ภาพ วีดิโอ 
 

 
ภาพท่ี 4-5 หนา้จอการท ากิจกรรมบนบทเรียนออนไลน์ 
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ภาพท่ี 4-6 หนา้จอแบบทดสอบหลงัเรียน 
 
 5. กิจกรรมการเรียนแบบปกติ ประกอบดว้ย 
  5.1 ทบทวนความรู้จากการเรียนดว้ยบทเรียนออนไลน์ 
  5.2 มอบหมายใบงาน อภิปรายกลุ่ม 
  5.3 น าเสนองานหนา้ชั้นเรียน 
  5.4 ครูใหค้  าแนะน าและสรุปองคค์วามรู้ 
  5.5 ท าแบบทดสอบประจ าหน่วย 
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ตอนที ่2 ผลการวเิคราะห์เพ่ือหาประสิทธิภาพของบทเรียนออนไลน์แบบผสมผสาน 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนังสืออเิลก็ทรอนิกส์
ด้วยโปรแกรม Flip album ส าหรับนักเรียนช้ันประถมศึกษาปีที่ 6 ตามเกณฑ์มาตรฐาน 
85 /85      
 ผลการวเิคราะห์เพื่อหาประสิทธิภาพของบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระ 
การเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม  
Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ตามเกณฑม์าตรฐาน 85/ 85 มีรายละเอียดดงั
ตารางท่ี 4-1     

 
ตารางท่ี 4-1 ผลประสิทธิภาพของบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้ 
       การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม  
       Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ในการทดลองกบักลุ่มเป้าหมาย 
 

ลกัษณะของคะแนน คะแนนเต็ม คะแนนเฉลีย่ SD ร้อยละ 
ค่าระดับ

ประสิทธิภาพ 
คะแนนระหวา่งเรียน 30 25.87 1.36 86.22 86.22/86.44 
คะแนนหลงัเรียน 30 25.93 1.57 86.44 

 
 จากตารางท่ี 4-1 พบวา่ ผลการทดสอบประสิทธิภาพบทเรียนออนไลน์แบบผสมผสาน  
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ไดจ้  านวนร้อยละของคะแนน
เฉล่ียของการทดสอบหลงัเรียน เท่ากบั 86.44 และจ านวนร้อยละของผูเ้รียนท่ีสามารถ 
ท าแบบทดสอบผา่นทุกจุดประสงค ์เท่ากบั 86.22 สรุปไดว้า่ บทเรียนออนไลน์แบบผสมผสาน 
ท่ีผูว้จิยัไดพ้ฒันาข้ึน มีประสิทธิภาพเป็นไปตามเกณฑท่ี์ก าหนดไว ้
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ตอนที ่3 ผลการวเิคราะห์เพ่ือหาดัชนีประสิทธิผล (EI) ของการเรียนด้วยบทเรียน
ออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี 
เร่ือง การสร้างหนังสืออเิลก็ทรอนิกส์ด้วยโปรแกรม Flip album ส าหรับนักเรียน 
ช้ันประถมศึกษาปีที ่6   
 ผลการวเิคราะห์เพื่อหาดชันีประสิทธิผล (EI) ของการเรียนดว้ยบทเรียนออนไลน์แบบ
ผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 รายละเอียดดงัตารางท่ี 4-2 
 
ตารางท่ี 4-2 ผลการวเิคราะห์เพื่อค่าดชันีประสิทธิผลของบทเรียนออนไลน์แบบผสมผสาน 
       กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสือ 
         อิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
 

รายการ N 
ผลรวมคะแนนทดสอบ ค่าเฉลีย่ ผลต่าง 

ของคะแนน 
ดชันี

ประสิทธิผล ก่อนเรียน หลงัเรียน ก่อนเรียน หลงัเรียน 
ผลสมัฤทธ์ิ
ทางการเรียน 

30 378 753 12.6 25.1 375 0.72 

  
 จากตารางท่ี 4-2 พบวา่ค่าดชันีประสิทธิผล (Effectiveness index: E.I.) ของความกา้วหนา้
ทางพฒันาการของผูเ้รียนมีค่าเท่ากบั 0.72 หรือคิดเป็นร้อยละ 72 แสดงวา่ ผูเ้รียนมีความกา้วหนา้
ทางพฒันาการเรียนรู้เพิ่มข้ึน ร้อยละ 72 
 

ตอนที ่4 ผลการวเิคราะห์เพ่ือหาความพงึพอใจของการเรียนด้วยบทเรียนออนไลน์ 
แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนังสือ
อเิลก็ทรอนิกส์ด้วยโปรแกรม Flip album ส าหรับนักเรียนช้ันประถมศึกษาปีที่ 6   
 ผลการวเิคราะห์เพื่อหาความพึงพอใจของการเรียนดว้ยบทเรียนออนไลน์แบบผสมผสาน 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 โดยมีรายละเอียดดงัตารางท่ี 4-3  
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ตารางท่ี 4-3 ผลการประเมินค่าความพึงพอใจของผูเ้รียนต่อบทเรียนออนไลน์แบบผสมผสาน 
        กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสือ       
        อิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
 

ข้อ รายการประเมนิ 
ระดบัความพงึพอใจ 

ค่าเฉลีย่ SD เกณฑ์การประเมนิ 
ดา้นท่ี 1 ดา้นเน้ือหาและการด าเนินเร่ือง    

1 เน้ือหาตรงกบัความตอ้งการในการเรียนรู้  
เร่ือง การสร้างหนงัสืออิเลก็ทรอนิกส์ดว้ยโปรแกรมอยา่งง่าย 

4.43 0.50 มาก 

2 มีความเขา้ใจเน้ือหาการเรียนจากบทเรียนออนไลน ์
แบบผสมผสาน 

4.40 0.66 มาก 

3 สามารถเรียนรู้เน้ือหาจากบทเรียนออนไลน์แบบผสมผสาน 
ไดด้ว้ยตนเอง 

4.47 0.50 มาก 

4 สามารถอ่านและท าความเขา้ใจในบทเรียนออนไลน ์
แบบผสมผสาน 

4.23 0.72 มาก 

5 บทเรียนออนไลน์แบบผสมผสาน ใหค้วามรู้เก่ียวกบัเน้ือหา 
ไดเ้ช่นเดียวกบัส่ือประเภทอ่ืน ๆ 

4.17 0.69 มาก 

ดา้นท่ี 2 ดา้นภาพ ภาษา และเสียง    
6 ความชดัเจนของภาพประกอบท่ีใชใ้นบทเรียน 4.67 0.47 มากท่ีสุด 
7 ความเหมาะสมของภาพเคล่ือนไหวท่ีใชใ้นบทเรียน 4.77 0.42 มากท่ีสุด 
8 ความถูกตอ้งของภาษาท่ีใช ้ 4.63 0.48 มากท่ีสุด 
9 ความเหมาะสมของเสียงดนตรี 4.70 0.64 มากท่ีสุด 
10 ความเหมาะสมของเสียงบรรยาย 4.17 0.90 มาก 
11 ความเหมาะสมของการออกแบบกรอบภาพ 4.87 0.34 มากท่ีสุด 
12 ความสมัพนัธ์ระหวา่งภาพกบัภาษาและเสียง 4.60 0.49 มากท่ีสุด 
ดา้นท่ี 3 ดา้นตวัอกัษรและส่ือ    
13 ความเหมาะสมของแบบตวัอกัษร 4.67 0.47 มากท่ีสุด 
14 ความเหมาะสมของขนาดตวัอกัษร 4.37 0.66 มาก 
15 ความเหมาะสมของการเลือกใชสี้ตวัอกัษร 4.77 0.42 มากท่ีสุด 
16 บทเรียนออนไลน์แบบผสมผสานท าใหผู้เ้รียนมีความรู้ในการ

เรียนรู้เร่ือง การใชอิ้นเทอร์เน็ต 
4.60 0.49 มากท่ีสุด 
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ตารางท่ี 4-3 (ต่อ) 
 

ข้อ รายการประเมนิ 
ระดบัความพงึพอใจ 

ค่าเฉลีย่ SD เกณฑ์การประเมนิ 
ดา้นท่ี 3 ดา้นตวัอกัษรและส่ือ    
17 บทเรียนออนไลน์แบบผสมผสานท าใหมี้ความต่ืนเตน้และมี

ความเร้าใจ 
4.50 0.76 มาก 

18 บทเรียนออนไลน์แบบผสมผสานท าใหรู้้จกัช่วยตนเองในการ
เรียนมากข้ึน 

4.90 0.30 มากท่ีสุด 

19 บทเรียนออนไลน์แบบผสมผสานท าใหเ้อาใจใส่ต่อการเรียน
มากข้ึน 

4.77 0.56 มากท่ีสุด 

20 บทเรียนออนไลน์แบบผสมผสานใหท้ั้งความรู้และความ
เพลิดเพลิน 

4.93 0.25 มากท่ีสุด 

 ภาพรวม 4.58 0.54 มากท่ีสุด 

 
 จากตารางท่ี 4-3 พบวา่ ความพึงพอใจของนกัเรียนท่ีมีต่อบทเรียนออนไลน์แบบผสมผสาน
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ในภาพรวม อยูใ่นระดบัมากท่ีสุด            
( X = 4.58, SD = 0.54) 
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บทที ่5 
 สรุปผล อภิปรายผล และข้อเสนอแนะ 

 

 การวจิยัในคร้ังน้ี เป็นการสร้างและพฒันาพฒันาบทเรียนออนไลน์แบบผสมผสาน 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 มีขั้นตอนในการด าเนินการ 
และสรุปผลการวจิยั ดงัน้ี  
 

วตัถุประสงค์ของการวจิัย  
 1. เพื่อพฒันาบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพ 
และเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียน 
ชั้นประถมศึกษาปีท่ี 6 ใหมี้ประสิทธิภาพตามเกณฑ ์E1/ E2 เท่ากบั 85/ 85 
 2. เพื่อหาดชันีประสิทธิผล (EI) ของการเรียนดว้ยบทเรียนออนไลน์แบบผสมผสาน              
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
 3. เพื่อศึกษาความพึงพอใจของนกัเรียนต่อการใชบ้ทเรียนออนไลน์แบบผสมผสาน 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
 

วธิีการด าเนินการวจิัย 
 ในการด าเนินการวจิยั  ผูว้จิยัไดด้ าเนินการตามขั้นตอน ADDIE ดงัน้ี 
 1. ขั้นตอนการวิเคราะห์ (A: Analysis) 
 2. ขั้นตอนการออกแบบ (D: Design) 
 3. ขั้นตอนการพฒันา (D: Development) 
 4. ขั้นตอนการทดลอง (I: Implementation) 
 5. ขั้นตอนการประเมินผล (E: Evaluation) 
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เคร่ืองมือทีใ่ช้ในการวจิัย 
 บทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี
เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษา 
ปีท่ี 6 ประกอบดว้ย 
 1. แบบทดสอบก่อนเรียน-หลงัเรียน  
 2. แบบวดัความพึงพอใจของนกัเรียนต่อการใชบ้ทเรียนออนไลน์แบบผสมผสาน  
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
 

การวเิคราะห์ข้อมูล 
 1. ทดสอบประสิทธิภาพประสิทธิภาพตามเกณฑ ์E1/ E2 เท่ากบั 85/ 85 โดยใชสู้ตร 
การทดสอบประสิทธิภาพ 
 2. วเิคราะห์หาค่าดชันีประสิทธิผลของบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระ 
การเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม  
Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 โดยใชสู้ตรการหาค่าดชันีประสิทธิผล 
 3. วเิคราะห์หาค่าความพึงพอใจของผูเ้รียนต่อบทเรียนออนไลน์แบบผสมผสาน 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 โดยหาค่าเฉล่ียและส่วนเบ่ียงเบน
มาตรฐาน  
 

สรุปผลการวจิัย 
 การวจิยัในคร้ังน้ี เป็นการสร้างและพฒันาบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระ
การเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ืองการสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม 
อยา่งง่าย ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 สามารถสรุปได ้ดงัน้ี 
 1. บทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี
เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษา 
ปีท่ี 6 ท่ีผูว้จิยัสร้างข้ึน มีประสิทธิภาพ E1/ E2 เท่ากบั 86.22/ 86.44 เป็นไปตามเกณฑม์าตรฐาน  
E1/ E2 (85/ 85) ท่ีก าหนดไว ้
 2. ผลการวเิคราะห์เพื่อค่าดชันีประสิทธิผลของบทเรียนออนไลน์แบบผสมผสาน 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
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ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 มีค่าเท่ากบั 0.72 หรือ คิดเป็น 
ร้อยละ 72 แสดงวา่ ผูเ้รียนมีความกา้วหนา้ทางพฒันาการเรียนรู้เพิ่มข้ึน ร้อยละ 72 
 3. ผลการศึกษาความพึงพอใจของนกัเรียนท่ีมีต่อบทเรียนออนไลน์แบบผสมผสาน 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 พบวา่ นกัเรียนชั้นประถมศึกษา 
ปีท่ี 6 ท่ีไดใ้ชบ้ทเรียนออนไลน์แบบผสมผสาน มีความพึงพอใจอยูใ่นระดบั “มากท่ีสุด” 
 

อภิปรายผล  
 จากกการวจิยัสามารถอภิปรายผลการศึกษาได ้ดงัน้ี  
 1. ผลการทดสอบประสิทธิภาพของบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระ 
การเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม  
Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 พบวา่ มีประสิทธิภาพ 86.22/86.44 ซ่ึง 
เป็นไปตามเกณฑท่ี์ก าหนดไว ้เพราะผูว้ิจยัไดย้ดึหลกัการออกแบบและพฒันาตามล าดบัขั้นตอน 
ทางวชิาการ (ไชยยศ เรืองสุวรรณ, 2554) โดยมีล าดบัขั้น ดงัน้ี 1) ขั้นวเิคราะห์ (Analyze)  
2) ขั้นออกแบบ (Design) 3) ขั้นพฒันา (Develop)  4) ขั้นน าไปใช ้ (Implement) และ 5) ขั้นประเมิน
และปรับปรุงแกไ้ข (Evaluate) โดยทุกขั้นตอนไดผ้า่นการตรวจสอบและปรับปรุงแกไ้ข  
ตามขอ้เสนอแนะของอาจารยผ์ูค้วบคุมวทิยานิพนธ์และผูเ้ช่ียวชาญ ช่วยประเมินคุณภาพ 
ของเคร่ืองมือ ใหมี้คุณภาพท่ีเหมาะสมและถูกตอ้ง ก่อนน าไปใชท้ดลองกบักลุ่มตวัอยา่งจริง  
ซ่ึงบทเรียนผสมผสาน เป็นการสอนท่ีตอ้งอาศยัส่ือการเรียนการสอน เพื่อเป็นการสร้างรูปแบบ 
ใหเ้หมาะสมกบัผูเ้รียน (เจษฎา เมฆะสุวรรณโรจน์, 2549) ทั้งน้ี การเรียนแบบผสมผสานนั้น  
จะเป็นการดึงคุณสมบติัเด่นของการเรียนในชั้นเรียนและการเรียนการสอนบนเวบ็ โดยค านึงถึง
ความเหมาะสมและคุณสมบติัของผูเ้รียนเป็นส าคญั จึงท าใหไ้ดบ้ทเรียนแบบผสมผสาน  
ท่ีมีประสิทธิภาพสูงกวา่เกณฑท่ี์ก าหนด ซ่ึงสอดคลอ้งกบังานวจิยัของ นพรัตน์ พลเสน (2557)  
ไดส้ร้างและหาประสิทธิภาพของบทเรียนแบบผสมผสาน เร่ือง ประวติัศาสตร์กรุงศรีอยุธยา         
ส าหรับนกัเรียนชั้นมธัยมศึกษาปีท่ี 2 โรงเรียนบา้นหนองมะสัง มีค่าเท่ากบั 85.78/ 84.22  
เป็นไปตามเกณฑท่ี์ตั้งไว ้ 
 2. ผลการศึกษาพบวา่ ค่าดชันีประสิทธิผล (Effectiveness Index: E.I.) ของความกา้วหนา้
ทางพฒันาการของผูเ้รียน มีค่าเท่ากบั 0.72  หรือคิดเป็นร้อยละ 72 แสดงวา่ผูเ้รียนมีความกา้วหนา้
ทางพฒันาการเรียนรู้เพิ่มข้ึน ร้อยละ 72 เพราะบทเรียนแบบผสมผสาน เป็นการเรียนท่ีมี 
การน าเสนอเน้ือหาวชิาโดยผสมผสานวธีิเรียนบนเวบ็และวธีิพบปะในชั้นเรียน สัดส่วน ร้อยละ  
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50-50 มีการน าเสนอเน้ือหาผา่นอินเทอร์เน็ตและบางส่วนน าเสนอในชั้นเรียน ซ่ึงเป็นการดึง
คุณสมบติัเด่นของการเรียนในชั้นเรียนและการเรียนบนเวบ็ โดยค านึงถึงความเหมาะสม 
และคุณสมบติัของผูเ้รียนเป็นส าคญั โดยบทเรียนออนไลน์แบบผสมผสานท่ีผูว้จิยัไดส้ร้างข้ึน  
ยงัมีการน าเสนอเน้ือหาท่ีชดัเจน เขา้ใจง่าย น่าสนใจ นกัเรียนสามารถกลบัไปทบทวนเน้ือหาได้
ตลอดเวลาและสามารถติดต่อกบัผูส้อนผา่นบทเรียนได ้เม่ือมีปัญหาหรือขอ้สงสัยต่าง ๆ ดงัท่ี 
Cottrell & Robison (2003); Bonk & Graham (2006) ไดก้ล่าววา่ บทเรียนบนเวบ็จะช่วยใหน้กัเรียน
ไดศึ้กษาขอ้มูลและเน้ือหาการเรียน ตลอดจนฝึกทกัษะต่าง ๆ ท่ีจ  าเป็น และใชเ้วลาท่ีมีค่าในชั้นเรียน 
นกัเรียนไดรั้บการพฒันาทกัษะการคิดและการตดัสินใจแกปั้ญหา  ซ่ึงสอดคลอ้งกบังานวจิยั 
ของ จิตรลดา ยงุไธสง (2558) ท่ีไดพ้ฒันาบทเรียนออนไลน์แบบผสมผสาน (Blended learning)   
รายวชิาศาสนศึกษา ส30101 ชั้นมธัยมศึกษาปี 4 ผลการศึกษา พบวา่ ค่าดชันีประสิทธิผล 
ของบทเรียนมีค่าเท่ากบั 0.69 แสดงวา่ นกัเรียนมีการพฒันาทางการเรียนสูงข้ึน คิดเป็น ร้อยละ 69 
 3. ผลการศึกษาความพึงพอใจ พบวา่ นกัเรียนท่ีเรียนบทเรียนออนไลน์แบบผสมผสาน 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 มีความพึงพอใจอยูใ่นระดบัมาก
ท่ีสุด เพราะการเรียนดว้ยบทเรียนออนไลน์แบบผสมผสาน เป็นการเรียนเน้ือหาในชั้นเรียนปกติ
ร่วมกบัการเรียนการสอนบนเวบ็ ท่ีค  านึงถึงความแตกต่างระหวา่งบุคคลของนกัเรียน ท่ีมีบรรยากาศ 
การเรียนไม่ตึงเครียด นกัเรียนสามารถเรียนไดต้ลอดเวลา มีเน้ือหาท่ีชดัเจน เขา้ใจง่าย  
มีการน าเสนอท่ีน่าสนใจ มีกราฟิก ภาพเคล่ือนไหว ภาพน่ิง ท่ีสอดคลอ้งกบัเน้ือหา ตวัหนงัสือ 
มีความเหมาะสม อ่านง่าย ท าใหผู้เ้รียนมีความสุขในการเรียน สอดคลอ้งกบัผลการวจิยั  
สุทธิพงศ ์ยอดเสาดี (2553) ไดศึ้กษาผลการพฒันาบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระ 
การเรียนรู้งานอาชีพและเทคโนโลย ีเร่ือง เทคโนโลยสีารสนเทศและคอมพิวเตอร์ ส าหรับนกัเรียน
ชั้นมธัยมศึกษาปีท่ี 1 พบวา่ นกัเรียนชั้นมธัยมศึกษาปีท่ี 1 มีความคิดเห็นต่อการเรียนดว้ยกลุ่มสาระ
การเรียนรู้งานอาชีพและเทคโนโลย ีเร่ือง เทคโนโลยสีารสนเทศและคอมพิวเตอร์ ส าหรับนกัเรียน
ชั้นมธัยมศึกษาปีท่ี 1 อยูใ่นระดบัมาก  
 

ข้อเสนอแนะ 
 จากการสร้างการพฒันาบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้ 
การงานอาชีพและเทคโนโลยี เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album 
ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ตามท่ีเสนอไปแลว้ขา้งตน้ ผูว้ิจยัมีขอ้เสนอแนะ ดงัต่อไปน้ี 
 



78 
 

 ข้อเสนอแนะในการน าไปใช้ 
 1. บทเรียนออนไลน์แบบผสมผสานท่ีพฒันาข้ึน ท าใหผู้เ้รียนมีทกัษะในการเรียนรู้ 
ดว้ยตนเอง มีความกระตือรือร้นในการเรียนมากข้ึน เน่ืองจากบทเรียนออนไลน์แบบผสมผสาน 
มีกิจกรรมท่ีหลากหลายทั้งในออนไลน์และแบบเผชิญหนา้ ใหผู้เ้รียนไดแ้สวงหาความรู้ดว้ยตนเอง 
และยงัใหผ้ลตอบกลบัผูเ้รียนในทนัทีอีกดว้ย ดงันั้น ในการน าบทเรียนไปใชง้าน ครูผูส้อนควรจะ
จดักิจกรรมการเรียนรู้แบบผสมผสาน ใชส่ื้อมลัติมีเดียในการน าเสนอเน้ือหา มีกิจกรรมการเรียนรู้
ทั้งในออนไลน์และแบบเผชิญหนา้ ซ่ึงจะท าใหป้ระสบความส าเร็จตามวตัถุประสงคใ์นการสอน 
และน าบทเรียนออนไลน์แบบผสมผสานท่ีพฒันาข้ึน ไปเป็นตน้แบบในการจดักิจกรรมในรายวชิา
อ่ืน ๆ ต่อไป 
 2. บทเรียนออนไลน์แบบผสมผสานท่ีพฒันาข้ึน ท าใหผู้เ้รียนมีความกลา้แสดงออก 
ในการซกัถามมากข้ึน เน่ืองจากบทเรียนออนไลน์แบบผสมผสาน ไดมี้ช่องทางการติดต่อส่ือสาร 
กบันกัเรียน ท าใหน้กัเรียนมีความกลา้ท่ีจะซกัถาม กลา้ท่ีจะตอบค าถาม ดงันั้น ในการน าบทเรียน 
ไปใชง้านในรายวชิาอ่ืน ๆ ควรจะมีช่องการติดต่อซกัถามขอ้สงสัยผา่นทางออนไลน์ดว้ย 
 ข้อเสนอแนะในการวจัิยคร้ังต่อไป 
 1. ควรมีการพฒันาบทเรียนออนไลน์แบบผสมผสานในเน้ือหาสาระอ่ืน ๆ ท่ีตอ้งการให้
ผูเ้รียนเกิดการเรียนรู้ดว้ยตนเอง 
 2. ควรมีการพฒันาบทเรียนคอมพิวเตอร์ท่ีมีลกัษณะเฉพาะ เช่น บทเรียนออนไลน์ 
แบบผสมผสานตามแนวคิดของกาเย ่หรือบทเรียนออนไลน์แบบผสมผสานโดยใชปั้ญหาเป็นฐาน 
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ภาคผนวก ก 
รายช่ือผูเ้ช่ียวชาญส าหรับการพิจารณาคุณภาพของเคร่ืองมือ 
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รายช่ือผู้เช่ียวชาญตรวจสอบคุณภาพเคร่ืองมือทีใ่ช้ในการวจัิย 
 1. ดร.ฐิติชยั รักบ ารุง           อาจารยป์ระจ าภาควชิานวตักรรมและเทคโนโลยกีารศึกษา  
             คณะศึกษาศาสตร์ มหาวทิยาลยับูรพา 
 2. ดร.ณฐาภพ สมคิด          อาจารยป์ระจ าภาควชิานวตักรรมและเทคโนโลยกีารศึกษา  
              คณะศึกษาศาสตร์ มหาวทิยาลยับูรพา 
 3. ดร.แสงทอง บุญยิง่         อาจารยป์ระจ าภาควชิานวตักรรมและเทคโนโลยกีารศึกษา  
             คณะศึกษาศาสตร์ มหาวทิยาลยับูรพา 
 4. ดร.สมพล เขม็ก าเนิด      อาจารยป์ระจ าภาควชิานวตักรรมและเทคโนโลยกีารศึกษา 
                คณะศึกษาศาสตร์ มหาวทิยาลยับูรพา 
 5. ดร.นราวชิญ ์ศรีเปารยะ  อาจารยป์ระจ าภาควชิานวตักรรมและเทคโนโลยกีารศึกษา   
            คณะศึกษาศาสตร์ มหาวทิยาลยับูรพา  
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ภาคผนวก ข 
การพฒันาบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี

เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album 
ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
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           การทดสอบประสิทธิภาพ บทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้ 
การงานอาชีพและเทคโนโลยี เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album 
ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 เพื่อพฒันาและแกไ้ขขอ้บกพร่องของบทเรียน จากนั้น 
จึงน าไปทดลองใชก้บัผูเ้รียนท่ีเป็นกลุ่มตวัอยา่ง เพื่อหาประสิทธิภาพตามเกณฑม์าตรฐาน 85/85 
โดยมีรายละเอียดดงัตารางท่ี ข-1 ถึง ตารางท่ี ข-4 
 
ตารางท่ี ข-1 คะแนนการทดสอบประสิทธิภาพบทเรียนออนไลน์แบบผสมผสาน 
     กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสือ 
     อิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
     แบบเด่ียว 3 คน 
 

คนที่ คะแนนกจิกรรม (30 คะแนน) คะแนนหลังเรียน (30 คะแนน) 
1 23 24 
2 16 13 
3 21 19 

รวม 60 56 
ค่าเฉล่ีย 22 21.5 
ร้อยละ 66.67 62.22 

ประสิทธิภาพ E1/ E2 = 66.67/ 62.22 
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ตารางท่ี ข-2 คะแนนการทดสอบประสิทธิภาพบทเรียนออนไลน์แบบผสมผสาน 
     กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสือ 
     อิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  
    แบบกลุ่มยอ่ย 10 คน 
 

คนที่ คะแนนกจิกรรม (30 คะแนน) คะแนนหลังเรียน (30 คะแนน) 

1 21 20 
2 20 24 
3 24 25 
4 23 24 
5 24 25 
6 16 20 
7 19 23 
8 20 23 
9 25 25 

10 23 25 
รวม 215 234 

ค่าเฉล่ีย 21.5 24 
ร้อยละ 71.67 78.00 

ประสิทธิภาพ E1/ E2 = 71.67/ 78.00 
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ตารางท่ี ข-3 คะแนนการทดสอบประสิทธิภาพบทเรียนออนไลน์แบบผสมผสาน 
     กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสือ 
     อิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  
    แบบกลุ่มยอ่ย 30 คน 

 

คนที่ คะแนนกจิกรรม (30 คะแนน) คะแนนหลังเรียน (30 คะแนน) 

1 22 21 
2 22 21 
3 28 25 
4 24 23 
5 24 25 
6 21 23 
7 23 24 
8 26 28 
9 25 23 

10 24 23 
11 22 24 
12 21 23 
13 26 25 
14 25 26 
15 23 24 
16 22 23 
17 26 27 
18 23 25 
19 27 28 
20 26 26 
21 25 27 
22 25 27 
23 24 23 
24 24 23 
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ตารางท่ี ข-3 (ต่อ)  
 

คนที่ คะแนนกจิกรรม (30 คะแนน) คะแนนหลังเรียน (30 คะแนน) 

25 27 26 
26 26 27 
27 25 28 
28 23 25 
29 24 25 
30 25 23 
รวม 724 738 

ค่าเฉล่ีย 24.13 24.60 
ร้อยละ 80.44 82.00 

ประสิทธิภาพ E1/ E2 = 80.44/ 82.00 
 

ตารางท่ี ข-4 คะแนนการทดสอบประสิทธิภาพบทเรียนออนไลน์แบบผสมผสาน 
     กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสือ 
     อิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  
    โดยทดลองกบักลุ่มตวัอยา่งจ านวน 30 คน 

 

คนที่ คะแนนกจิกรรม (30 คะแนน) คะแนนหลังเรียน (30 คะแนน) 

1 27 27 
2 28 26 
3 28 28 
4 25 27 
5 28 29 
6 25 26 
7 25 27 
8 24 25 
9 25 24 
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ตารางท่ี ข-4 (ต่อ) 
 

คนที่ คะแนนกจิกรรม (30 คะแนน) คะแนนหลังเรียน (30 คะแนน) 

10 24 25 
11 26 26 
12 27 25 
13 26 27 
14 24 27 
15 24 24 
16 25 27 
17 26 26 
18 27 28 
19 26 25 
20 27 25 
21 24 23 
22 25 24 
23 25 26 
24 25 27 
25 28 29 
26 26 26 
27 26 23 
28 25 24 
29 27 26 
30 28 26 
รวม 776 778 

ค่าเฉล่ีย 25.87 25.93 
SD 1.36 1.57 

ร้อยละ 86.22 86.44 
ประสิทธิภาพ E1/ E2 = 86.22/ 86.44 
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ภาคผนวก ค 
แบบประเมินบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี

เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียน 
ชั้นประถมศึกษาปีท่ี 6 และผลการประเมินโดยผูเ้ช่ียวชาญ 
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แบบประเมินบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี 
เร่ือง การสร้างหนังสืออิเลก็ทรอนิกส์ด้วยโปรแกรม Flip album  

ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6 
 
ค าช้ีแจง โปรดเขียนเคร่ืองหมาย  ลงในช่องตามความคิดเห็นของท่าน โดยมีเกณฑ์การเลือก ดงัน้ี 
 ดีมาก หมายถึง บทเรียนออนไลน์แบบผสมผสานมีคุณภาพดีมาก 
 ดี หมายถึง บทเรียนออนไลน์แบบผสมผสานมีคุณภาพดี 
 ปานกลาง หมายถึง บทเรียนออนไลน์แบบผสมผสานมีคุณภาพปานกลาง 
 นอ้ย หมายถึง บทเรียนออนไลน์แบบผสมผสานมีคุณภาพนอ้ย 
 นอ้ยท่ีสุด หมายถึง บทเรียนออนไลน์แบบผสมผสานมีคุณภาพนอ้ยท่ีสุด 
 

รายการ 
ระดับความคิดเห็น 

ดีมาก ดี ปานกลาง น้อย น้อยทีสุ่ด 
1 เน้ือหาสอดคลอ้งกบัวตัถุประสงค ์      
2 เน้ือหามีความถูกตอ้ง      
3 ภาพประกอบสอดคลอ้งกบัเน้ือหา      
4 มีการด าเนินบทเรียนท่ีน่าสนใจ      
5 เน้ือหามีความเหมาะสมกบัระดบัผูเ้รียน      
6 มีการล าดบัเน้ือหาในบทเรียน      
7 ปริมาณเน้ือหามีความเหมาะสม      
8 ใชภ้าษาท่ีเขา้ใจง่าย      
9 กิจกรรมง่ายต่อการเรียนรู้      

10 จ านวนแบบฝึกหดัมีความเหมาะสม      
11 ความเหมาะสมของภาพและเสียง      
12 เน้ือหาและภาพมีความสอดคลอ้ง      
13 ขนาดตวัอกัษรท่ีใช้      
14 รูปแบบตวัอกัษรท่ีใช้      
15 ความเหมาะสมของสีตวัอกัษร      
16 การออกแบบหนา้จอ      
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รายการ 
ระดับความคิดเห็น 

ดีมาก ดี ปานกลาง น้อย น้อยทีสุ่ด 
1 เน้ือหาสอดคลอ้งกบัวตัถุประสงค ์      
2 เน้ือหามีความถูกตอ้ง      
3 ภาพประกอบสอดคลอ้งกบัเน้ือหา      

 

ขอ้เสนอแนะ 
………………………………………………………………………………………………………
………………………………………………………………………………………………………
……………………………………………………………………………………………………… 
       

ลงช่ือ……………………………….ผูป้ระเมิน 
          (…………………………………..) 
              ต  าแหน่ง……………………………………. 
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ตารางท่ี ค-1  ผลการประเมินบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพ 
      และเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album  
     ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 โดยผูเ้ช่ียวชาญ 

ข้อ รายการประเมนิ 
ระดบัความคดิเห็นของผู้เช่ียวชาญ 

1 2 3 4 5 ค่าเฉลีย่ SD 
1 เน้ือหาสอดคลอ้งกบัวตัถุประสงค ์ 5 4 4 4 3 4 0.71 
2 เน้ือหามีความถูกตอ้ง 5 5 4 5 5 4.8 0.45 
3 ภาพประกอบสอดคลอ้งกบัเน้ือหา 4 4 4 4 4 4 0.00 
4 มีการด าเนินบทเรียนท่ีน่าสนใจ 5 5 5 4 4 4.6 0.55 
5 เน้ือหามีความเหมาะสมกบัระดบัผูเ้รียน 4 4 4 4 5 4.2 0.45 
6 มีการล าดบัเน้ือหาในบทเรียน 5 5 4 4 4 4.4 0.55 
7 ปริมาณเน้ือหามีความเหมาะสม 5 5 5 5 5 5 0.00 
8 ใชภ้าษาท่ีเขา้ใจง่าย 5 5 4 4 3 4.2 0.84 
9 กิจกรรมง่ายต่อการเรียนรู้ 5 5 4 4 4 4.4 0.55 
10 จ านวนแบบฝึกหดัมีความเหมาะสม 5 5 5 5 5 5 0.00 
11 ความเหมาะสมของภาพและเสียง 4 4 5 4 5 4.4 0.55 
12 เน้ือหาและภาพมีความสอดคลอ้ง 4 4 4 5 5 4.4 0.55 
13 ขนาดตวัอกัษรท่ีใช ้ 5 5 5 5 5 5 0.00 
14 รูปแบบตวัอกัษรท่ีใช ้ 5 5 5 5 5 5 0.00 
15 ความเหมาะสมของสีตวัอกัษร 5 5 5 5 5 5 0.00 
16 การออกแบบหนา้จอ 4 4 4 4 3 3.8 0.45 
17 ล าดบัขั้นในการน าเสนอ 4 4 4 4 4 4 0.00 
18 ปริมาณเน้ือหาในแต่ละหนา้ 5 4 5 4 4 4.4 0.55 
19 การโตต้อบระหวา่งผูใ้ชก้บับทเรียน 5 5 4 4 4 4.4 0.55 
20 ความสะดวกในการใชบ้ทเรียน 5 5 5 5 4 4.8 0.45 
 รวม 94 92 89 88 86 4.49 0.36 

 

  จากตารางท่ี ค-1 พบวา่ ความเหมาะสมของบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระ
การเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรมอยา่ง
ง่าย ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 มีค่าเฉล่ีย 4.49 หมายถึง บทเรียนมีคุณภาพ ระดบัดีมาก 
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ภาคผนวก ง 
แบบประเมินความพึงพอใจบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพ
และเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียน 

ชั้นประถมศึกษาปีท่ี 6 และผลการประเมินโดยกลุ่มตวัอยา่ง 
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แบบประเมินความพงึพอใจบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพ
และเทคโนโลย ีเร่ือง การสร้างหนังสืออิเลก็ทรอนิกส์ด้วยโปรแกรม Flip album 

 ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6 
(บุญทศัน์ แจ่มจนัทรา, 2551) 

ค าช้ีแจง 
 1. แบบวดัชุดน้ี มีจุดประสงคเ์พื่อน าขอ้มูลท่ีไดไ้ปใชใ้นการปรับปรุงแกไ้ขบทเรียน
ออนไลน์แบบผสมผสานเพื่อนามาใชใ้นการประกอบการเรียนการสอนใหมี้ประสิทธิภาพยิง่ข้ึน 
ขอใหน้กัเรียนตอบแบบวดัตามความเป็นจริง ท่ีตรงกบัความพึงพอใจของนกัเรียนมากท่ีสุด 
 2. แบบวดัมี 4 ดา้น คือ 
 ดา้นท่ี 1 เน้ือหาและการด าเนินเร่ือง จ านวน 5 ขอ้ 
 ดา้นท่ี 2 ภาพ ภาษา และเสียง จ านวน 7 ขอ้ 
 ดา้นท่ี 3 ตวัอกัษร และสี จ านวน 3 ขอ้ 
 ดา้นท่ี 4 ดา้นประสบการณ์การเรียน จ านวน 5 ขอ้ 
ใหน้กัเรียนกาเคร่ืองหมาย  ลงในช่องระดบัความพึงพอใจเพียงหมายเลขเดียว 
 

ที ่ รายการประเมนิ 
ระดบัความพงึพอใจ 

มากทีสุ่ด มาก ปานกลาง น้อย น้อยทีสุ่ด 

ด้านเนื้อหาและการด าเนินเร่ือง      
1 เน้ือหาตรงกบัความตอ้งการในการเรียนรู้  

เร่ือง การสร้างหนงัสืออิเลก็ทรอนิกส์ 
ดว้ยโปรแกรมอยา่งง่าย 

     

2 มีความเขา้ใจเน้ือหาการเรียนจากบทเรียน
ออนไลน์แบบผสมผสาน 

     

3 สามารถเรียนรู้เน้ือหาจากบทเรียนออนไลน ์
แบบผสมผสานไดด้ว้ยตนเอง 

     

4 สามารถอ่านและท าความเขา้ใจใน 
บทเรียนออนไลน์แบบผสมผสาน 

     

5 บทเรียนออนไลน์แบบผสมผสานใหค้วามรู้
เก่ียวกบัเน้ือหาไดเ้ช่นเดียวกบัส่ือประเภทอ่ืน ๆ 
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ที ่ รายการประเมนิ 
ระดบัความพงึพอใจ 

มากทีสุ่ด มาก ปานกลาง น้อย น้อยทีสุ่ด 

ด้านภาพ ภาษา และเสียง      
1 ความชดัเจนของภาพประกอบท่ีใชใ้นบทเรียน      
2 ความเหมาะสมของภาพเคล่ือนไหว 

ท่ีใชใ้นบทเรียน 

     

3 ความถูกตอ้งของภาษาท่ีใช ้      
4 ความเหมาะสมของเสียงดนตรี      
5 ความเหมาะสมของเสียงบรรยาย      
6 ความเหมาะสมของการออกแบบกรอบภาพ      
7 ความสมัพนัธ์ระหวา่งภาพกบัภาษาและเสียง      
ด้านตัวอักษรและส่ือ      
1 ความเหมาะสมของแบบตวัอกัษร      
2 ความเหมาะสมของขนาดตวัอกัษร      
3 ความเหมาะสมของการเลือกใชสี้ตวัอกัษร      
ด้านความรู้และประสบการณ์      
1 บทเรียนออนไลน์แบบผสมผสาน ท าใหผู้เ้รียน 

มีความรู้ในการเรียนรู้ เร่ือง การใชอิ้นเทอร์เน็ต 
     

2 บทเรียนออนไลน์แบบผสมผสาน ท าให ้
มีความต่ืนเตน้และมีความเร้าใจ 

     

3 บทเรียนออนไลน์แบบผสมผสาน ท าใหรู้้จกั 
ช่วยตนเองในการเรียนมากข้ึน 

     

4 บทเรียนออนไลน์แบบผสมผสาน ท าใหเ้อาใจใส่
ต่อการเรียนมากข้ึน 

     

5 บทเรียนออนไลน์แบบผสมผสานใหท้ั้งความรู้
และความเพลิดเพลิน 

     

 
 
 
 
 
 
 



98 

ตารางท่ี ง-1 ผลการประเมินความพึงพอใจบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้ 
                    การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม  
                    Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 โดยกลุ่มตวัอยา่ง 
 

ข้อ รายการประเมนิ 
ระดบัความคดิเห็นของผู้เช่ียวชาญ 

5 4 3 2 1   SD 
เกณฑ์ 
ประเมนิ 

1 เน้ือหาตรงกบัความตอ้งการในการเรียนรู้  
เร่ือง การสร้างหนงัสืออิเลก็ทรอนิกส์ 
ดว้ยโปรแกรมอยา่งง่าย 

13 17 0 0 0 4.43 0.50 มาก 

2 มีความเขา้ใจเน้ือหาการเรียนจากบทเรียน
ออนไลน์แบบผสมผสาน 

15 12 3 0 0 4.40 0.66 มาก 

3 สามารถเรียนรู้เน้ือหาจากบทเรียนออนไลน ์
แบบผสมผสานไดด้ว้ยตนเอง 

14 16 0 0 0 4.47 0.50 มาก 

4 สามารถอ่านและท าความเขา้ใจในบทเรียน
ออนไลน์แบบผสมผสาน 

12 13 5 0 0 4.23 0.72 มาก 

5 บทเรียนออนไลน์แบบผสมผสานใหค้วามรู้
เก่ียวกบัเน้ือหาไดเ้ช่นเดียวกบัส่ืออ่ืน ๆ 

10 15 5 0 0 4.17 0.69 มาก 

6 ความชดัเจนของภาพประกอบท่ีใชใ้น
บทเรียน 

20 10 0 0 0 4.67 0.47 มากท่ีสุด 

7 ความเหมาะสมของภาพเคล่ือนไหวท่ีใช ้
ในบทเรียน 

23 7 0 0 0 4.77 0.42 มากท่ีสุด 

8 ความถูกตอ้งของภาษาท่ีใช ้ 19 11 0 0 0 4.63 0.48 มากท่ีสุด 
9 ความเหมาะสมของเสียงดนตรี 24 3 3 0 0 4.70 0.64 มากท่ีสุด 
10 ความเหมาะสมของเสียงบรรยาย 15 5 10 0 0 4.17 0.90 มาก 
11 ความเหมาะสมของการออกแบบกรอบภาพ 26 4 0 0 0 4.87 0.34 มากท่ีสุด 
12 ความสมัพนัธ์ระหวา่งภาพ ภาษาและเสียง 18 12 0 0 0 4.60 0.49 มากท่ีสุด 
13 ความเหมาะสมของแบบตวัอกัษร 20 10 0 0 0 4.67 0.47 มากท่ีสุด 
14 ความเหมาะสมของขนาดตวัอกัษร 14 13 3 0 0 4.37 0.66 มาก 
15 ความเหมาะสมของการเลือกใชสี้ตวัอกัษร 23 7 0 0 0 4.77 0.42 มากท่ีสุด 
16 บทเรียนออนไลน์แบบผสมผสาน ท าให้

ผูเ้รียนมีความรู้ในการเรียนรู้ เร่ือง การใช้
อินเทอร์เน็ต 

18 12 0 0 0 4.60 0.49 มากท่ีสุด 
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ตารางท่ี ง-1 (ต่อ) 
 

ข้อ รายการประเมนิ 
ระดบัความคดิเห็นของผู้เช่ียวชาญ 

5 4 3 2 1  SD 
เกณฑ์ 
ประเมนิ 

17 บทเรียนออนไลน์แบบผสมผสาน ท าให ้
มีความต่ืนเตน้และมีความเร้าใจ 

20 5 5 0 0 4.50 0.76 มาก 

18 บทเรียนออนไลน์แบบผสมผสาน ท าให้
รู้จกัช่วยตนเองในการเรียนมากข้ึน 

27 3 0 0 0 4.90 0.30 มากท่ีสุด 

19 บทเรียนออนไลน์แบบผสมผสาน  
ท าใหเ้อาใจใส่ต่อการเรียนมากข้ึน 

25 3 2 0 0 4.77 0.56 มากท่ีสุด 

20 บทเรียนออนไลน์แบบผสมผสานใหท้ั้ง
ความรู้และความเพลิดเพลิน 

28 2 0 0 0 4.93 0.25 มากท่ีสุด 

 
 จากตารางท่ี ง-1 พบวา่ นกัเรียนมีความพึงพอใจต่อบทเรียนออนไลน์แบบผสมผสาน 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ 
ดว้ยโปรแกรม Flip album ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 อยูใ่นระดบัดีมาก 
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ภาคผนวก จ 

คะแนนการหาค่าดชันีประสิทธิผลบทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้ 
การงานอาชีพและเทคโนโลย ีเร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album 

ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 โดยทดลองกบักลุ่มตวัอยา่ง จ านวน 30 คน 
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ตารางท่ี จ-1 คะแนนการหาค่าดชันีประสิทธิผลบทเรียนออนไลน์แบบผสมผสานฯ (N =30) 
 

คนท่ี คะแนนก่อนเรียน (30 คะแนน) คะแนนหลงัเรียน (30 คะแนน) 
1 15 27 
2 13 26 
3 18 28 
4 19 27 
5 20 29 
6 14 26 
7 16 27 
8 15 25 
9 9 24 
10 17 25 
11 12 26 
12 11 25 
13 19 2 
14 18 27 
15 7 24 
16 8 27 
17 6 26 
18 12 28 
19 11 25 
20 15 25 
21 16 23 
22 3 24 
23 5 26 
24 7 27 
25 10 29 
26 10 26 
27 13 23 
28 10 24 
29 17 26 
30 12 26 
รวม 378 753 

ค่าเฉล่ีย 12.6 25.1 
ค่าดชันีประสิทธิผลของบทเรียน 0.72 

 
 
 



102 

 
 
 
 
 
 
 
 
 
 
 

ภาคผนวก ฉ 
บทเรียนออนไลน์แบบผสมผสาน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี 
เร่ือง การสร้างหนงัสืออิเล็กทรอนิกส์ดว้ยโปรแกรม Flip album ส าหรับนกัเรียน 

ชั้นประถมศึกษาปีท่ี 6 และแบบทดสอบก่อนเรียน-หลงัเรียน 
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ภาพท่ี ฉ-1 แนะน าบทเรียน                                 
                                    

 
ภาพท่ี ฉ-2 หนา้ค าถามกระตุน้ความคิด เร้าความสนใจ 
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ภาพท่ี ฉ-3 แบบทดสอบก่อนเรียน 
 

 
ภาพท่ี ฉ-4 เน้ือหาบทเรียน ประกอบดว้ย ขอ้ความ ภาพ วีดิโอ 
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ภาพท่ี ฉ-5 หนา้จอการท ากิจกรรมบนบทเรียนออนไลน์ 
 

 
ภาพท่ี ฉ-6 หนา้จอแบบทดสอบหลงัเรียน 
 
 



106 

แบบทดสอบ เร่ือง การสร้างหนังสืออเิลก็ทรอนิกส์ด้วยโปรแกรม Flip album  
ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6 

 

ค าช้ีแจง  จงกากบาท X ทบัตวัอกัษร ท่ีตรงกบัตวัเลือกท่ีตอ้งการลงในกระดาษค าตอบ 

1. ขอ้ใดใหค้วามหมายของหนงัสืออิเล็กทรอนิกส์ไดถู้กตอ้งท่ีสุด 
ก. หนงัสือท่ีสร้างดว้ยโปรแกรมคอมพิวเตอร์และเปิดอ่านไดเ้หมือนหนงัสือจริง 
ข. หนงัสือท่ีสามารถเปิดอ่านไดใ้นเคร่ืองคอมพิวเตอร์  
ค. หนงัสือท่ีประกอบไปดว้ยขอ้ความ ภาพและเสียง 
ง. หนงัสือท่ีสามารถสั่งพิมพท์างเคร่ืองพิมพไ์ด ้

2. E-Book ยอ่มาจากค าในภาษาองักฤษในขอ้ใด 
ก. E-learning Book   ข. Electronic Book 
ค. Electrolux Book   ง. Electron Book 

3. ความแตกต่างของหนงัสืออิเล็กทรอนิกส์กบัหนงัสือทัว่ไปคือขอ้ใด 
ก. หนงัสืออิเล็กทรอนิกส์มีตน้ทุนในการผลิตหนงัสือต ่าหนงัสือทัว่ไปมีตน้ทุนการผลิตสูง 
ข. หนงัสืออิเล็กทรอนิกส์สามารถใส่เสียงประกอบไดห้นงัสือทัว่ไปไม่มีเสียงประกอบ 
ค. หนงัสืออิเล็กทรอนิกส์ไม่ใชก้ระดาษหนงัสือทัว่ไปใชก้ระดาษ 
ง. ถูกทุกขอ้ 

4. ขอ้ใด ไม่ใช่ โปรแกรมในการสร้างหนงัสืออิเล็กทรอนิกส์ (E-Book) 
         ก. Flash album deluxe     

ข. Desktop Author 
 ค. Flip album  

ง. Photoshop 
5. ขอ้ใดเป็นขั้นตอนการเรียกใชโ้ปรแกรม Flip Album Vista Pro   

ก. Start > Flip Album Vista Pro  
ข. Start > settings > Flip Album Vista Pro  
ค. Start > All Programs > E-book System >  Flip Album Vista Pro  
ง. ไม่มีขอ้ใดถูก 
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6. วตัถุประสงคข์องการจดัท าแหล่งคน้ควา้หนงัสืออิเล็กทรอนิกส์ (E-Book) คืออะไร 
ก. ผูเ้รียนไดเ้รียนผา่นส่ืออิเล็กทรอนิกส์ท่ีมีความหลากหลายน่าสนใจ 
ข. เป็นการรวบรวมเน้ือหาต่างๆใหผู้ท่ี้สนใจไดศึ้กษาคน้ควา้ 
ค. เป็นการน าเอกสารอิเล็กทรอนิกส์มารวมกนัไวเ้ป็นชุด 
ง. ทุกขอ้ท่ีกล่าวมา 

7.  ขอ้ใด ไม่ใช่ ประโยชน์ของหนงัสืออิเล็กทรอนิกส์ 
ก. สามารถแสดงทั้งขอ้ความ  ภาพน่ิง  ภาพเคล่ือนไหว  และเสียงไดพ้ร้อมกนัได ้
ข. ช่วยลดค่าใชจ่้าย และลดการใชท้รัพยากรธรรมชาติ 
ค. สะดวกในการจดัเก็บขอ้มูลสามารถเช่ือมโยงขอ้มูลต่างๆได ้
ง. ท าการแกไ้ขยาก 

8. ความแตกต่างทางโครงสร้างของหนงัสืออิเล็กทรอนิกส์กบัหนงัสือทัว่ไปท่ีเห็นชดัเจน คือขอ้ใด 
ก. ความสะดวกในการอ่าน  ความเพลิดเพลิน สาระของหนงัสือแต่ละหนา้ 
ข. จ  านวนหนา้ของหนงัสือ  ภาพประกอบ  และปกหนงัสือ 
ค. กระบวนการผลิต  รูปแบบ  และวธีิการอ่านหนงัสือ 

              ง. แหล่งอา้งอิง  ดชันี  และขอ้ความของเร่ืองท่ีอ่าน 
9. ส่ิงส าคญัท่ีนกัเรียนตอ้งเตรียมความพร้อมในการสร้างหนงัสืออิเล็กทรอนิกส์ ประกอบดว้ย 
    อะไรบา้ง  

ก. สร้างโฟลเดอร์ไวส้ าหรับเก็บไฟลง์านของหนงัสืออิเล็กทรอนิกส์  
ข. เตรียมไฟลง์านท่ีเก่ียวขอ้ง เช่น ขอ้ความ ภาพน่ิง ภาพเคล่ือนไหว ไฟลเ์สียง ไฟลว์ดีีโอ  
ค. เตรียมหนงัสืออ่านทัว่ไป รูปภาพ ภาพเคล่ือนไหว  
ง. ถูกทั้งขอ้ ก. และ ข.  

10. การสร้างหนงัสือเล่มใหม่ ตอ้งคลิกค าสั่งใด   
ก. File -> New Book   ข. Edit -> New  
ค. Save -> Book   ง. Open -> New 

11. การบนัทึกหนงัสือ ตอ้งคลิกค าสั่งใด   
ก. Save -> Book  ข. Edit -> Save  
ค. File -> Save  ง. Open -> New  

 
 
12. การเปิดหนงัสือเดิม ตอ้งคลิกค าสั่งใด   
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ก. File -> Open Book  ข. File -> Open  
ค. File -> Book   ง. Open -> New Book  

13. Font Cover หมายถึงอะไร  
ก. ปกหนา้   ข. ปกหลงั  
ค. กระดาษหนา้ในดา้นซา้ย  ง. กระดาษหนา้ในดา้นขวา  

14. Left Page หมายถึงอะไร  
ก. ปกหนา้   ข. ปกหลงั  
ค. กระดาษหนา้ในดา้นซา้ย  ง. กระดาษหนา้ในดา้นขวา   

15. Contents หมายถึงอะไร  
ก. ปกหนา้   ข. ปกหลงั  
ค. สารบญั   ง. ดชันี   

16. Book Background หมายถึงอะไร  
ก. พื้นหลงัหนงัสือ   ข. สีปกหนา้  
ค. สีปกหลงั   ง. สีกระดาษ   

17. ขอ้ใดคือการแทรกขอ้ความในโปรแกรม Flip Album  
ก. คลิกขวา > Add Text  ข. คลิกขวา > Insert Text   
ค. คลิกขวา > Text   ง. คลิกขวา > Annotate  

18. ตอ้งการลบหนา้กระดาษตอ้งใชค้  าสั่งใด  
ก. Insert Page    ข. Delete Page  
ค. Open Page   ง. New Page  

19. ขอ้ใดคือค าสั่งในการแทรกรูปภาพ   
ก. Insert > Clip Art   ข. Insert > Anotations  
ค. Insert > Bookmarks  ง. Insert > Multi-Media Object 

20. ค  าสั่งใดท่ีใชเ้ปล่ียนรูปแบบหนงัสือทั้งชุด (ปกหนา้, ปกหลงั, สีกระดาษ และภาพพื้นหลงั)   
ก. Set Theme   ข. Book Binder  
ค. Page Properties   ง. Set Book Options 

21. การเปล่ียนแปลงรูปภาพใหเ้ป็นรูปทรงต่าง ๆ ตอ้งเลือก ค าสั่งใด  
ก. Effects > 3D   ข. Effects > Shadow  
ค. Effects > Transparent  ง. Effects > Select crop Shape 

22. หากตอ้งการใส่กรอบให้กบัรูปภาพ ตอ้งเลือกค าสั่งใด  
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ก. Effects -> 3D   ข. Effects -> Shadow  
ค. Effects -> Add/Edit Frame  ง. Effects -> Select crop Shape  

23. ขอ้ใดคือค าสั่งการใส่ห่วงสันใหก้บัหนงัสือ   
ก. Set Theme   ข. Book Binder  
ค. Page Properties   ง. Set Book Options   

 24. Centerfold Page คือค าสั่งใด   
ก. การลบหนา้กระดาษ  ข. การสร้างหนา้กระดาษ  
ค. การแทรกภาพเคล่ือนไหว  ง. การสร้างหนงัสือแบบหนา้คู่   

25. รูปภาพท่ีน ามาใส่ในหนงัสืออิเล็กทรอนิกส์ (e-Book) จะตอ้งใชน้ามสกุลใด  
ก. .mpeg    ข. .wav  
ค. .jpg    ง. .mp3 

26. เม่ือตอ้งการแกไ้ขหนา้ดชันี (Index) ใหแ้สดงผลเป็นภาษาไทยได ้ตอ้งเลือกใชเ้มนูค าสั่งใด  
  ก. เมนู Edit -> Customize Index  ข. เมนู Edit -> Index  
  ค. เมนู Edit -> Rename Index   ง. เมนู Edit  -> Modify C Index 

27. เม่ือตอ้งการดูเน้ือหาในภาพรวมของหนงัสือ จะตอ้งดูจากหนา้ใดของหนงัสือ  
ก. Index    ข. Contents  
ค. Bookmark   ง. Overview   

28. เม่ือตอ้งการแกไ้ขหนา้สารบญั (Contents) ใหแ้สดงผลเป็นภาษาไทย ตอ้งเลือกใชเ้มนูค าสั่งใด  
ก. เมนู Edit -> Contents   ข. เมนู Edit -> Modify Contents  
ค. เมนู Edit -> Rename Contents  ง. เมนู Edit -> Customize Contents  

29. ส่วนใดของหนงัสือท่ีเป็นส่วนส าคญัและเป็นแรงจูงใจใหผู้อ่้านสนใจ  
ก. สารบญั  ข. ปกหนา้  
ค. ปกหลงั  ง. เน้ือหา  

30. ไฟลง์านท่ีสร้างดว้ยโปรแกรม Flip Album Vista Pro จะ มีนามสกุลอะไร  
ก. *.exe    ข. *.flp  
ค. *.jpg    ง. *.opf 

 
 
 

เฉลยแบบทดสอบ เร่ือง การสร้างหนังสืออเิลก็ทรอนิกส์ด้วยโปรแกรม Flip album 
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ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6 
 

 
 

 

ขอ้ เฉลย ขอ้ เฉลย ขอ้ เฉลย 
1 ก 11 ค 21 ง 
2 ข 12 ข 22 ค 
3 ง 13 ก 23 ข 
4 ง 14 ค 24 ง 
5 ค 15 ค 25 ค 
6 ง 16 ก 26 ก 
7 ง 17 ง 27 ง 
8 ก 18 ค 28 ง 
9 ง 19 ง 29 ข 

10 ก 20 ง 30 ข 


